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Preface

This guide describes how to use NetBackup for the UNIX platform to perform backups,
archives, and restores. Throughout this guide, VERITAS NetBackup is referred to as
NetBackup.

Audience

This guide is intended for the system administrator and the UNIX end user. A basic
knowledge of UNIX commands and operations is assumed.

Organization

This guide is organized as follows:

2

Chapter 1, “Introduction to NetBackup,” provides an overview of NetBackup,
describes how the end user operates NetBackup, and describes technical terms and
concepts. Read this chapter to become familiar with NetBackup.

Chapter 2, “Using the Backup, Archive, and Restore Interface,” explains how to use
the NetBackup Java interface, jbpsa, to perform backup, archive, and restore
operations.

Chapter 3, “Using the Menu Interface,” explains how to use the NetBackup menu
interface, bp, to perform backup, archive, and restore operations.

Chapter 4, “Using the X-Windows Interface,” explains how to use the graphical
interface, xbp, to perform backup, archive and restore operations.

Chapter 5, “Reference Guide to xbp and bp,” describes the various windows, screens,
and menus associated with the xbp and bp user interface programs.

The Appendix “System Administrators” provides additional information on the
jbpsa inteface for the NetBackup Administrator.

“Glossary”provides definitions used in this manual and in the NetBackup interfaces.




Related Documentation

Related Documentation

The following documents provide related information. For a more detailed listing of
NetBackup documents, refer to NetBackup Release Notes.

4

NetBackup Installation Guide for PC Clients

Explains how to install NetBackup PC client software. The PC clients are Windows,
Mac OS, and Novell NetWare.

If you have a UNIX server, refer to these documents:

4

NetBackup Release Notes

Provides important information about NetBackup DataCenter and BusinesServer
products on UNIX- and Windows-based servers, such as the platforms and operating
systems that are supported and operating notes that may not be in the NetBackup
manuals or the online help.

NetBackup DataCenter System Administrator’s Guide for UNIX

Explains how to configure and manage NetBackup DataCenter on a UNIX server.
NetBackup BusinesServer System Administrator’s Guide for UNIX

Explains how to configure and manage NetBackup BusinesServer on a UNIX server.
NetBackup Troubleshooting Guide for UNIX

Provides troubleshooting information for UNIX-based NetBackup products.

If you have a Windows server, refer to these documents:

4

NetBackup Release Notes

Provides important information about NetBackup software, such as the platforms and
operating systems that are supported and operating notes that may not be in the
manuals or the online help.

NetBackup DataCenter System Administrator’s Guide for Windows
Explains how to configure and manage NetBackup DataCenter on a Windows server.
NetBackup BusinesServer System Administrator’s Guide for Windows

Explains how to configure and manage NetBackup BusinesServer on a Windows
server.

NetBackup Troubleshooting Guide for Windows

Provides troubleshooting information for Windows-based NetBackup products.
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Accessibility

Accessibility

NetBackup contains features that make the user interface easier to use by people who are
visually impaired and by people who have limited dexterity. Accessibility features
include:

& Support for assistive technologies such as screen readers and voice input (Windows
servers only)

& Support for keyboard (mouseless) navigation using accelerator keys and mnemonic
keys

For more information, see the NetBackup system administrator’s guide.

Conventions

The following explains typographical and other conventions used in this guide.
Type Style

Typographic Conventions

Typeface Usage

Bold fixed width  |nput. For example, type cd to change directories.

Fixed width Paths, commands, filenames, or output. For example: The default installation
directory is /opt /VRTSxx.

Italics Book titles, new terms, or used for emphasis. For example: Do not ignore cautions.

Sans serif (italics) Placeholder text or variables. For example: Replace filename with the name of your
file.

Serif (no italics) Graphical user interface (GUI) objects, such as fields, menu choices, etc.

For example: Enter your password in the Password field.
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Conventions

Notes and Cautions

Note This is a Note. Notes are used to call attention to information that makes using the
product easier or helps in avoiding problems.

Caution This is a Caution. Cautions are used to warn about situations that could cause
data loss.

Key Combinations

Some keyboard command sequences use two or more keys at the same time. For example,
holding down the Ctrl key while pressing another key. Keyboard command sequences are
indicated by connecting the keys with a plus sign. For example:

Press Ctrl+t

Command Usage
The following conventions are frequently used in the synopsis of command usage.
brackets [ ]
The enclosed command line component is optional.

Vertical bar or pipe (])

Separates optional arguments from which the user can choose. For example, when a
command has the following format:

command argl|arg2

the user can use either the argl or arg2 variable.

- xii NetBackup User’s Guide - UNIX



Getting Help

Terms

The terms listed in the table below are used in the VERITAS NetBackup documentation to
increase readability while maintaining technical accuracy.

Term Definition
Microsoft Windows, Terms used as nouns to describe a line of operating systems
Windows developed by Microsoft, Inc.

A term used as an adjective to describe a specific product or
noun. Some examples are: Windows 95, Windows 98,

Windows NT, Windows 2000, Windows servers, Windows
clients, Windows platforms, Windows hosts, and Windows GUI.

Where a specific Windows product is identified, then only that
particular product is valid with regards to the instance in which
it is being used.

For more information on the Windows operating systems that

NetBackup supports, refer to the VERITAS support web site at
http://www.support.veritas.com.

Windows servers A term that defines the Windows server platforms that
NetBackup supports; those platforms are: Windows NT and
Windows 2000.

Windows clients A term that defines the Windows client platforms that
NetBackup supports; those platforms are: Windows 95, 98, ME,
NT, 2000, XP (for 32- and 64-bit versions), and LE.

Getting Help

For updated information about this product, including system requirements, supported
platforms, supported peripherals, and a list of current patches available from Technical
Support, visit our web site:

http://www.support.veritas.com/

VERITAS Customer Support has an extensive technical support structure that enables you
to contact technical support teams that are trained to answer questions to specific
products. You can contact Customer Support by sending an e-mail to
support@veritas.com, or by finding a product-specific phone number from the VERITAS
support web site. The following steps describe how to locate the proper phone number.

Preface
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Getting Help

1. Openhttp://www.support.veritas.com/ inyour web browser.
2. Click Contact Support. The Contacting Support Product List page appears.
3. Select a product line and then a product from the lists that appear. The page will

refresh with a list of technical support phone numbers that are specific to the product
you just selected.
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Introduction to NetBackup 1

NetBackup lets you back up, archive, and restore files, directories, or raw partitions that
reside on your client system. In NetBackup terminology, the system that needs the backup
or restore is the client (or agent). The system that manages the storage and retrieval of the
backup data is called the NetBackup server.




User-Directed Operations

User-Directed Operations

User-directed operations are NetBackup operations that the user can perform from the
client. These operations can be performed without administrator intervention or logging
into the NetBackup server.

User-directed operations include:

& Back up files, directories or raw partitions that reside on your local disk. A backup
operation saves the data to a storage device on the NetBackup server.

& Archive files and directories that reside on your local disk. An archive operation saves
the selected files and directories to a storage device on the NetBackup server and then
deletes them from your local disk.

& Restore previously backed up or archived files, directories, or raw partitions to either
the location from which they were backed up or to another location. You select what
you want to restore and NetBackup automatically restores it to the disk.

After you start a user-directed operation, the server manages storage and retrieval of data.
All file transfers occur in the background so there is no long wait for the operation to
complete before regaining control of your terminal.

Client Interfaces

NetBackup provides four client interfaces:

& Backup, Archive, and Restore interface (for Java)
¢ Menu interface

¢ X-Windows graphical interface

¢ Command line interface

You can perform user-directed operations through any of these interfaces, but the Backup,
Archive, and Restore and menu interfaces are the one that you will probably use most
often:

& The Backup, Archive, and Restore interface can be used on NetBackup-Java capable
platforms. Refer to “Using the Backup, Archive, and Restore Interface” on page 9 for
information on using this interface.

& The menu interface is used on virtually any terminal that can connect to a client
system. The bp command starts the menu interface program. Refer to “Using the
Menu Interface” on page 47 for details on using the bp menu interface.

) NetBackup User’s Guide - UNIX



Client Interfaces

¢ The X-Windows interface is used on any X terminal or workstation with an X server
program compatible with X11.R4 or later. The xbp command starts this interface.
Refer to “Using the X-Windows Interface” on page 75 for details on using the xbp
graphical interface.

¢ The command line interface lets you perform backup, archive, restore, and list
operations by entering individual commands at the shell prompt.

The following commands are available in the command line interface:
bp
bparchive
bpbackup
bplist
bprestore
xbp

For descriptions of commands see the man pages. To view the man pages, enter, for
example:

man bp

Note If the man pages are not installed on your system, contact your system
administrator.

Information on the commands is also included in the NetBackup System Administrator’s
Guide for UNIX.

The Backup, Archive, and Restore, X-Windows, and menu interfaces have all the options
necessary to perform and monitor user-directed operations. An important feature of these
interfaces is their built-in ability to browse for and select files and directories:

¢ During a backup or archive, you can browse the file system on your client to select
files and directories.

& During a restore, you can browse the backup history for your client to select files and
directories that you have previously saved. It is also possible to browse the backup
history for other clients if the NetBackup administrator gives you the necessary

permissions.
R ————
Chapter 1, Introduction to NetBackup 3 v



Progress Logs and Email Notifications

Progress Logs and Email Notifications

NetBackup progress logs provide information on the progress of a NetBackup operation.
These logs also indicate the success and failure of a NetBackup operation. For each
user-directed operation, NetBackup can be configured to create a separate progress log
file. You can delete the log files when they are no longer needed. For more details on
creating log files, refer to “Checking Progress of Operations” on page 98 for xbp or
“Checking Progress of Operations” on page 74 for bp. For more details on log files for the
Backup, Archive, and Restore interface, refer to “Viewing the Progress of Backups and
Restores” on page 30.

The NetBackup server can be configured to deliver email notifications to the client user on
the status of the client user’s NetBackup operations. Refer to the NetBackup System
Administrator’s Guide for UNIX or the NetBackup System Administrator’s Guide for Windows
for details on configuring the server for email notifications.

Backup and Archive Windows

NetBackup can be configured to allow user-directed backups or archives to occur only
during specific time periods, usually referred to as windows. For example, if your window
is from 8 am to 6 pm, you will not be able to back up or archive at other times. The
NetBackup administrator defines these windows during server configuration. For more
information, refer to the NetBackup System Administrator’s Guide for UNIX or the NetBackup
System Administrator’s Guide for Windows.

Note The backup and archive windows do not affect user-directed restores. You can
perform a restore at any time.

Automatic Backups

The NetBackup administrator can configure NetBackup to perform automatic full and
incremental backups of your client system. These backups occur unattended and under
control of the NetBackup server. If carefully scheduled, the automatic backups will meet
most of the backup requirements for your client. NetBackup can also be configured to
send email on the success or failure of automatic backups to the administrator of your
client system.

For more information on automatic backups and other administrator directed activities,
refer to the NetBackup System Administrator’s Guide for UNIX or the NetBackup System
Administrator’s Guide for Windows.

! NetBackup User’s Guide - UNIX



Exclude and Include Lists

Exclude and Include Lists

The NetBackup system administrator configures the exclude and include lists for your
client.

The NetBackup exclude list contains a list of files and directories that will not be included
in scheduled backups. Files and directories in the exclude list can still be backed up
manually through the user interface.

In some cases, the system administrator may create an exclude list for a specific policy or
for a policy and schedule combination. The master server will use a single exclude list
when performing a scheduled backup for all clients in the specified policy or policy and
schedule combination. If, however, an individual client finds that a file or directory must
be included in a scheduled backup, then an include file list can be created on the client.

The NetBackup include list contains a list of files and directories that will be included in a
scheduled backup. This is also useful if, for example, you want to exclude an entire
directory except for one file.

The NetBackup System Administrator’s Guide for UNIX or the NetBackup System
Administrator’s Guide for Windows provide instructions for creating the exclude and
include lists.

Redirecting Restores to Different Clients

With the necessary permissions and configuration, users can browse the NetBackup
database for files backed up by another NetBackup client and restore files to their own
computer.

System administrators can direct restores to the client that originally backed up the files or
to a different client. This type of restore can be performed on any server and is called a
server-directed restore. The NetBackup administrator can direct file or raw partition
restores to any client. For more information refer to “System Administrators” on page 151.

Read This Before Using NetBackup

Read the following before performing any user operations with NetBackup.

Chapter 1, Introduction to NetBackup 5 Y



Read This Before Using NetBackup

Cautions and Notes to Observe When Using NetBackup

¢ When performing backups and archives, remember that if a file is only a symbolic link
to another file, NetBackup backs up or archives only the link, not the file itself. This
eliminates multiple backups of a file when more than one directory contains a
symbolic link to it. It also means you must be certain to back up or archive the source
file.

¢ OnaHewlett Packard system, do not attempt to restore a file in a CDF directory if the
CDF does not already exist. If you do, the directory is created without the directory
mode bits necessary for it to be recognized as a CDF. The correct procedure is to
restore the CDF itself thus restoring the files it contains. To restore only missing files
in a CDF, ensure that you specify to not overwrite existing files.

& The maximum path length that you can specify for a file is 1023 characters.

¢ The overwrite option is ignored during raw partition restores. The device file must
exist and the disk partition is overwritten whether or not this option is set.

Questions to Ask Your Administrator

During configuration, the administrator configures NetBackup to meet the backup and
archiving requirements of your site. The following are some questions you should ask the
administrator about your configuration before you use NetBackup. Knowing the answers
to these questions can help you to avoid problems later.

Which files and directories will NetBackup include in automatic backups of your client?

The list that the administrator configures may not include everything on your local disk. If
there are additional files that you want backed up, you can either ask the administrator to
add them to the file list for automatic backups or back them up yourself.

When do the automatic backups occur?

By knowing the schedules, you can recognize when you must perform your own backups
to preserve critical data.

When are user-directed backups and archives permitted for your client?

During configuration, the administrator determines when you can perform backup and
archive operations. For example, if they are allowed between 8 am and 4 pm, you will be
unable to perform a backup or archive at 6 pm.

What is the retention period for your data?

It is difficult to recover expired backups. Therefore, ensure that the retention time is long
enough to suit your needs.

- 6 NetBackup User’s Guide - UNIX



Read This Before Using NetBackup

(NetBackup DataCenter users) Can you back up, archive, and restore NFS mounted
files?

NetBackup allows this but your specific configuration may not. Remember that when you
archive NFS files, you remove them from the system on which they reside.

Does your configuration permit backups and archives of entire file paths even if they
cross file systems?

For example, if the backups and archives for your workstation are configured to cross file
systems, specifying / (root) backs up the entire disk. Otherwise, specifying / backs up
only the files and directories that are in the / file system and excludes files in other file
systems.

How do you restore files that were backed up or archived by another client?

Normally, NetBackup allows you to restore files only for the original client. The
administrator can override this if necessary.

Is the NetBackup configuration set up to provide you with email notifications on the
results of your user-directed operations?

These email notifications can eliminate the need for you to monitor the progress logs.
NetBackup can also send email on the success or failure of automatic backups to the
administrator of your client system.

File Permissions Required By NetBackup

You need UNIX read permission to back up a file and UNIX write permission to archive a
file (since the archive operation removes the file from the disk).

Note During a backup or archive, NetBackup stores only the user ID and group ID that
are assigned to the files. NetBackup does not store the user ID and group ID of the
person performing the backup. For example, assume a user uuu and group ggg own
a file and the root user backs it up. Regardless of who restores it, the restored file
still shows user ID = uuu and group ID = ggg.

Listing and restoring files and directories require the following UNIX permissions:

& To list or restore files in a directory owned by someone else, you must have read and
execute permission for the directory and all directories leading to it.

& To restore afile to its original location, you must have write access to the file (if the file
exists), or to the directory (if the file does not exist).
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Read This Before Using NetBackup

The following table shows how NetBackup restores files in various situations (for
example, if a copy of the file or directory already exists).

File Permissions

Type of Restore Attempted

Results

Restore a file that already
exists and overwrite the
existing file.

Restore a file that already
exists and not overwrite the
existing file.

Restore a file that doesn’t
exist.

Restore a file when a directory
exists with the same name as
the file.

Restore a directory when a file
exists with the same name as
the directory.

Restore a file in a directory
that does not exist.

If you are a root user, NetBackup restores the file and sets file
ownership to the same owner as the backup image.

If you are not a root user, NetBackup restores the file only if you
have write access to it. In a case where the file is read only, but you
have write access to the parent directory, NetBackup removes the
file and restores the backup image with you as the owner.

For both root and nonroot users, NetBackup does not restore the
file and places a message in the progress log.

If you are a root user, NetBackup restores the file and sets file
ownership to the same owner as the backup.

If you are a nonroot user, the file is created with you as the owner
and restored only if permissions on the parent directory allow it.

For both root and nonroot users, NetBackup places an error
message in the progress log and does not restore the file or remove
the directory. This occurs regardless of whether or not you elect to
overwrite existing files.

NetBackup restores the directory and removes the file, providing
that permissions allow it and you elect to overwrite existing files.
Ownerships are set as follows:

If you are a root user, NetBackup sets ownership of the
directory to that of the original owner.

If you are a nonroot user, the user name under which you are
doing the restore is assigned ownership.

NetBackup creates the directory with the user name and the name
of the user group doing the restore and uses the mask bits 022 to set
the mode of the directory. The file is then restored in the same
manner as one that does not exist (see above).

NetBackup User’s Guide - UNIX



Using the Backup, Archive, and Restore
Interface 2

The Backup, Archive, and Restore interface (jbopSAa) provides a graphical user interface
through which users can perform backups, archives, and restores. The interface can be
started and run on all NetBackup-Java capable platforms.

Topics covered in this chapter include:

Starting the Backup, Archive, and Restore Interface
Adjusting the Time Zone

Helpful Hints on Locating and Marking Files
Performing Backups and Archives

Performing Restores

Viewing the Progress of Backups and Restores

Advanced Restore Procedures

® 6 6 6 6 O 0 o

Tips and Troubleshooting




Starting the Backup, Archive, and Restore Interface

Starting the Backup, Archive, and Restore Interface

Logging into a NetBackup client via the Backup, Archive, and Restore interface

NetBackup UNIX Client

NetBackup Client

tiger
shark /

Backup, Archive, and
Restore interface NetBackup UNIX Client

Launch the Backup, Archive, and bear
Restore interface on shark and

log in to any NetBackup client
(shark, tiger, or bear) to perform
backups, archives, and restores
on that client.

With the Backup, Archive, and Restore interface
you can perform backup, archive, and restore
operations on any client from the NetBackup Client
running this interface.

To start the Backup, Archive, and Restore interface

1.

Log in to the NetBackup computer where you are going to start the Backup, Archive,
and Restore interface.

Start the Backup, Archive, and Restore interface by executing:
/usr/openv/netbackup/bin/jbpSA &

For additional usage information enter: §bpSA -h.

In the Login dialog box, type the name of the client where you want to perform the
backup, archive, or restore.

You must have a valid user account on that client, and have access to that client.
Specify the user name.
Specify the password.

Click Login.
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Setting Up Your Window Manager for the Backup, Archive, and
Restore Interface

Always set your window manager so windows become active only when you click inside
the windows. Do not enable auto focus, which is when windows become active if you just
move the mouse pointer over them. The NetBackup-Java interface does not run properly
with auto focus enabled. The following are general instructions for correctly setting up the
focus.

CDE (Common Desktop Environment)

The following explains how to set up a CDE (Common Desktop Environment) window
manager, which is the preferred window manager for NetBackup-Java applications.

1. On the front panel in the CDE window, click the Style Manager control icon.

The Style Manager toolbar appears.

2. On the Style Manager toolbar, click the Window control icon.

The Style Manager - Window dialog box appears.

3. Inthe Style Manager - Window dialog box, click the Click In Window To Make
Active button.

4. Click OK.

5. Click OK when asked to Restart the Workspace Manager.

Motif

When using the Motif window manager, set the Mwm*keyboardFocusPolicy X
resource as follows:

Mwm*keyboardFocusPolicy:explicit

Starting from a Windows Platform

You can also use the Backup, Archive, and Restore interface from a Windows platform, if
you have installed the Windows Display Console. The WDC can only be used to log into a
UNIX client.
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Starting the Backup, Archive, and Restore Interface

1. Click Programs on the Start menu.
2. On the Programs menu, point to NetBackup and then click NetBackup - Java on host
on the submenu.

The Login dialog box appears. Host is the default NetBackup client where you
perform user operations.

To perform user operations on another client, type its name in the NetBackup host
field.

3. Type your user name and password and click Login.

4. When login is complete, the Backup, Archive, and Restore interface appears.
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Adjusting the Time Zone

When working with sites that have geographically dispersed NetBackup server and client
machines, it may be necessary to adjust the time zone when restoring files. Set the time
zone relative to the server’s time zone. NetBackup gives you the ability to adjust the time
zone settings for the current session (and for all future sessions, if you have administrative
capabilities).

There are two situations where it would be necessary to change the time zone settings:

4 You reside in a time zone that is not correctly translated by the underlying Java code
in NetBackup. The Middle European time zone, for example, is interpreted as Middle
Eastern Time. You will need to adjust the time zone settings so that backups receive
the correct datetime stamps.

4 You administer sites that are in different time zones. You may need to adjust the time
zone settings before restoring files.

Example

& You have received a request to restore a backup made on March 3, 2000 at 12:00 a.m.
Eastern Standard Time (EST), which is 5 hours behind Greenwich Mean Time (GMT).

& You reside in the Pacific Standard time zone (PST), which is 8 hours behind GMT.

If you do not change your time zone settings to EST and search for backups created on
March 3, 2000, you will not be able to find the backup. According to your time zone
settings (PST), the backup was created at 9:00 p.m. on March 2, 2000.

V¥ To adjust the time zone settings

1. On the File menu, click Adjust Application Timezone.
The Adjust Timezone dialog box appears.

2. Adjust the time to reflect how many hours/minutes the server’s time zone is behind
or ahead of Greenwich Mean Time.

3. To use daylight savings time, select Use daylight savings time.
4. Indicate when Daylight Savings Time (DST) should begin.

a. Select the method you wish to use for indicating when DST should begin.

- To have DST begin on a specific date, select Absolute date and indicate the
desired month and day.

- To have DST begin on the first occurrence of a day in a month, select First day
of week in month and indicate the desired day of the week and the month.
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- To have DST begin on the first occurrence of a day in a month and after a
specific date, select First day of week in month after date and indicate the
desired day of the week and the month and day.

- To have DST begin on the last occurrence of a day in a month, select Last day
of week in month and indicate the desired day of the week and the month.

- To have DST begin on the last occurrence of a day in a month and before a
specific date, select Last day of week in month after date and indicate the
desired day of the week and the month and day.

b. Select the appropriate Day of week, Month, Day, and Time.

To have DST begin on:
April 1

the first Monday in April

the first Monday after April 1

the last Thursday in April

the last Thursday before April 30

Enter this:

~Daylight savings time starts
Use method:
[ppsolute dats R

Dy ek hAanth: Day:  Time

ISunday ;I IAprﬂ LI |_1j |02:00 j

~Daylight savings time starts
Use method
IF\rst day of week in manth |

D=y of week: konth Dy Time:

|MDnday ll IApnI ;I ’_1ﬂ ’Wj

~Daylight savings time starts
Use method
IFlrSt ey of week In month aftercate | v |

Day of week: hdonth: Day:  Time:

IMDnday j IApn‘I j |_1:| ’Wj

~Daylight savings time starts
Use method:
ILasT. day of weelk in month ll

Day of week: Month: Dyt Time:

IThursdav ;I IApn’I :I |_1j ’ﬁﬂ

- Daylight savings time starts
Use methed
ILast day of week in month before date | w |

Daty of week: ronth: Day:  Tirne:

IThursday ;I IApnI ll ,E:i 02:00 j

5. Asyou did in step 4, indicate when DST should end.
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6. If you have administrative capabilities and wish to have the time zone settings
applied to the current session and all future sessions, select Save as default timezone.

7. Click OK.
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Helpful Hints on Locating and Marking Files

This section explains what you need to know to navigate in the directory trees and filter
files on the Backup Files and Restore Files tabs and how to mark files and folders for
backup or restore operations.

Navigating in the Directory Trees

To display the contents of a folder:

& Click on the folder name in the left pane. The right pane will show the contents of that
folder.

& Folders that have subfolders have a plus sign (+) to the left of the folder. To display
the subfolders, click on the plus sign or double-click on the folder. The left pane will
display the subfolders within that folder.

& On the Restore Files tab, you can also display the contents of a folder by typing the
directory path in the Browse directory box and pressing Enter.

& To collapse a folder, click on the minus sign (-) to the left of the folder or double-click
on the folder.

File Icons

The following icons are used to indicate the file types displayed in the Contents of
Selected Directory pane.

Description Icon

Represents a directory.

Represents a Java file.

Represents a Java class file.
Represents a program file.
Represents an HTML file.
Represents a UNIX link.

Represents a read-only file.

ooe e @D
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Description Icon

Represents a text file.

Represents a bitmap, gif, or icon file. :J

Represents a file that doesn’t have an icon associated with it. B
Filtering Files

You can filter the files and folders shown in the Contents of Selected Directory pane. To
display only filenames beginning with “sys,” for example, type sys* in the Filename
filter field and on the View menu, click Refresh. To display only files with the “txt”
extension, type in *. txt. This filter is case-insensitive.

When starting the Backup, Archive, and Restore interface, * appears in the Filename filter
box. This will display all files.

Sorting Columns

The columns in the right pane can be sorted by clicking on the column header. To sort by
Modified date, for example, click on the Modified column header. Click on the column
header again to sort in descending order.

Marking Files and Folders

¢ To mark afile for backup or restore, select the checkbox to left of a file or right-click on
the file and select Mark Selected Files.

& To select multiple contiguous files, click on the first file you wish to mark, hold down
the Shift key, and click on the last file in the group you wish to mark. To select
non-contiguous files, hold down the Ctrl key as you make your selections.
Right-click and select Mark Selected Files to mark the files you selected.

& To mark a folder for backup or restore, select the checkbox to the left of a folder. A
check mark will appear in the box. A slash mark in the box indicates only some of the
files or subfolders within that folder are marked.

Marking a folder automatically marks all its files and subfolders.

¢ To mark all files displayed in the right pane, from the Edit menu, choose Mark
Displayed Files.
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If more than one version of afile is displayed (because the file was backed up more
than once during the date range selected), NetBackup will mark only the most recent
version.

Unmarking Files and Folders

& Tounmark afile, clear the checkbox to the left of the file, or right-click on the file and
select Unmark Selected Files.

& Tounmark a folder, and all the files and subfolders marked within that folder, clear
the checkbox to the left of the folder.

& To unmark all backup or restore selections, choose Unmark Displayed Files from the
Edit menu.

- 18 NetBackup User’s Guide - UNIX



Performing Backups and Archives

Performing Backups and Archives

This section will step you through a simple backup procedure. The process would be the
same if you choose to archive, except that the files you choose will be deleted after they
are backed up.

This process assumes that you have already started the Backup, Archive, and Restore
interface as described in “Starting the Backup, Archive, and Restore Interface” on page 10.

Vv To perform a backup

1. Click the Backup Files tab.

EBackup, Archive, and Restore [logged into hagar] ;|g|5|

VERITAS NetBackup~

File Edit “iew Actions Help

MetBackup server: Source client: Folicy type: Destination client: ﬂ

hagar hagar Standard hagar

Backup F”951 Restare Files | Task Progress]

Directo : :Filename filter:

#03 °F

Marme | size | Modified |
O DeadLetters 51212/21/2000 13:24:13 =
O dev 3584 10011152001 10:07:08
O3 devices 812 12i2002000 16:49:17
O et 3584 0211052002 0310043
O expart 5121212002000 16:15:07
O floppy 5812071972001 14:25:09
O hame 2021152002 14:52:31
OB ibuilds 181202062000 16:57:599
Q& intouild 191272062000 16:57:599
O kernel 8121212002000 16:18:10
O& b 91272072000 16:18:06 N
O3 lost+found 192 071752001 12:28:11
O mail 8121212172000 132413
O mnt 512 12i20/2000 16:18:06
DB nbjCaonf 1693 061452001 15:31:08
10 mketunit A1 A0 110742
L MR

2. If necessary, change the NetBackup master server that will perform the backup.

If there is more than one master server to which you can send your backups and
archives, ensure that you are connected to the correct one. Ask your NetBackup
administrator if you have questions about which master server to use.
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Normally, you will not have to switch master servers unless, for some reason, the
administrator has temporarily moved the NetBackup backups (for example, because
of a problem on the original master server). If the change becomes permanent, the
administrator should change your default to reflect the other server.

a. On the Actions menu, click the Specify NetBackup Machines.
b. Click on the NetBackup server tab.

c. Select the desired server from the list.

If you indicate an invalid name, or if your client does not belong to a NetBackup
policy on that server, you will get an error when the backup begins. If this occurs,
see your system administrator for assistance.

d. Click OK.

Select the file or files to back up. In this example the selected file is sample. txt.

ﬂNetBackup Administration Console [logged into hagar] - |EI|1|
VERITAS NetBackup~
File Edit “iew Actions Help |
B « = |‘
N MetBackup server: Source client: Folicy type: Destination client: =
» |
hagar hagar Standard hagar
Backup F”951 Restore Files] Task Progress]
Directo : :Filename filter:
=HAC s
EH D hame Contents of selected directory
=HA( eblaufus
#0OOs
_1'_H:|[:| mac
O resds_tree
[P sample

anckup... .
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You can filter the files and folders shown in the Contents of Selected Directory pane.

Once you have entered the filter criteria, click Refresh from the View menu. For more
information, see “Filtering Files” on page 17.

4. Click Backup to start the Backup operation.
The Backup Files dialog box is displayed.

MetBackup server:

Ihagar Vl

Files Marked for Hormal Backup
Mame |

fhomelfehlaufusisample

Eermayeiror st |

_ | Archive files (delete files after successiul hackup)

Keyword phrase to agsociate with this backup or archive {optional):
hestbackup

Start Elackupl Cancel |

To associate a keyword phrase with the backup or archive, type a keyword or phrase
into the Keyword phrase to associate with this backup or archive box. You can then

search for that keyword or phrase if you wish to restore this specific backup or
archive.

In this example, the keyword phrase test backup is used.

To delete the file after it has been backed up, select Archive files.

To remove a file from the list of files to back up, select the file and click Remove
from list.

6. Click Start Backup to begin the backup operation.

Note The NetBackup operation may take a few minutes to complete.

You will be prompted to view the status of the backup operation.

7. Click Yes to open the Task Progress tab.

. ————
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The Task Progress tab allows you to view the progress report of a NetBackup
operation. For more information, see “Viewing the Progress of Backups and Restores”

on page 30.

mNetBackup Administration Console [logged into hagar] - | Dlll
VERITAS NetBackup™
File Edit Wiew Actions Help |
Je - m@E
4 hNetBackup server: Source client: Faolicy type: Destination client: |
3 A
hagar hagar Standard hagar

Backup Files] Restore Files] Task Progress

Update Tagk L\stl
elete |

Tasks Performed
Status

0211152002 1

El| Backup

~Results ofthe Task Selected Above

_ | Auto Refresh  Rate (zeconds) 1D::| _ | Full Contents

15:28:41 Initiating backup

145:29:09 INF - Processing fhomeieblaufusisample

14:29:09 WRN - fhomefeblaufusisample is on file systermn type NFS. Skipping.
18:29:10 IMNF - Client completed sending data for backup

15:29:15 INF - Beginning backup on server hagar of client hagar.

———
- 22 NetBackup User’s Guide - UNIX



Performing Restores

Performing Restores

This section will step you through a simple restore process, using the same file that was
backed up in the previous section. It assumes that the Backup, Archive, and Restore
interface has already been started as described in “Starting the Backup, Archive, and
Restore Interface” on page 10.

Notes on Performing Restores

2

2

Before performing a restore, ensure that the correct or desired time zone settings have
been set. See “Adjusting the Time Zone” on page 13.

If there are any links in the path you are searching, NetBackup, by default, resolves
the links so the path points to the actual file or directory. If you do not want to resolve
links, deselect Use Actual Path If Browse Directory is Linked on the View menu
before starting your search. See “Resolving Links” on page 42 for more information.

NetBackup restores files according to the original file pathname. If the files you are
restoring already exist, you must have the proper file permissions in order to
overwrite the existing files with the files that were backed up. See “File Permissions
Required By NetBackup” on page 7 for an explanation of how NetBackup restores
files in various situations.

Tips on Locating Files and Folders to Restore

You can narrow your search by indicating the following information. When finished,
update the right pane by clicking Refresh on the View menu.

2

2

If you know the exact directory you wish to browse, type the path to that directory in
the Browse directory box.

You can filter the files and folders shown in the Contents of Selected Directory pane.
Once you have entered the filter criteria, from the View menu, click Refresh. For more
information, see “Filtering Files” on page 17.

If you indicated a keyword phrase when you performed a backup, you can use that
keyword or phrase to locate that backup by specifying that keyword phrase (from the
Actions menu, click Set Keyword).

Chapter 2, Using the Backup, Archive, and Restore Interface 23 v



Performing Restores

V¥ To perform arestore

1. Click the Restore Files tab.

Note When the Restore Files tab is displayed intially, nothing is shown in either pane.

File Edit Wiew Actions Help

ﬂNetBackup Administration Console [logged into hagar]

VERITAS NetBackup~

=10/ x|

3¢9 am

gl

=none=

l‘ NetBackup serer: Source clignt: Folicy type: Destination clignt: J
b A
hagar hagar Standard hagar
Backup Filesw Restore F”ESW Task Progress}
Restore Type:
Keyword Phrase: Start Date: End Date:

021112002 23:59:59 g

1211372001 11:02:02

Browse directony:

Filename filter:

N
P b
Directory Structure

Mame

Contents of selected directory

% A [ 8

| Backuppate | sim | Modified

[ [
Erevii | RESireL,

Change the NetBackup master server if necessary.

If there is more than one master server that can back up this client, ensure that you are
connected to the one that performed the backup you are trying to restore. If you
attempt to restore from another master server, the files will not be found. Ask your
NetBackup administrator if you have questions about which master server to use.
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a. On the Actions menu, click Specify NetBackup Machines.
b. Click on the NetBackup server tab.
c. Select the desired server from the list.

d. Click OK.

If you indicate an invalid name, or if your client does not belong to a NetBackup
policy on that server, you will get an error when attempting to browse for files to
restore. If this occurs, see your system administrator for assistance.

3. Select the type of restore to perform. From the Actions menu, point to Select Restore
Type, or select an option from the Restore Type list box.
- To restore a backup, click Normal Backup.
- Torestore an archive, click Archived Backups.

- To restore from a raw partition backup, click Raw Partition Backups. See
“Restoring Raw Partitions” on page 159 for more information.

- To restore a true image backup, click True Image Backups. For more information
on restoring a true image backup, see “Restoring a True Image of a Directory” on
page 40.

- To restore a Backup Exec backup, click Backup Exec Backups. For more
information on restoring a Backup Exec backup, see “Restoring Backup Exec
Images” on page 35.

- To restore both regular backups and Backup Exec backups, click Normal and
Backup Exec Backups.
4. Select the folder or file to restore.

You can filter the files and folders shown in the Contents of Selected Directory pane.
Once you have entered the filter criteria, click Refresh on the View menu. For more
information, see “Filtering Files” on page 17.

In this example, we will use the keyword phrase feature to restore the sample. txt
that was backed up in “Performing Backups and Archives” on page 19.

a. From the Actions menu, click Set Keyword.

b. Type test backup in the New keyword phrase box and click OK.
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c. Inthe right pane, select the checkbox to the left of the sample. txt file.

ﬂNetBackup Administration Console [logged into hagar] - |EI|1|
VERITAS NetBackup~

File Edit “iew Actions Help |
3 e~ m@E

N MetBackup server: Source client: Folicy type: Destination client: =

» |
hagar hagar Standard hagar

Restare Type:

Keyword Phrasze: |
test backup =

INormaI Backups ll

Backup Files] Restore FHESW Task Progress]

Start Date: End Drate: | |
02/11/2002 15:58:06  02/11/2002 15:58:06 &

Browse directany:

h Y

Filename filter:

Phomeieblaufusr

=HAC:
=HALCD home
=HZIC eblaufus
L7133 sample

Contents of selected directory
MName

0211f

& 5 Gl 6|

Backup Date i Modified

Preview |

Restore... |

5. Click Restore.
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The Restore Files dialog box is displayed.

ﬂRestore Files x|

e

Destination

(® Restare everything to its ariginal location.

_) Restare everything to a different location {maintaining existing structure).

ETTeE e StirALHE
Phomereblaufusrsamplei Phomereblaufusrsamplei

_) Restore individual directaries and files to different locations.

Source Destination | Backup Date Modified
[ [
Ehange Selected Destinationis).. | Ehanye Al Destinaiuns. .. |
Ao e stinEtin.. | Eemoyeselecied Hestinations) |
~Option
_ | Overwrite existing files | Renarqe fiard ks

_ | Restore directories without crossing mount points | Rename soff links

Start Restore | Cancel |

By default, files will be restored to their original location. See “Redirecting Files to a
Different Path” on page 36 for information on restoring all files to a different
destination or restoring individual files to multiple destinations.

6. Select Overwrite existing files. By default, NetBackup does not overwrite files.
7. Select Restore directories without crossing mount points to skip over file systems

mounted in the selected directories. Clear this checkbox to restore file systems that are
mounted in the selected directories.

Note Mount points inside will get restored whether or not the Restore directories
without crossing mount points checkbox is selected.
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8. If you are restoring files that are links, choose whether to update those link
pathnames.

- Select Rename hard links to rename the hard link pathnames. Clear the Rename
hard links checkbox if you do not want to rename the hard link pathname.

- Select Rename soft links to rename the soft (symbolic) link pathnames. Clear the
Rename soft links checkbox if you do not want to rename the soft link pathname.

Note If you are restoring system files to a disk other than the current system disk and
plan on using the other disk as the system disk with the original file paths when the
restore is completed, we suggest that you select the Rename hard links checkbox
and clear the Rename soft links checkbox. This will let you use the other disk and
have the correct file paths.

9. Click Start Restore to begin the restore operation.

You will be prompted to view the status of the restore operation.

10. Click Yes to open the Task Progress tab.
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The Task Progress tab allows you to view the progress of a NetBackup operation. For
more information, see “Viewing the Progress of Backups and Restores” on page 30 .

ﬂNetBackup Administration Console [logged into hagar] - |EI|1|
VERITAS NetBackup~ Y

Wl Ul DataCenter SV
File Edit “iew Actions Help |
3 e~ m@E
N MetBackup server: Source client: Folicy type: Destination client: &
» |
hagar hagar Standard hagar

Backup Files] Restore Files] Task Progress

Tasks Performed

Update Task Listl
elete |

Status

‘estore

[ Backup 021152002 15:57:51 Successful
[ Backup 021152002 15:46:41 Successful
[ Backup 021152002 15:28:38 Successful

~Results ofthe Task Selected Above

@ _ | Auto Refresh  Rate (secands): 10::| _| Full Contents

16:12:39 (4950013 Restoring fram image created Mon Feb 11 15:58:06 2002
16:12:40 (495.001) TAR STARTED

16:12:43 (495001 Changed fhomelehlaufusisamplelsample td to fhomelehlaufusils!
16:12:43 (495001 Directory thomeleblaufusils exists. Keeping it.

16:12:43 (495.001) INF - TAR EXITING WITH STATUS =10

16:12:43 (495.001) INF - TAR RESTORED 0 OF 1 FILES SUCCESSFULLY

AR AT AA SARE ANALIRIE T LA A CueT R e T e

3]
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Viewing the Progress of Backups and Restores

V¥ To view the progress of a backup or restore
1. Click the Task Progress tab.
2. Click Update Task List to refresh the list of tasks being performed.

3. Click on the task for which you want to check the progress.
The lower pane will reflect the progress of the item selected in the top pane.

4. To automatically refresh the results of the tasks, select Auto Refresh and select a
refresh interval.
The default setting is 10 seconds. A smaller interval may negatively affect server
performance.

5. By default the progress file is displayed in an abbreviated form. If you wish to view
the entire contents of the progress file, click Full Contents.

The NetBackup operation is finished when the Status changes to Successful. If the task
failed, review the results of task log and check with your NetBackup system
administrator.
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Advanced Restore Procedures

The following procedures provide detailed explanations for performing advanced
restores.

Searching for Files to Restore

Occasionally, you might want to restore a file or directory, but you may not remember
where it is, or was, located. The Find feature allows you to specify a file or directory name
and search for it.

v To find a directory or file

1. Inthe Backup, Archive, and Restore interface, click on the Restore Files tab.
2. On the Actions menu, click Search Backups.
The Search Backups dialog box appears.

3. Inthe File or directory name box, type the name of the directory or file you wish to
search for.

You can use the wildcard symbol (*) to search for a directory or file if you are unsure
of the exact name or wish to display directories or files with similar names.

4. If you want to perform a case-insensitive search, select the Perform case insensitive
search option. The default is case-sensitive, meaning the file name must match exactly
as it was entered.

For example, if you type sample. txt and select case-sensitive, NetBackup will only
find files that use that exact capitalization. The files Sample. txt and SAMPLE . TXT
would not appear in the results.

5. Click Search.

NetBackup will display all backups of the directory or file you entered.
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Note It may take a few minutes for the list of files to refresh.

ﬂ5earch Backups x|

File or directory name:

|SE”""”:'|‘3-D"t Search

|J Ferform case insensitive search |

Results of Search

Mame | Size | Backup Date | Modified |
sample.bd 20480 02/11/2002 15:58:08 10/17/2001 09:20:33

QKl gancell

6. To select a file or folder, click on the checkbox to the left of the file or folder.

7. Click OK to return to the Restore Files tab in the Backup, Archive, and Restore
interface.

The files or folders you selected are now marked to be restored.

8. To start the restore operation, click Restore.

Selecting Specific Backup Dates to Restore

By default, the NetBackup Restore window shows the files and folders that were backed
up since the last full backup. The default range will satisfy the majority of your needs to
restore files but there will be times when you must restore a file that was not backed up
during the default time period. For example, a file that was deleted prior to the last full
backup will not appear in the default display. To locate and back up this file, you would
need to change the date range.
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If the client belongs to more than one policy, the starting date defaults to the last full
backup that occurred first. For example, assume that: (1) a client belongs to PolicyW1 and
PolicyW?2, (2) Full backups occur for both of these policies, (3) PolicyW1’s most recent full
backup occurred on June 16 and PolicyW?2’s most recent full backup occurred on June 24.
NetBackup will display those files and folders that have been backed up since the
PolicyW1 full backup on June 16.

Note The Contents of Selected Directory pane will show only the files and subdirectories
that were backed up during the range of dates indicated. If a file or directory was
backed up more than once during the date range selected, multiple copies of that
file or folder will appear in the right pane.

Setting the Date Range
There are two ways you can set the date range: by selecting the dates using the Calendar,
or by selecting the dates using the Backup History.

V¥ To set the date via the Calendar

1. Onthe Actions menu, point to Set Date Range, and click Calendar.

The Date Range dialog box displays.
2. Click the Start Date tab.

3. Select the desired start date on the calendar.

- To change the month, select the desired month from the drop-down list in the
upper left-hand corner of the dialog.

- To change the year, select the desired year from the drop-down list in the upper
left-hand corner of the dialog.

- Tochange the time, select the part of the time you wish to change. Use the spinner
controls to indicate an earlier or later time.

Time:

4. Click the End Date tab and choose the desired end date.

5. Click OK.
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V¥ To set the date via the Backup History

1. On the Actions menu, point to Set Date Range, and click Backup History.
The Date Range dialog box appears.

2. Select the desired backup image or images from the list.

[Elpate Range
Backup History

Backup Date Expires Files

Keywaord Phras
test backup
test backup
hagar_user_backup  testbackup

0211172002 15:28:56 02r25/2002 0 32 Mo UserBackup

IQ_K gancell

Tip  To select multiple contiguous backup images, select the first backup image, press
the Shift key, and click the last image in the group you wish to select.

3. Click OK.

Restoring an Earlier Version of a Directory

The following procedure will restore all files that were backed up during the range of
backup dates that you searched for files to restore. This includes files that were deleted
from your online directory after they were backed up. If you do not want the deleted files,
use the procedure described in “Restoring a True Image of a Directory” on page 40.
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V¥ To restore an earlier version of a directory

1.

2.

Click the Restore Files tab.

Select the desired Restore Type. (On the Actions menu, point to Select Restore Type
and choose the desired type of restore, or select a type from the Restore Type list box.)

Use the Calendar or Backup History list to select the date range that contains the
version of the directory you wish to restore.

From the Directory Structure pane, select the directory you wish to restore. Check the
right pane to see if it shows the files you need.

Note By default, NetBackup restores the directory to its original location. To restore to a

different location, see “Redirecting Files to a Different Path” on page 36.

5.

6.

Click Restore.
The Restore Files dialog box is displayed.

Click Start Restore to begin the restore operation.

Restoring Backup Exec Images

It is possible to restore Backup Exec images or both Backup Exec and NetBackup images
in a single NetBackup restore job.

V¥ To restore from Backup Exec images

1.

2.

Start the Backup, Archive, and Restore interface interface.
Click on the Restore Files tab.

Select the desired Restore Type.

- To restore Backup Exec images, on the Actions menu, point to Select Restore
Type and click Backup Exec Backups.

- To restore Backup Exec and NetBackup images, on the Actions menu, point to
Select Restore Type and click Normal and Backup Exec Backups.

Select the files or folders to restore.

Click Restore.
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The Restore Files dialog box will open.

6. Select the desired restore options.

By default, files will be restored to their original location. See “Redirecting Files to a
Different Path” on page 36 for information on restoring all files to a different
destination or restoring individual files to multiple destinations.

Note When both Backup Exec and NetBackup images are being restored, files cannot be
redirected to a different path.

7. Click Start Restore to start the restore operation.

Redirecting Files to a Different Path

In some instances, you may want to restore items to a file or path other than the one from
which they were backed up. All items can be restored to a different path or individual
items can be restored to different paths.

Restoring Everything to a Different Path

Note When both Backup Exec and NetBackup images are being restored, files cannot be
redirected to a different path.

V¥ To restore everything to a different location
1. Click on the Restore Files tab.

2. On the Actions menu, point to Select Restore Type and choose the desired type of
restore, or select the restore type from the Restore Type list box.

3. Select the files or folders you wish to restore.

Note You will be able to restore files and folders differently depending on how you mark
the files and folders for a restore. If you wish to restore an entire folder and all its
contents to the same location, mark the folder in the left pane. If you wish to restore
the files in a folder to different locations, mark the files in the right pane.

4. Click Restore.
The Restore Files dialog box is displayed.
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5. Select Restore everything to a different location.

6. Inthe Destination box, enter the directory to which you want to restore the files or
folders.

ﬂRestore Files x|

General

Destination

_) Restare everything to its original location.

(® Restare everything to a different location (maintaining existing structure).

Source: Destination:
Phomeieblaufusr lfh0meIeblaufusisample_original

_) Restore individual directaries and files to different locations.

Source Destination | Backup Date Modified
[ [
Ehange Selected Destinationis).. | Ehanye Al Destinaiuns. .. |
Ao e stinEtin.. | Eemoyeselecied Hestinations) |
~Option
_ | Overwrite existing files W Rename hard links

_ | Restore directories without crossing mount points & Rename soft links

Start Restore | Cancel |

When restoring from Backup Exec images, files must be redirected to the export path,
as defined in the agent . cfg file on the UNIX client (this file is a Backup Exec
configuration file for the Backup Exec Unix client). Files can only be redirected to this
path. For example, if the export path is defined as export\diri, files can be
redirected to the path export\diril (or to export\dirl\dir2).

7. Select any other desired restore options. For information on these options, refer to
“Performing Restores” on page 23.

8. Click Start Restore.
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Restoring Individual Items to Different Paths

Note When Backup Exec images or both Backup Exec and NetBackup images are being
restored, individual files cannot be redirected to a different path.

V¥ To restore files and directories to different locations
1. Click on the Restore Files tab.

2. On the Actions menu, point to Select Restore Type and choose the desired type of
restore, or select a restore type from the Restore Type list box.

3. Select the files or folders you wish to restore.

Note You will be able to restore files and folders differently depending on how you mark
the files and folders for a restore. If you wish to restore an entire folder and all its
contents to the same location, mark the folder in the left pane. If you wish to restore
the files in a folder to different locations, mark the files in the right pane.

4. Click Restore.
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5. Select Restore individual directories and files to different locations.

ﬂResture Files x|

General

rDestination

) Restore everything to its original location

) Restore everthing to a different location (maintaining existing structure)

SOUrGEE [estination
llhumefeblaufusi Fhumeieblaufusi

(® Restore individual directories and files to different locations

Source Destination Backup Date Modified

‘homefeblaufusils

Change Selected Destination(s)... | Change All Destinations... |
Add Destination... | Eemave Selected Destinationis) |
~Option:
R Overwrite existing files W Rename hard links

| Restare directories without crossing mount points & Rename soft links

Start Resiore I Cancel |

6. Select the file or directory which you want to restore to a different location.

You can select multiple files and folders using Ctrl + click or Shift + click (see
“Marking Files and Folders” on page 17).

7. Click Change Selected Destinations.
8. Inthe Destination field, enter the destination for the file or files.
9. Click OK.

10. Select any other desired restore options. For information on these options, refer to
“Performing Restores” on page 23.

11. Select Overwrite existing files.

12. To begin the restore operation, click Start Restore.
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Restoring a True Image of a Directory

A true image restore of a directory, by default, restores the directory so its contents are
exactly what they were at the time of the most recent automatic full or incremental
backup. Files deleted prior to the specified backup are not restored.

A true image restore is the best choice if, for example, you have recently cleaned up a
directory by deleting unwanted files and now want to restore the latest version without
having to repeat your cleanup. It is also possible to restore the true image of an earlier
version of a directory.

Example of a True Image Restore

To illustrate the concept of a true image restore, consider the following table, which shows
the contents of a directory named home /abc/doc during a series of backups performed
between 12/01/00 and 12/04/00.

Day 12/01/00  12/02/00 12/03/00  12/04/00 12/04/00
Type of Backup  (Full) (Incr) (Incr) (User Back) (Incr)
filel filel filel filel filel
file2 file2 file2 file2 file2
dirAffileA  dirAffileA dirAffileA dirAffileA -
dirB/fileB - - - -
file3 - - - -
dirCffileC -
file4 file4

Assume that you are going to restore the most recent version of the directory.

¢ If you perform a standard restore, NetBackup will restore all files and subdirectories
that were backed up during the time period from 12/01/00 (last full backup) through
12/04/00.

filel
file2
dirA/fileA
dirB/fileB
file3
dirc/filecC
file4
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& If you restore a true image backup, NetBackup restores only the files and directories
that existed at the time of the incremental backup on 12/04/00.

filel
file2
file4

NetBackup does not restore anything deleted prior to the 12/04/00 incremental
backup.

Notice that the restored directory does not include the dirA and dirC subdirectories,
even though they were backed up on 12/04/00 with a user-directed backup.
NetBackup did not restore these directories because they did not exist at the time of
the incremental backup that was the reference for the true image restore.

True Image Restore and Overwriting

If you are overwriting the directory you are restoring, NetBackup does not delete files that
are currently in the directory but not in the true image restore backups.

Using the previous example, if you had created a file5 after the incremental backup
occurred on 12/04/00, but before doing the restore, then the contents of the directory after
the restore would have been:

filel
file2
file4
file5 (thisis the new file that is not in any of the backups)

Vv To restore atrue image of a directory

Note You can restore a true image of a folder only if the NetBackup Policy that is backing
up your files is configured to collect true image restore information prior to backup.
If in doubt, ask your NetBackup administrator.

Note NetBackup does not allow a true image restore that is based on the time of a
user-directed operation. However, NetBackup does use the data from a
user-directed operation when performing a true image restore if the user backup is
more recent than the latest automatic full or incremental backup.

1. Click on the Restore Files tab.
2. Make sure that your root directory is selected.

3. From the Actions menu, point to Select Restore Type and choose True Image
Backups.
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4. To refresh the list of backups available for restore, click Refresh on the View menu.

5. Select the directory that you want to restore.

Since you are restoring a directory in its entirety, as it existed on a specific date,
NetBackup only allows you to select one version of the directory. For the same reason,
the Mark All button is also disabled.

Note If NetBackup does not find any directories, check the range of dates and path. If
these settings are correct and no directories are found, check with your
administrator to see if the NetBackup Policy that is backing up your files and
directories is configured to collect true image restore information.

6. Click Restore.
The Restore Files dialog box is displayed.

7. To begin the restore operation, click Start Restore.

By default, the folder is restored to its original location.

Resolving Links

When searching for files to restore, you can choose whether to have NetBackup resolve
links that may exist in the search path. If you resolve links, NetBackup automatically
changes the path so it points to the actual file or directory. Otherwise, NetBackup uses the
path you type in. bpSAa resolves links by default, unless you deselect Use Actual Path If
Browse Directory is Linked (on the View menu) before starting your search.

Note NetBackup does not resolve links if you use wildcard characters in the search
directory path.

It is usually best to resolve links. There are exceptions, such as the following:

¢ If you backed up a file that was not a link and, since then, the file path was linked to a
different directory.
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For example, assume you backed up /home/bjm and this directory is now a link to
/home2/bjm. If you resolve links during the restore, NetBackup will not find the file
because it will search for /home2/bjm and /home /bjm was the path you backed up.

1. Directory is backed up.
/home/bjm -

Backup Image

2. File path is linked to a different directory.
/home/bjm ——p» /home2/bjm

3. User attempts to restore the directory.
If links are resolved:

NetBackup resolves the directory to /home2/bjm

and cannot find it in the backup image. —_—— -
home/bi Ihome2/bi < Directory not N
E— —_—
/home/bjm ome2/bjm \ _ restored _

—_— e ——

If links are not resolved:

NetBackup does not resolve the directory and is
able to restore it.

/home/bjm > Directory
restored

& Ifyou are restoring a file to your machine that was backed up by another client. There
will be a problem if the path exists as a link on your machine, but not on the other
client.

For example, assume that the path /usr/openv/ is linked to /opt /openv on the
local machine, but not on the other client machine. If you deselect Use Actual Path If
Browse Directory is Linked, jbpsa will look for /opt /openv on the other client,
even though the path doesn’t exist on that client.
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Tips and Troubleshooting

The following sections provide information on some common issues.

Right Mouse Button Does Not Invoke Pop-up Menu

On a Solaris x86 with a two-button mouse, right-clicking will not invoke the pop-up
menu.

To invoke the pop-up menu

1. Press and hold the right mouse button.
2. Press the Ctrl key.

3. Release the right mouse button.

4. Release the Ctrl key.

Differentiating Between Different Backups on the Same Day

By default the Restore Files tab only shows the latest file entries since the last full backup.
This is designed to reduce the number of files displayed.

Sometimes it is useful to see all the available backups, perhaps to restore the version from
three days ago. In this instance, use the Calendar or Backup History list to select the
appropriate date (see “Selecting Specific Backup Dates to Restore” on page 32).

If a file or folder was backed up more than once during the date range selected, multiple
entries will be shown for that file or folder. You can narrow the list by entering a smaller
date range or by changing the time.

Restoring a File Not Initially Shown on the List

If a file is not initially shown in the list of files that can be restored, it is likely that the file
was backed up by the user, and not in the last full backup. Use the Backup History list to
select user backups for specific dates or use the Calendar to specify a new start date, then
click Refresh on the View menu.
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Unmarking a File Takes a Long Time

Sometimes when you unmark a file it may take a long time before control of the
application is returned to you. This can happen when you have marked an entire
directory (in the Directory Structure pane) and then you unmark a single file in the
directory.

Selecting an Invalid Policy Type Causes Problems

Although it is possible to change the Policy type, in most situations the default policy type
is appropriate and should not be changed.

Symptoms of an invalid policy type are:

¢ All attempts to back up files fail. The following error message appears in the Task
Progress tab for each failed backup:

no active policies in the configuration database are of the
correct policy type.

& Existing backups do not appear in the Directory Structure and Contents of Selected
Directory panes.

If you suspect a problem is caused by an invalid policy type setting, change the Policy
type to the value appropriate for your operating environment (“Standard” for UNIX). If
problems persist, ask your NetBackup administrator for advice on setting this to match
your organization’s NetBackup configuration.
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This chapter explains how to use the NetBackup menu interface program, bp, to perform
NetBackup operations. The menu interface is character-based so you can use it at any
terminal (or terminal emulation window) for which you have a termcap or terminfo
definition. You can also use the X-Windows interface (Xbp) or the Backup, Archive, and
Restore interface (jbpSa) on any terminal with the proper prerequisites. The menu
interface has the functionality of xbp and jbpSa but with a menu-driven presentation.

The purpose of this chapter is to provide step-by-step procedures for using the menu
interface. If you need information about specific screens or menu options within the
interface, refer to Chapter 5, “Reference Guide to xbp and bp” on page 105.

The areas covered here are:

¢ Starting the Menu Interface

¢ Performing Backups or Archives
¢ Performing Restores
2

Checking Progress of Operations
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Starting the Menu Interface

Start the menu interface program by typing the /usr/openv/netbackup/bin/bp
command.

When bp starts, the Main Menu appears on your screen as shown.

window  Edit Options Help

NetBackup 4.5

Master Server: hagar
Client: hagar

Main Menu

b} Backup...
r) Restore...

h} Help
q) Quit

ENTER CHOICE:

The name of your client and NetBackup master server are shown at the top of the menu. If
more than one master server is available to your client, you can use the m (Change Master
Server) option on the Backup Menu to select another server.

Performing Backups or Archives

The following procedure explains how to perform a backup of files, directories, or raw
partitions or to archive files and directories. The main difference between backups and
archives is that an archive deletes the designated directories and files from your disk after
successfully backing them up.

1. Type the following command line:

/usr/openv/netbackup/bin/bp
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The Main Menu displays.

window  Edit Options

Help

NetBackup 4.5

Master Server: hagar
Client: hagar

Main Menu

b} Backup...
r) Restore...

h} Help
q) Quit

ENTER CHOICE:

2. Select the b (Backup) option. The Backup Menu displays.

~i Consale

window  Edit Options

Master Server: hagar
Client: hagar

Backup Menu

o} Backup Oracle DE...

i) Backup Informix DE...

s} Backup Sybase DEB...

p) Backup SAP DB...

2} Backup DBZ DEB...

£} Backup SQL-BackTrack DB...

m} Change Master Server...
h} Help
q) Quit Menu

ENTER CHOICE:

b} Backup Files and Directories...
a) Archive Files and Directories...

[

Refer to “Backup Menu” on page 133 for details on this menu.

Note The following menu items do not apply to BusinesServer: Backup SAP DB, Backup

DB2 DB, and Backup SQL-BackTrack DB.
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Check the name in the Master Server field. This field shows the name of the server to
which NetBackup will send your backups. When you start the bp interface program,
the default master server is your client.

You should not have to switch master servers unless the administrator has moved the
backups. If the change becomes permanent, the administrator should change your

default to reflect the other master server.

To change master servers, choose the m (Change Master Server) option and type the
name of the other server. If you type an invalid name or your client does not belong to

a policy on that server, you will get an error.

3. Select the b (Backup Files and Directories) option. The Backup of Files and Directories
menu will appear.

window  Edit Options

Search Path:
Start Date:

End Date:
Master Server:
Display Mode:
Files selected:
Keyword Phrase:

Backup of

Joptiopeny/netbackupsbing
01/01/1970 00:00:00
08/22/2001 23:59:59

hagar

Brief

1}

Files and Directories

s)
el
i)
pJ
)
m)

Select

Files and Directories...

Edit/view Selected Files...
Initiate Backup

Change
Change
Change
Change
Change
Help

Search Path...

Date Range...

Master Server...
Keyword Phrase...
Display Mode to Verbose

Quit Menu

ENTER CHOICE:

4. Check the Search Path field at the top of the menu to see if it is set to the directory
where you want to start the search for the desired files. At start-up, NetBackup sets

Search Path to your current working directory.

In this example, we are going to backup the release notes. txt file located in the
/usr/openv/netbackup/ directory.
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a. Tochange the path, choose the p (Change Search Path) option from the Backup of
Files and Directories menu. The following prompt displays.

Ai Console IE iJ

window  Edit Options Help
Current File Path: fopt/openv/netbackup/bin/
Mew File Path: | =

b. Type the following for the New File Path.

/usr/openv/netbackup/
c. Press Enter to return to the Backup of Files and Directories menu.

5. Check that the Start Date and End Date fields include the last-modified dates of the
files you want to back up.

a. To change the range of dates, select the d (Change Date Range) option from the
Backup of Files and Directories menu. The following prompt displays.

=] Console ==
window  Edit Options Help

Current Start Date: 0140141970 00:00:00
Mew Start Date: [ ]

o
b. Type the new Start Date.
c. Press Enter. The following prompt displays.
Ai Console [= iJ
window  Edit Options Help
Current End Date: 11/08/2001 23:59:59 |
Mew End Date: [ ] ’:

d. Type the new End Date.

e. Press Enter to return to the Backup of Files and Directories menu.
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6. Type the keyword phrase you want to use to identify the backup. In this example, we

will use the keyword bptest.

a. Select the k (Change Keyword Phrase) option from the Backup of Files and

Directories menu. The following prompt displays.

~i Consale

window  Edit Options

| Enter keyword: ()

b. Type the keyword bptest.

c. Press Enter to return to the Backup of Files and Directories menu.

7. Select the files and directories you want to back up.

a. Select the s (Select Files and Directories) option from the Backup of Files and

Directories menu. The following prompt displays.

~i Consale

window  Edit Options

-B/optsopeny/nethackup/
.upgrade. to. 3,404
.upgrade.to.4.5
.upgrade.to.4.5
MediaMgr_DeviceConfig_cuide. txt
bins
bp. conf
catalog/
clients
db/
dbext/
axt/
helps
help.3.4G04/
help.4.5Predlpha/
Togs/
nbesa
release_notes. txt

Selections: 0 Current Path: foptfopenv/netbackup/

sdk/
Zoom{Iin (Z)oomOut {Sielect (Black (Flwd (UWp (DIn (Lleft (Riight (0Dk _J

b. Use the menu options at the bottom of the screen to browse the file system and

select the desired files and directories.
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c. Choose the (S)elect option to select the release notes. txt file. Anasterisk (*)

displays to the left of the selected file.

= (==
Window Edit Options Help
Selections: | Current Path: foptfopenv/netbackup/
Joptfopenv/netbackups
.upgrade. to. 3,404
.upgrade.to.4.5
.upgrade.to.4.5
MediaMgr_DeviceConfig_cuide. txt
bins
bp. conf
catalog/
clients
b/
dbext/
axt/
helps
help.3.4G04/
help.4.5Predlpha/
Togs/
nbess
*Erslease_notes.txt
5
Zoom{Iin (Z)oomOut {Sielect (Black (Flwd (UWp (DIn (Lleft (Riight (0Dk

If you select a directory, all files and directories below the selected directory will
be selected. An asterisk (*) will appear to the left of the selected directory.

d. Select the (O)k option to return to the Backup of Files and Directories menu.

8. Preview the files and directories you have selected to back up.
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a. Select the e (Edit/View Selected Files) option from the Backup of Files and

Directories menu. A list of the selected files displays.

~i Consale

window  Edit Options

Humber of Selections = 1

-B/opt/openy/nethackup/release_notes. txt

(A)dd Selection Un{Sielect (Cilear (Black ({Fwd (Uip (DIn (Lleft (R}ight (0Jk _J

This screen lists your selections and lets you make changes.

b. Make sure the release notes.txt file appears in the list.

c. Select the (O)k option to return to the Backup of Files and Directories menu.

9. Start the backup operation.

Note You can return to the Backup of Files and Directories menu at any time up to

starting the operation by pressing the Escape key.

a. Select the i (Initiate Backup) option from the Backup of Files and Directories

menu. The following prompt displays.

~i Consale

window  Edit Options

Use progress Tog? Cyind Oyl 0
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b. Type y to create a log file and write to this file as the operation progresses. The
following prompt displays.

=] Console ==
window  Edit Options Help

Use progress Tog? (y/n) (yd: v
Enter Progress File Path: (/bplog.bkup.003) B

If you do not want logging, type n to start the operation and go to step d.

c. Press Enter to accept the default (shown in parentheses), or type a new path and
press Enter. The operation begins when you press Enter. The following prompt
displays.

=] Console ==
window  Edit Options Help

Initiating Backup . . .

The backup was successfully initiated.

| |Bress any key to continue =

d. Press any key to return to the Backup of Files and Directories menu.

10. Select the Q (Quit Menu) option to return to the Main Menu.
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Performing Restores

NetBackup restores files according to the original file pathname. If current files have the
same names as backed-up files, you can specify whether or not to overwrite the current
files (file permissions must allow overwriting). See “File Permissions Required By
NetBackup” on page 7 for an explanation of how NetBackup restores files in various
situations.

Note When restoring NetWare backups, set the directory depth to a minimum of 6 to
ensure that the backup image is displayed.

Note When restoring raw partitions, ensure that the partition is not mounted and not in
use. Also ensure that the device file for the raw partition exists prior to the restore.

1. Type the following command line:
/usr/openv/netbackup/bin/bp
The Main Menu displays.

window  Edit Options Help

NetBackup 4.5

Master Server: hagar
Client: hagar

Main Menu

b} Backup...
r) Restore...

h} Help
q) Quit

ENTER CHOICE:
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2. Choose the r (Restore) option from the Main Menu. The Restore Menu displays.

window  Edit Options Help

Master Server: hagar
Client: hagar

Restore Menu
b} Restore Files and Directories From Backups...
a) Restore Files and Directories from Archives...
r} Restore From Raw Partition Backups...
f) Restore From Auspex FastBack Backups...
d} Restore From True Image Backups...

o} Restore From Oracle DB Backups...

i) Restore From Informix DB Backups...

s} Restore From Sybase DB Backups...

t) Restore From SQL-BackTrack DB Backups...
p} Restore From SAP DB Backups...

2} Restore From DB2 DB Backups...

m} Change Master Server...
h} Help
q) Quit Menu

EWTER CHOICE:

Refer to “Restore Menu” on page 139 for details on this menu.

Note The following menu items do not apply to BusinesServer: Restore From Auspex
FastBack Backups, Restore From SQL-BackTrack DB Backups, Restore From SAP
DB Backups, and Restore From DB2 DB Backups.

Note The f (Restore From Auspex FastBack Backups) option is not supported in
NetBackup 4.5. This is no longer a valid client type.

If your site supports more than one master server and you want to browse or restore

files from another server, check the Master Server field at the top of the screen. When
you start the bp interface program, the Master Server field shows the default for your
client.

To browse a backup on another master server, choose the m (Change Master Server)
option and type the name of the other server. If you type an invalid name or your
client does not belong to a policy on that server, you will get an error.
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3. Select the b (Restore Files and Directories From Backups) option. The Restore Backups
menu will appear.

=[]

Wwindow Edit Options Help

search Path: fopt/openv/nethackup/bin/

Start Date: 08/22/2001 11:04:25 Master Server: hagar
End Date: 0842272001 23:59:39 Source Client: hagar
Files Selected: 0 Destination Client: hagar
Directory Depth: 1 Tevel Policy Type: Standard
Display Mode: Brief keyword Phrase:

Restore Backups

Select Files and Directories... 5% Change Search Path...

s}

e) Edit/view Selected Files... Change Date Range...

i) Initiate Restore <) Change Directory Depth...
%) Change Display Mode to Verbose m) Change Master Server...
13 List Backup Images... b} Change Source Client...

q) Quit Menu £} Change Destination Client
h) Help a) Change Destination Path...

¥} Change Policy Type
k) Change Keyword Phrase

ENTER CHOTCE: i

4. View the backups for your client.

a. Choose the I (List Backup Images) option from the Restore Backups menu.

=] Console =
Window Edit Options Help
Backed Up Expires Files KB ¢ Sched Type Policy K
1140842001 14:10 1142272001 5 3z & User Backup hagar_user_b 5;;

B (Brack (Fiorward (Udp (Dlown (Quit

This screen shows the backups created. Notice that the keyword bptest, entered
during the backup procedure described in “Performing Backups or Archives” on
page 48, is displayed under the keyword column. For this example, we will be
restoring from the backup with the bptest keyword.

b. Select (Q)uit to return to the Restore Backups menu.
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5. Check the Policy Type field to see if it is set correctly.

a. To change the policy type, select the y (Change Policy Type) option from the

Restore Backups menu.

Consale

window  Edit Options

Policy Type
03 Standard
17 #pollo-whak
2) Oracle
3} Informix-On-BAR
4) Sybase
51 MetWare

71 duspex-FastBackup
8) MS-Windows-NT
0572

10} MS-SQL-Server

123 SAP
13) DB2
143 NDMP
15) NCR-Teradata
16} FlashBackup
173 Split-Mirror
18) AFS
19) DataStore
200 Wault

Enter Choice [0-20]:

6} DataTools-SQL-BackTrack

11) MS-Exchange-Server

Gy |

The current policy type appears in parenthesis.

Note The following policy types do not apply to BusinesServer:

DataTools-SQL-BackTrack, Auspex-FastBackup, SAP, DB2, NDMP, and

FlashBackup.

Note The 7 (Restore From Auspex FastBack Backups) option is not supported in

NetBackup 4.5. This is no longer a valid client type.

b. Type the number for the new policy type.

c. Press Enter to return to the Restore Backups menu.

6. Check the Search Path field at the top of the Restore Backups menu to see if it is set to
the directory in which you want to start the search. At start up, the current path is set

to the directory from which you start the interface program.
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a. To change the path, select the p (Change Search Path) option. The following
prompt displays.

Ai Console IE iJ

window  Edit Options Help
Current File Path: fopt/openv/netbackup/bin/
Mew File Path: | =

For this example, we will be changing the path to /usr/openv/netbackup.

b. Type the new file path.
/usr/openv/netbackup

The search begins in this directory and goes down the directory tree.
c. Press Enter to return to the Restore Backups menu.

7. Check the Start Date and End Date fields to see if the range of dates includes the
backup dates of the files you want to restore.

a. To change the range of dates, select the d (Change Date Range) option from the
Restore Backups menu. The following prompt displays.

~i Console I iJ

window  Edit Options Help

Current Start Date: 0140141970 00:00:00
MWew Start Date:
I
b. Type the new Start Date.

c. Press Enter. The following prompt displays.
~i Console I iJ
window  Edit Options Help
Current End Date: 11/08/2001 23:59:59 |
Mew End Date: [ ] ’:

d. Type the new End Date.

e. Press Enter to return to the Restore Backups menu.
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8. Select the files and directories you want to restore.

a. Selectthe s (Select Files and Directories) option from the Restore Backups menu to
search for files and directories that belong to the client and meet the path and date
criteria. The list of files and directories displays.

= Console -]
wWindow Edit Options Help
Selections: 0 Current Path: Joptfopenv/netbackup/
Backup Date
-»11/08/2001 14:10:26 fopt/openv/netbackup/release_notes. tut
|
Zoon{Idn (Zyoomout (S)elect (Black (Fiwd (Wp (DIn (LDeft (RI{ght [0k J

If you are restoring an entire directory and the range of dates includes more than
one backup date for files in the directory, NetBackup restores only the most recent
backups. To restore earlier versions, you can either:

- Restore by file rather than by directory and select the files with the desired
backup date.

or
- Return to step 7 and specify only the backup dates you desire.

Here, you can restore the entire directory. Before proceeding, however, decide
whether you want to overwrite all files in that directory with the earlier
versions. If you do not want to overwrite existing files, you can restore the
directory to a different path (see step 10 of this procedure).

You may also want to refer to “Shortcut Restore Procedures” on page 89 and
“Restoring a True Image of a Directory” on page 69.

b. Use the menu options at the bottom of this screen to move the display arrow to
the line with the release notes. txt file.
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Select the (S)elect to select the release notes.txt file. An asterisk (*) displays
to the left of the selected file.

C.

= Console
window  Edit Options Help
Selections: 1 Current Path: foptfopenv/netbackup/
Backup Date
B11/08/2001 14:10: 26 fopt/openv/netbackup/release_notes. tut
Zoom{Iin (Z)oomOut {Sielect (Black (Flwd (UWp (DIn (Lleft (Riight (0Dk I

If you had selected a directory, all directories and files below the selected
directory would have been implicitly selected. An asterisk (*) displays to the left

of the selected directory.

d. Select the (O)k option to return to the Restore Backups menu.

9. Preview the files and directories you have selected to restore.

——— N
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a. Select the e (Edit/View Selected Files) option from the Restore Backups menu.
The list of selected files displays.

= Console ==
window  Edit Options Help

Humber of Selections = 1

-B/opt/openy/nethackup/release_notes. txt

(A)dd Selection Un{Sielect (Cilear (Black ({Fwd (Uip (DIn (Lleft (R}ight (0Jk J

This screen lists your selections and lets you make changes.
b. Make sure the release notes.txt file appears in the list.
c. Select the (O)k option to return to the Restore Backups menu.

10. Set up a redirected restore to a different path.

This is an optional step, used to restore files to a different path on the same client. In
the following example, we will set up a redirected restore from
/usr/openv/netbackup to /usr/openv/netbackup/bin.

Note You cannot use NetBackup on the master server to redirect restores of a file to a
different path on a NetBackup Novell NetWare client. For those clients, you must
perform the redirected restore with the user interface on the NetWare client.
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a. Choose the a (Change Destination Path) option from the Restore Backups menu.
The following prompt displays.

[ comele T[]

Specify Destination Path Substitution

Enter Restore From: (fopt/openv/netbackups/d Il

b. Press Enter. The following prompt displays.

[ comele T[]

Specify Destination Path Substitution

Enter Restare From: (fopt/openv/nethackup/d
Enter Restore To: {fopt/openv/netbackups) il

c. Type the following path in the Enter Restore To field.

/usr/openv/netbackup/bin

d. Press Enter. The following prompt displays.

Specify Destination Path Substitution

Enter Restare From: (fopt/openv/nethackup/d

Enter Restare To: (fopt/openv/netbackup/) fusr/openv/netbackup/bin
0K to use these paths?? (v/nd (vd: B
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e. Type y to use the indicated Enter Restore From and Enter Restore To paths on the
next restore. The following prompt displays.

= Console ==
window  Edit Options Help

Specify Destination Path Substitution
Enter Restare From: (fopt/openv/nethackup/d

Enter Restare To: (fopt/openv/netbackup/) fusr/openv/netbackup/bin
0K to use these paths?? (y/nd (yd: v

MWote: the temporary file fvar/tmp/DasdvaWes will be used
to manage the restore.

Press any key to continue

Type n to cancel the changes so the previous paths are still used.
f.  Press any key to return to the Restore Backups menu.
11. Start the restore operation.

a. Select the i (Initiate Restore) option from the Restore Backups menu. The
following prompt displays.

= Console ==
window  Edit Options Help

Restoring the following files
Joptfopenv/netbackup/release_notes. tut

overwrite if fileds) exist? {y/nd (nd: N

Caution The overwrite option is ignored during raw partition restores. The device file
must exist and the disk partition is overwritten whether this option is set or not.
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b. Type y to overwrite existing files. The following prompt displays.

[ comele 0]

Restoring the following files
Joptfopenv/netbackup/release_notes. tut

Overwrite if file(s) ewist? (y/nd (nd: y

Use progress Tog? (y/nd (yl:

Type n to if you do not want to overwrite existing files.

c. Type y tocreate a log file and write to this file as the operation progresses. The
following prompt prompt displays.

[ comele 0]

Restoring the following files

Joptfopenv/netbackup/release_notes. tut

Overwrite if file(s) ewist? (y/nd (nd: y
Use progress Tog? (y/n) (yd: v
Enter Progress File Path: (/bplog.rest.o0g) B

If you do not want logging, type n to start the operation and go to step d.

d. Press Enter to accept the default (shown in parentheses), or type a new path and
press Enter. The operation begins when you press Enter.
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If you have previously changed the destination path (see step 10) the OK to Use
destination path substitution? prompt displays:

Ai Console [= iJ

window  Edit Options Help

Restoring the following files
Joptfopenv/netbackup/release_notes. tut

Overwrite if file(s) ewist? (y/n) (nd: y

Use progress Tog? (y/nd (yl: v

Enter Progress File Path: (/bplog.rest.008)
diaghostic output will be logged to /fbplog.rest.008

||Use destination path substitution? (y/nd (y): 1

Type n to start the restore operation and ignore the destination path entered.
e. Type y to use the destination path entered.

f.  Press Enter. The following prompt displays.

~i Console = iJ

window  Edit Options Help

Restoring the following files
Joptfopenv/netbackup/release_notes. tut

Overwrite if file(s) ewist? (y/n) (nd: y

Use progress Tog? (y/n) (yd: v

Enter Progress File Path: (/bplog.rest.008)
diaghostic output will be logged to /fbplog.rest.008

Use destination path substitution? {w/nd (vl oy
1 |Rename hard links relative to the dest1nat10n path? {y/nd Cvd: N

Note If you are restoring system files to a disk other than the current system disk, and
plan on using the other disk as the system disk with the original file paths when the
restore is completed, we suggest that you specify y (yes) when prompted to rename
hard links and n (no) when prompted to rename soft links. This will allow you use
the other disk and have the correct file paths.

If there are links in the path you are searching, NetBackup prompts you to specify
whether you want to resolve the links so the path points to the actual file or
directory. If you do not want to resolve links, answer n (no) to the prompt. See
“Resolving Links” on page 73 for more information.
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g. Type n. The following prompt displays.

[ comele ]

Restoring the following files
Joptfopenv/netbackup/release_notes. tut

Overwrite if file(s) ewist? (y/n) (nd: y

Use progress Tog? (y/n) (yd: v

Enter Progress File Path: (/bplog.rest.008)
diaghostic output will be logged to /fbplog.rest.008
lUse destination path substitution? {y/nd (yd: oy

Rename hard Tinks relative to the destination path? (v/n) (¥J: n
Rename soft Tinks relative to the destination path? {v/nd (vd: B

h. Type n. The restore operation begins. The following prompt displays.

Restoring the following files
Joptfopenv/netbackup/release_notes. tut

Overwrite if file(s) ewist? (y/nd (nd: y

Use progress Tog? (y/n) (yd: v

Enter Progress File Path: (/bplog.rest.008)

diaghostic output will be logged to fbplog.rest.008

Use destination path substitution? {yind (yd: oy

Rename hard Tinks relative to the destination path? {y/n) (vJ: n
Rename soft Tinks relative to the destination path? {y/n) (vl: n
Initiating Restore . . .

The restore was successfully initiated.

;ress any key to continue

i. Pressany key to return to the Restore Backups menu.
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Restoring a True Image of a Directory

A true image restore will restore the contents of a directory to what it was at the time of a
selected automatic full or incremental backup. See “Restoring a True Image of a
Directory” on page 40 for an overview of true image recovery. The concepts explained
there for the Backup, Archive, and Restore interface also apply to the menu interface.

1. Select the d (Restore From True Image Backups) option from the Restore Menu. The
Restore True Image Backups menu appears.

window  Edit Options

Help

q) Quit Menu
h} Help

ENTER CHOICE:

Start Date:

End Date:

Files Selected: 0O
Directory Depth:
Display Mode:

Search Path: Jfopt/openv/netbackup/bin/

08/22/2001 11:04:25
08/22/2001 23:59:59

1 level
Brief

Master Server: hagar
Source Client: hagar

Destination Client: hagar

Policy Type: Standard
Keyword Phrase:

Restore True Image Backups

s} Select Files and Directories... p)
e) View/Delete Selected Files... dJ
i) Initiate Restore (]
#) Change Display Mode to Verbose m)
1} List TIR Backup Images... bl

t)
a)
k)

Change
Change
Change
Change
Change
Change
Change
Change

Search Path...

Date Range...
Directory Depth...
Master Server...
Source Client...
Destination Client
Destination Path...
Keyword Phrase

2. Select the d (Change Date Range) option from the Restore True Image Backups menu.

- The default Start Date is the time of the last scheduled full backup of the policy.
Use the default unless you are restoring a version that existed before the latest full

backup.

- The default End Date is the current date. If necessary, change this value to the
reflect the date that you want to recover.

In this example, we are recovering the most recent version of the directory so the
default date range is not changed.

3. To view the backup list for true image restore backups, choose the | (List TIR Backup

Images) option from the Restore True Image Backups menu.

4. To change the path, Select the p (Change Search Path) option from the Restore True
Image Backups menu.

Type the directory which contains the desired backups. Searching begins in this
directory and goes down the directory tree.
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To search for a specific directory, type its complete path at the prompt.

Select the s (Select Files and Directories) option from the Restore True Image Backups
menu to search for directories that belong to the client and meet the path and date
criteria.

Individual files do not appear and cannot be selected because true image restores are
intended only for restoring entire directories. To list or select individual files in a true
image restore backup or range of backups, use the Restore Backups menu.

A true image restore will restore files that existed in the directory at the time of the
incremental backup. Files that did not exist at the time of the incremental backup will
not be restored.

Note If NetBackup cannot find any directories, check your range of dates, path, and

directory depth. If these settings are correct and no directories are found, check with
the administrator on the master server to see if the NetBackup policy that is backing
up your files and directories is configured to collect true image restore information.

10.

Select the files or directories you want to restore.

a. Use the menu options at the bottom of the screen to find and select the desired
directory.

b. When you are through selecting, select the (O)k option to return to the Restore
True Image Backups menu.

Preview the files and directories you selected to restore.

a. Select the e (View/Delete Selected Files) option from the Restore True Image
Backups menu.

b. Check that the directories you selected appear in the list.

c. Select the (O)k option to return to the Restore True Image Backups menu.

If you want to restore to a directory other than the one from which the files were
originally backed up, choose a (Change Destination Path) option from the Restore
True Image Backups menu.

Select the i (Initiate Restore) option to display the Initiate Restore screen.

Answer the prompts to start the restore.
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If you are overwriting the directory you are restoring, NetBackup does not delete files
that are currently in the directory but not in the true image restore backups. See “True
Image Restore and Overwriting” on page 41.

Redirecting Restores to Different Clients

Note You cannot use NetBackup on the master server to redirect restores of a file to a
different path on a NetBackup Novell NetWare client. For those clients, you must
perform the redirected restore with the user interface on the NetWare client.

1. Choose the r (Restore) option from the Main Menu. The Restore Menu displays.

2. Selectthe b (Restore Files and Directories From Backups) option. The Restore Backups
menu displays.

3. Change the source client.

a. Select the b (Change Source Client) option from the Restore Backups menu. The
following prompt displays.

= Console [-I=
Window Edit Options Help
Enter client to hrowse: Chagar) i ’j

The current client appears in parenthesis.
b. Type the client name from which you want to browse and restore files.
c. Press Enter to return to the Restore Backups menu.
4. Change the destination client.

a. Select the t (Change Destination Client) option from the Restore Backups menu.
The following prompt displays.

= Cohsole =
window Edit Options Help
Enter client to restore to:  Chagard I ’7

=
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The current client appears in parenthesis.

b. Type the client name to which you want to restore files.

Note The destination client must be of the same policy type as the source client.

c. Press Enter to return to the Restore Backups menu.
5. Check the policy type for the source client and the destination client.

a. To change the policy type, select the y (Change Policy Type) option from the
Restore Backups menu. The current policy type appears in parenthesis.

b. Type the policy type for the source client and the destination client.
c. Press Enter to return to the Restore Backups menu.

6. Check the Path field at the top of the Restore Backups menu to see if it is set to the
directory at which you want to start the search for the desired backups.

a. To change the path, select the p (Change Search Path) option.
b. Type the new file path.
c. Press Enter to return to the Restore Backups menu.
7. Select the files and directories you want to restore.
a. Selectthe s (Select Files and Directories) option from the Restore Backups menu to
search for files and directories that belong to the source client and meet the path

and date criteria.

b. Use the menu options at the bottom of this screen to move the display arrow to
the files or directories you want to restore to the destination client.

c. Select the (S)elect option to select the file or directory. An asterisk (*) will appear
to the left of the selected file or directory.
If you select a directory, all directories and files below the selected directory will
be implicitly selected.

d. Select the (O)k option to return to the Restore Backups menu.
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8. Preview the files and directories you have selected to restore.

a. Select the e (Edit/View Selected Files) option from the Restore Backups menu.
The resulting screen lists your selections and lets you make changes.

b. Review your selections.
c. Select the (O)k option option to return to the Restore Backups menu.
9. Select the i (Initiate Restore) option to start the restore operation.

10. Follow the prompts. The restore operation begins when you press Enter.

Resolving Links

When searching for files to restore, you can choose whether to have NetBackup resolve
links that may exist in the search path. If you resolve links, NetBackup automatically
changes the path so it points to the actual file or directory. Otherwise, NetBackup uses the
path you type in. For more information, see “Resolving Links” on page 42.

Note If links exist in the selected path, you get a prompt at the time you elect to browse
the backups.

Note NetBackup does not resolve links if you use wildcard characters in the search
directory path.
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Checking Progress of Operations

When you start a NetBackup operation, you can have NetBackup create a log file in a
directory of your choice and write to this file during the course of the operation. By
default, NetBackup creates a log file in your home directory of the form:

bplog.bkup.n (for backups)
bplog.arch.n (for archives)
bplog.rest.n (for restores)
Where n is a number that is unique for each file.

You can read log files by using the more command or a UNIX file editor. Delete the logs
when you no longer need them.

Note Before deleting the log files, be sure to verify that they do not contain warnings or
error messages.

See “Interpreting Progress Logs” on page 100 for information on interpreting the logs.

A — NetBackup User’s Guide - UNIX



Using the X-Windows Interface 4

This chapter explains how to use the xbp interface to perform NetBackup operations. This
interface is X-Windows based and requires an X terminal or a workstation with an X
server program compatible with release X11.R4 or later. The interface uses OSF and Motif
conventions.

The purpose of this chapter is to provide step-by-step procedures for using the xbp
interface. For information about specific windows or menu options within this interface,
refer to Chapter 5, “Reference Guide to xbp and bp” on page 105. Refer also to the online
help facility.

The areas covered here are as follows:
Starting the xbp Interface
Performing Backups and Archives
Performing Restores

Resolving Links

Checking Progress of Operations

Obtaining a List of Your Backups and Archives

® 6 6 ¢ O o o

Finding and Selecting Files and Directories
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Starting the xbp Interface

1.

Ensure that your X terminal or workstation X server is named according to X
conventions.
Set your DISPLAY environment variable to the appropriate value.

The most convenient method is to define the DISPLAY variable with your login
procedure.

The following example uses the setenv command after login to set up the display for
an X terminal or server named orca:

setenv DISPLAY orca.user.abc.com:0
You can also use the -d option when you execute the xbp command (see step 3).
Start the xbp interface by typing the xbp command as shown in the following

examples. The variation you use depends upon whether your DISPLAY environment
variable is already set:

- Ifthe DISPLAY variable is set, type:
/usr/openv/netbackup/bin/xbp &
- Ifthe DISPLAY variable is not set, use the -d option:
/usr/openv/netbackup/bin/xbp -d orca.user.abc.com:0 &

The & character puts the program in background mode so your original window stays
active and is available for other activities.
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When xbp starts, the xbp window displays on your screen.

Tfoptsopeny/netbackupsbin/
01/01/1970 00:00:00 oa/s22/2001 23:59:59

adminemd/
bpdbm_child/
bpdbm_parent/
bprd.d/
bprd_child/
bprd_parent/
bpsched.d/f
driver/
goodies. 3,404/
goodies.4.5Prealphas
goodies/

BACKUP_CALLED

BACKUP_EXIT_CALLED

BPRD_CALLED

RESTORE_CALLED

SESSTON_CALLED

SESSTON_START_CALLED

KkeysynDB

KNE

HNB. dt

add_slave

add_slave_on_clients

backup_exit_notify

backup_exit_notify.3.4G4

backup_exit_notify.4.5Prealpha

backup_notify

backup_notify.3.4GA

|7 backup_notify.4.5Prealpha
bp

IF bpadn

When you start xbp, the Browse file system (backup or archive) command from the File
menu is selected by default. The Directory Structure pane and the Files pane show all
directories and files in the directory specified in the Directory to Search box down to the
level specified in the Directory Depth box. The Directory to Search box is set to the
directory where you start xbp. You set the number of levels down in the Directory Depth
box.

Refer to “xbp Window” on page 108 for details on this window.
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Performing Backups and Archives

The following procedure explains how to perform a backup of files, directories, or raw
partitions or to archive files and directories. The main difference between backups and
archives is that an archive deletes the designated files and directories from your disk after
successfully backing them up.

1. Change NetBackup master servers if necessary.

If there is more than one master server to which you can send your backups and
archives, ensure that you are connected to the correct one. Ask your NetBackup
administrator if you have questions about which master server to use.

Normally, you will not have to switch master servers unless, for some reason, the
administrator has temporarily moved the NetBackup backups (for example, because
of a problem on the original master server). If the change becomes permanent, the
administrator should change your default to reflect the other server.
a. Click Configuration on the File menu.

The the xbp_config dialog box displays.

Server

your server

Client to browse for restores

vour client]

Client to restore to

vour client or different client |

Policy tupe of images to browse
Standard = |

OK | Cancel | Help.. |

The name of the current master server appears in the Server box. When you start
xbp, the server is set to the default for your client.

If you do not want to change the master server, click Cancel. If you want to
change the master server, go to the next step.

b. Type the name of the other server in the Server box.

c. Click OK.

~ 78 NetBackup User’s Guide - UNIX



Performing Backups and Archives

If you typed an invalid name, or if your client does not belong to a NetBackup
policy on that server, you get will an error. If this occurs, see your system
administrator for assistance.

2. Find and select the desired files and directories.

If the desired files or directories are not currently displayed, find them by using the
methods described under “Finding and Selecting Files and Directories” on page 101.

In this example we are going to select the release notes.txt file.

a. Selectthe /usr/openv/netbackup directory in the Directory Structure pane.

When a directory is selected in the Directory Structure pane, all of the
subdirectories and files listed in the Files pane are implicitly selected. These
implicitly selected subdirectories and files will not appear highlighted in the Files
pane.

b. Selectrelease notes.txt in the Files pane.

~| xbp [T
File Edit Wiew Backup Restore Help
Directory to Search
Tfopt/openv/netbackup/

Range of Dates
01/01/1970 00:00:00 | |}11/08/2001 23:59:59
Directory Depth Filename Filter
2 s
| Files
= bing
catalog/
adminemd client/
bpdbn_child db/
bpdbm_parent dhext/
bprd.d ext/
bprd_child help.3.4CA/
bprd_parent help.4.5PreAlphas
bpsched. d help/
driver Togs/
gondies. 3. 404 sdk/
qoodies.4.5Predlpha
goodies .upgrade. to.3.4GA
catalog .upgrade. to.4.5Beta
client .upgrade. to.4.5Prealpha
INTEL MediaMgr_DeviceConfig_Cuide. txt
MACINTOSH bp. conf
NDMP
Hovell ele otes. txt
pC versian
RSEO0OD
Solaris
db
class
class_template
client
config
error
failure_history
images !I
jobs LI
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3. On the Backup menu, click Backup selected files and directories.

Backup selected files and directories..

This opens the xbp_confirm dialog box.

= dpconfim

Joptfopenv/netbackup/release_notes. tut

&

¥bplog. bkup. 004

Note If you click Archive selected files and directories, NetBackup will back up the
selected directory and all of its subdirectories, then delete the backed up directories
from your system.

a. Review your selections in the xbp_confirm dialog box.

b. Choose whether to use the progress log file.

Select the Use log file checkbox to create a log file in your home directory and
write to this file as the operation progresses.

The name of the log file appears in the Log Filename box. For information on
checking the log, see “Checking Progress of Operations” on page 98.

c. Type akeyword in the Keyword phrase to associate with this backup box.
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The phrase you type in the Keyword phrase to associate with this backup box
will be the key for finding this backup during the restore process. In this example
we will use the keyword test. You will use this keyword during the restore
operation in the following section.

d. Click OK. This sends your backup request to the server. The main window will

appear.
To return to the main window without starting the backup or archive, click
Cancel.
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Performing Restores

The following topics explain how to restore files, directories, and raw partitions:
& Basic Restore Procedure - includes detailed instructions for restoring files.
& Shortcut Restore Procedures - abbreviated procedures for common operations.

¢ Advanced Restore Operations - information on performing true image restores and
redirecting a restore to a different client.

Basic Restore Procedure

The following procedure is a detailed explanation of how to restore files, directories, and
raw partitions to your client system.

Note When restoring Novell NetWare backups, set the directory depth to a minimum of 6
to ensure that the backup image is displayed.

Note If you are restoring raw partitions, ensure that the partition is not mounted and not
in use. Also ensure that the device file for the raw partition exists prior to the
restore.

Note If you are restoring a directory, you may want to refer to “Shortcut Restore
Procedures” on page 89 and “Restoring a True Image of a Directory” on page 95.

1. Change NetBackup master servers if necessary.

If there is more than one master server that can back up this client, ensure that you are
connected to the one that performed the backup you are trying to restore. If you
attempt to restore from another master server, the files will not be found. Ask your
NetBackup administrator if you have questions about which master server to use.
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a. On the File menu, click Configuration. Refer to “File Menu” on page 109 for
details on this menu.

This opens the xbp_config dialog box.

Server

your server

Client to browse for restores

vour client]

Client to restore to

vour client or different client |

Policy tupe of images to browse
Standard = |

OK | Cancel | Help.. |

The name of the current master server appears in the Server box. When you start
xbp, the server is set to the default for your client.

If you do not want to change the master server, click Cancel. If you want to
change the master server, go to the next step.

b. Type the name of the other server in the Server box.

c. Click OK.

If you typed an invalid name, or if your client does not belong to a NetBackup
policy on that server, you get will an error. If this occurs, see your system
administrator for assistance.

2. Find the file and/or directory to restore.
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a. On the File menu, click Browse backups (restore).

A main window similar to the following will appear.

S 3

Tfopt/openv/netbackup/

Backed Up Expires i Sched Type  Policy Keyword

11/08/2001 14:55:20 11/22/20 User Backup hagar_user_backup test
11/22/20 User Backup hagar_user_backup
11/22/20 User Backup hagar_user_backup
11/22/20 User Backup hagar_user_backup bptest

Jopt/openy/netbackup Backup Date Filename

11/08/2001 14:55:20 release_notes.txt

Note If there are a large number of backups in your range of dates, a message box may
display, indicating that you cannot search for a specific path until you update the
display. If this message appears, select Update Display from the Edit menu.

b. Specify the directory to search.

In this example, we are going to restore the release notes. txt file backed up
in “Performing Backups and Archives” on page 78. Type the following in the
Directory to Search box:

/usr/openv/netbackup/
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Note If there are any links in the path you are searching, NetBackup, by default, resolves
the links so the path points to the actual file or directory. If you do not want to
resolve links, click Do Not Resolve Links in Search Directory on the View menu
before choosing a browse command from the File menu. See “Resolving Links” on
page 98 for more information.

c. Specify the range of dates.
When you go from backup mode to restore mode, NetBackup normally changes
the starting date so that it defaults to the time of the last full backup. If you type in
a specific date before changing modes, your specification is used. See “Selecting
Specific Backup Dates to Restore” on page 93 for more details.

d. Specify the keyword phrase to search for.
In step ¢ on page 80 of the “Performing Backups and Archives” section, test was
entered as the keyword. So, in the Keyword phrase to search for box, type test.

e. Type *.txt in the Filename Filter box.

f.  On the File menu, click Browse backups (restore).
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A main window similar to the following will appear.

5 - 1

fopt/apenv/nethackuns

Backed Up Expires Files KE Sched Type  Policy Keyword

11/08/2001 14:55:20 11/22/20 5 32z User Backup hagar_user_backup test

Jopt/openy/netbackup Backup Date Filename

11/08/2001 14:95:20 release_notes.txt

g. Select the files and directories that you want to restore.

If the desired files or directories are not currently displayed, find them by using
the methods described under “Finding and Selecting Files and Directories” on
page 101. You can also specify another range of backups to search. (See “Selecting
Specific Backup Dates to Restore” on page 93.)
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In the following figure, the /usr/openv/netbackup directory is selected in the
Directory Structure pane. This implicitly selects all directories and files that are
below /usr/openv/netbackup in the directory tree.

S 3

i/opt/openv/nethackup/

Backed Up Expires Files KB Sched Type Policy Keyword

1170872001 14:55:20 11/22/20 32 User Backup hagar_user_backup test

Backup Date Filename

11/08/2001 14:55:20 release_notes.txt

Note If you are selecting directories on the Files pane and then change your mind and
deselect a directory, it is not deselected until you have selected either Clear
selections for current directory or Discard selections for previous directories from
the Edit menu. If you use Inspect all selections from the Edit menu, you can see

what is selected to be restored.

3. Start the restore.
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a. Click Restore search directory from the Restore menu.

This opens the xbp_confirm dialog box.

~i wbp_confirm = iJ

OK to restore directory?
Joptiopeny/nethackup/

M Use log file
Log filename
Ybplog. rest.o0g

_| Querwrite existing files
&
| st

OK Cancel Help..

b. Choose whether to use the progress log file.

Select the Use log file checkbox to create a log file in your home directory and
write to this file as the operation progresses.

The name of the log file appears in the Log Filename box. For information on
checking the log, see “Checking Progress of Operations” on page 98.

c. Select the Overwrite existing files checkbox.

Note The disk partition is overwritten whether this option is set or not. The device file
must exist.

The Redirected restore checkbox and the Restore directories without crossing
mount points checkbox are enabled.

Note Mount points inside will get restored whether or not the Restore directories
without crossing mount points checkbox is selected.

NetBackup restores files according to the original file’s pathname.

- Select the Overwrite existing files checkbox to overwrite an existing file with
the restored file, providing file permissions allow it. (See “File Permissions
Required By NetBackup” on page 7.)
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- Clear the Overwrite existing files checkbox to prevent overwriting. The
restore does not occur if a file with same pathname already exists.

d. Review your selections.

4. Click OK. This will send your restore request to the server. The main window will
appear.

To return to the main window without starting the restore, click Cancel.

Shortcut Restore Procedures

The following are abbreviated procedures for common types of restore operations.

Listing the Available Backups or Archives
If you are not sure of the dates when a file or directory was backed up, you can find out by
browsing the backups.

1. Type the directory that you want to restore in the Directory to Search box.

2. Leave the range of dates at the defaults (01/01/70 to the current date).
or
If you know the approximate range, type it in to narrow the range that will be
displayed. Doing this speeds up your request.

3. On the File menu, choose the desired browse for restore option.

NetBackup updates the Directory Structure pane and the Files pane to show all
backups or archives for the specified directory path and date range.

Because NetBackup has to obtain the file information from the backups on the master
server, there can be a noticeable delay before the panes appear in the restore window.

Note If there are a large number of backups in the date range, you may be prompted to
use Update Display from the Edit menu before NetBackup will search for the
specific path.
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Restoring the Most Recent Backup
The following explains how to restore the most recent backup that has occurred since the
last full backup of your client.

1. Type the directory that you want to restore in the Directory to Search box.

2. On the File menu, click Browse backups (restore).

NetBackup updates the Directory Structure pane and the Files pane to show only the
files and directories that were backed up from the time of the last full backup through
the most recent backup (either incremental or user-directed).

Since NetBackup has to obtain the file information from the backups on the master
server, there can be a noticeable delay before the panes appear in the restore window.

Note By default, NetBackup restores the file to its original location. To restore to a
different path, use Specify Destination Path from the Restore menu before starting
the restore.

3. Select the most recent backup of the file you want to restore.

Note If you are selecting directories on the Files pane and then change your mind and
deselect a directory, it is not deselected until you have selected either Clear
selections for current directory or Discard selections for previous directories from
the Edit menu. If you use Inspect all selections from the Edit menu, you can see
what is selected to be restored.

4. On the Restore menu, click Restore selected files and directories.

This starts the restore.

Restoring the Most Recent Version of a Directory

Note The following procedure will restore all files that existed in the directory from the
time of the last full backup through the most recent backup. Files that were deleted
from your online directory during that time period are also restored. If you do not
want the files that were deleted from your online directory, proceed to “Restoring a
True Image of a Directory” on page 95.

You can restore the latest version of a directory with just one restore operation. The steps
are the same as explained under “Restoring the Most Recent Backup” on page 90, except
that here you must select a directory from the Directory Structure pane and use Restore
search directory from the Restore menu. The restored directory has the last full backup of
that directory, updated with all subsequent incremental and user backups.
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There are two important things to remember when restoring a directory:

1. The restored directory has only the files that are in the range of backups you selected
with the start and end dates. Therefore, these dates must include the last full backup
and all other backups through the latest date you are interested in. The best way to get
the most recent backup is to use the date of the last full backup as start date and the
current date as the end date (this is the default at the start of a browse).

2. Itis usually best to select from the Directory Structure pane. Selecting from the Files
pane restores only from the backup created at the backup date and time. If that
backup is for an incremental, you will restore only the files in that incremental.

Advanced Restore Operations

The topics in this section explain how to perform more specialized restore operations.
Also see the section on server-directed restores in the NetBackup User’s Guide for UNIX or
the NetBackup User’s Guide for Windows.

Redirecting Restores to Different Clients

The following explains how to redirect a restore to a different client. Refer to “Basic
Restore Procedure” on page 82 for a detailed restore procedure.

Note You cannot use NetBackup on the master server to restore a file to an alternate path
on a NetBackup for Novell NetWare client. For those clients, you must perform the
alternate path restore with the user interface on the NetWare client.

1. Change NetBackup master servers if necessary.

a. From the File menu, click Configuration.

This opens the xbp_config dialog box.
b. Type the name of the server in the Server box.

c. Click OK.

If you type an invalid name or your client does not belong to a NetBackup policy
on that server, you will get an error. See your system administrator for assistance.

2. From the Restore menu, click Specify Destination Path.

This opens the xbp_destpath dialog box.
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a. Type the paths in the Restore From box and the Restore To box.

You can also use the Current Directory button to change paths to their default
value, which is your current directory.

You cannot specify more than one path. If you specify a path that does not exist,
NetBackup creates it when restoring the file.

b. Before restoring files that are links, choose whether to update those link
pathnames:

- Select the Rename Hard Links checkbox to rename the hard link pathnames.
Clear the Rename Hard Links checkbox if you do not want to rename the
hard link pathname.

- Select the Rename Soft Links checkbox to rename the soft link pathnames.
Clear the Rename Soft Links checkbox if you do not want to rename the soft
link pathname.

Note If you are restoring system files to a disk other than the current system disk and
plan on using the other disk as the system disk with the original file paths when the
restore is completed, we suggest that you select the Rename Hard Links checkbox
and clear the Rename Soft Links checkbox. This will let you use the other disk and
have the correct file paths.

c. Confirm or cancel the changes as follows:

- Click OK to use the paths indicated in the Restore From box and the Restore
To box on the next restore.

or

- Click Cancel to cancel the changes so the previous paths are used.
3. On the File menu, click Browse backups (restore).

4. Specify the directory to search, the range of dates, the keyword phrase to search for,
the directory depth, and the filename filter for the files you want to restore.

5. Find and select the files and directories that you want to restore.

6. Click the appropriate restore command on the Restore menu.

This opens the xbp_confirm dialog box.
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a. Select the Use log file checkbox to create a log file in your home directory and
write to this file as the operation progresses.

b. Select the Overwrite existing files checkbox to overwrite an existing file with the
restored file, providing file permissions allow it (see “File Permissions Required
By NetBackup” on page 7). The checkbox is selected when highlighted.

Clear the Overwrite existing files checkbox to prevent overwriting. The restore
does not occur if a file with same pathname already exists.

c. Select the Redirected restore checkbox to confirm the restore to a different path.
The checkbox is selected when highlighted.

Clear the Redirected restore checkbox to cancel the redirection action.

d. Select the Restore directories without crossing mount points checkbox to skip
over file systems mounted in the selected directories. The checkbox is selected
when highlighted.

Clear the Restore directories without crossing mount points checkbox to restore
file systems that are mounted in the selected directories.

e. Review your selections.

f. Click OK to start to start the restore. The main window displays.

To return to the main window without starting the restore, click Cancel.

Selecting Specific Backup Dates to Restore

By default, the NetBackup Restore window shows the files and folders that were backed
up since the last full backup. The default range will satisfy the majority of your needs to
restore files but there will be times when you must restore a file that was not backed up
during the default time period. For example, a file that was deleted prior to the last full
backup will not appear in the default display. To locate and back up this file, you would
need to change the date range.

If the client belongs to more than one policy, the starting date defaults to the last full
backup that occurred first. For example, assume that: (1) a client belongs to PolicyW1 and
PolicyW?2, (2) Full backups occur for both of these policies, (3) PolicyW1’s most recent full
backup occurred on June 16 and PolicyW?2’s most recent full backup occurred on June 24.
NetBackup will display those files and folders that have been backed up since the
PolicyW1 full backup on June 16.
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If the default display does not show the desired files or directories:

1. Specify the range of backup dates that you believe contains the desired files and

directories:

- Type the desired backup dates in the Range of Dates boxes.

or

- Select backups from the Backup Images pane.

The Range of Dates boxes will now contain the oldest and newest backup dates
in the range of backups that you selected.

Note Narrow the date range as much as possible to speed up your search.

2. Position the pointer over any of the boxes and press Enter (or click Update Display on
the Edit menu).

NetBackup updates the Directory Structure pane and the Files pane to show only the
files and directories that it finds in the range of backups that you specified. You can
then select the backup you want and restore it.

Since NetBackup has to obtain the file information from the backups on the master
server, there can be a noticeable delay before the panes appear in the restore window.

Restoring an Earlier Version of a Directory

Note The following procedure will restore all files that were backed up during the range
of backup dates that you searched for files to restore. This includes files that were
deleted from your online directory after they were backed up. If you do not want
the deleted files, use the procedure described in“Restoring a True Image of a

Directory” on page 95.

To restore a version of a directory that existed prior to the last full backup, select only the

backups that include the desired version of the directory.

For example, assume that you want the /home /hrp/ directory as it existed on 10/5/00.

1. Browse all dates and examine the Files pane and the Backup Images pane.

In our example, we find that the following backups occurred.

Backup Date and

10/10/00
10/09/00
10/02/00
09/29/00

22:
16:
18:
19:

01:
30:
05:
36:

Time

20
27
41
55

Type
Full
Incr
Incr
Incr

of Backup

Backup
Backup
Backup
Backup
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09/25/00 18:06:15 . . . Full Backup
09/20/00 16:06:21 . . . Incr Backup
09/17/00 22:06:44 P Full Backup

2. Set the start date and end date to include the required backups.
In this example, we set them as follows:
- Start date to 09/25/00. This the last full backup preceding 10/5700.
- Enddate to 10/02/00. This is the incremental that includes the 10/5/00 version of
the directory. The next date is 10/09/00, but that has changes we do not want.

3. Start another browse using Update Display from the Edit menu.

4. Select /home/hrp/ from the Directory Structure pane and the check the Files pane to
see if it shows the files you need.

Note By default, NetBackup restores the directory to its original location. To restore to a
different path, use Specify Destination Path from the Restore menu before starting
the restore.

Note If you are selecting directories on the Files pane and then change your mind and
deselect a directory, it is not deselected until you have selected either Clear
selections for current directory or Discard selections for previous directories from
the Edit menu. If you use Inspect all selections from the Edit menu, you can see
what is selected to be restored.

5. On the Restore menu, click Restore search directory.

Restoring a True Image of a Directory

A true image restore of a directory, by default, restores the directory so its contents are
exactly what they were at the time of the most recent automatic full or incremental
backup. Files deleted prior to the specified backup are not restored.

See “Restoring a True Image of a Directory” on page 40 for an overview of true image
recovery. The concepts explained there for the Backup, Archive, and Restore interface also
apply to the menu interface.
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True Image Restore and Overwriting

If you are overwriting the directory you are restoring, NetBackup does not delete files that
are currently in the directory but not in the true image restore backups. An example is
provided in “True Image Restore and Overwriting” on page 41.

V¥ To restore atrue image of a directory

Note You can restore a true image of a directory only if the NetBackup policy that is
backing up your files and directories is configured to collect true image restore
information. If you are in doubt, ask your NetBackup administrator.

Note NetBackup does not allow a true image restore that is based on the time of a
user-directed operation. However, NetBackup does use the data from a
user-directed operation when performing a true image restore if the user backup is
more recent than the latest automatic full or incremental backup.

Assume you are recovering /home/abc/doc/ as it existed on 12/04/00. Also assume
you just started the xbp interface, so Browse file system (backup or archive) is selected
with all settings at the defaults.

1. On the File menu, click Browse backups (true image restore).

The Directory Structure pane and the Files pane show the directories that are available
for true image restores. For our example, the default display shows the following.

Directory Structure Files
/home/abc
doc 12/04/00 20:05:22 doc/
dirA 12/03/00 21:10:50 doc/
dirB 12/02/00 20:10:34 doc/

12/01/00 20:15:34 doc/

Notice that the panes show only directories. Individual files do not appear because
true image restores are intended only for restoring entire directories. To list or select
individual files, use the Browse backups (restore) mode.

Note If NetBackup does not find any directories, check the range of dates, path, and
directory depth. If these settings are correct and no directories are found, check with
the administrator on the master server to see if the NetBackup policy that is backing
up your files and directories is configured to collect true image restore information.

2. Select the desired range of dates.
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The default start date is the time of the last scheduled full backup of the policy. Use
the default unless you are restoring a version that existed before the latest full backup.

The default end date is the current date. If necessary, change this value to reflect the
date that you want to recover.

In this example, we are recovering the most recent version of the directory so we leave
the date range at the defaults.

- Start date is 12/01/00
- Enddateis 12/04/00

3. If you changed the range of dates in step 2, click Update Display on the Edit menu to
update the panes.
This step is unnecessary in our example, but is required if you change the range of
dates.

4. From the Files pane, select the directory that you want to restore. (NetBackup does not
let you select from the Directory Structure pane for a true image restore.)

In our example, we select the 12/04/00 version of /home/abc/doc/ from the Files
pane.

Note If you are selecting directories on the Files pane and then change your mind and
deselect a directory, it is not deselected until you have selected either Clear
selections for current directory or Discard selections for previous directories from
the Edit menu. If you use Inspect all selections from the Edit menu, you can see
what is selected to be restored.

Note By default, NetBackup restores the directory to its original location. To restore to a
different location, use Specify Destination Path from the Restore menu before
starting the restore.

5. On the Restore menu, click Restore selected files and directories. (Restore search
directory is not available for a true image restore.)

In our example, the restored directory has:

filel
file2
file4

This is the directory as it was at the time of the incremental backup that occurred on
12/04/00.

If you are overwriting the directory you are restoring, NetBackup does not delete files
that are currently in the directory but not in the true image restore backups.
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Resolving Links

When searching for files to restore, you can choose whether to have NetBackup resolve
links that may exist in the search path. If you resolve links, NetBackup automatically
changes the path so it points to the actual file or directory. Otherwise, NetBackup uses the
path you type in. For more information, see “Resolving Links” on page 42.

Note xbp resolves links by default, unless you click Do Not Resolve Links in Search
Directory on the View menu before starting your search.

Note NetBackup does not resolve links if you use wildcard characters in the search
directory path.

Checking Progress of Operations

When you start a NetBackup operation, you can have NetBackup create a log file in a
directory of your choice and write to this file during the course of the operation. By
default, NetBackup creates a log file in your home directory of the form:

bplog.bkup.n (for backups)
bplog.arch.n (for archives)
bplog.rest.n (for restores)

Where n is a number that is unique for each file.
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The following figure illustrates an xbp_progress dialog box.

=] =bp_progress B
Progress Report

Log files in wour FHOME directory

/bplog. bkup. 001
/bplog.bkup. 002

/bplog. bkup. 003
/bplog. bkup. 004
/bplog. bkup. 005
bplog. bkup, 006

Contents of selected log file
Backup started Thu Mov 08 14:55:03 2001 =

14:55:09 Initiating backup
14:55:25 INF - Processing fopt/openv/netbackup/release_notes.txt

14:55:26 INF - Beginning backup on serwer hagar.min.ov.com of client hagar.
14:55:26 Jfopt/

14:55:26 Jopt/openv/

14:55:26 fopt/openv/nethackup/

14:55:26 Jopt/openv/nethackup/release_notes. tut

14:55:26 INF - Client completed sending data for backup

14:55:33 INF - Backup by root on client hagar: the requested operation was successfully completed.

Log File
/bplog. bkup. 006

_I automatic Refresh

Clase | Delete Log File | Help...

This dialog box lists the progress log files that are in your home directory and lets you
view them. (You can also read log files by using the more command or a UNIX file editor.)

The log information is in two scrollable panes:
& Logfiles in your SHOME directory (upper section of dialog)
& Contents of selected log file (middle section of dialog)

View the contents of a log by selecting and highlighting its entry in the upper pane. The
pane in the middle section displays any entries that NetBackup makes in the log file.

Select the Automatic Refresh checkbox for automatic refresh. You can force a refresh by
reselecting the same log file. The checkbox is selected when highlighted.

When you are through checking progress, click Close to return to the xbp_main window.
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Interpreting Progress Logs

The log messages notify you of important events that occur during the operation. These
messages can have acronyms that specify the error level severity of an event.

The error level acronyms are as follows:

INF Informational message (no error occurred)
TRV Trivial error message

WRN Warning error message

ERR Error message

FTL Fatal error message

Progress logs also list the media required for a NetBackup operation. For backups, the
progress log lists the media IDs as NetBackup requests them during the course of the
backup. For restores, the progress log begins by listing all the media IDs that NetBackup
needs to recover the backups containing the files. If a backup or archive is split across
more than one media ID, a restore log lists all the media but NetBackup uses only what it
needs to restore the requested files.

Check the status at the end of the log to determine the final results of the NetBackup
operation. If NetBackup was unable to back up or restore all the requested files, check the
exit status that appears a few lines before the end of the log. This status will usually reveal
the cause of the problem.

Email Notifications

You can configure a bp . conf file in the client $SHOME directory so the user will receive
email notifications on the results of user-directed operations. Refer to the NetBackup
System Administrator’s Guide for UNIX .

Deleting Progress Log Files

To delete log files from your directory, open the xbp_progress dialog box, select the log
files and click Delete Log File. You can also delete logs manually by using system
commands.

Note Before deleting the log files, verify that they do not contain warnings or error
messages.
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Obtaining a List of Your Backups and Archives

You can use the bplist command to get a listing.

The bplist command lists backups and archives according to criteria, such as specific
file or directory, client name, and range of dates. You can print a list by sending it to a file
and then printing the file.

For detailed instructions on using this command, see the man pages. Information on the
commands is also included in the NetBackup System Administrator’s Guide for UNIX.

Finding and Selecting Files and Directories

This section explains what you need to know to find and select files and directories. See
Chapter 5, “Reference Guide to xbp and bp” on page 105 for more information on menus,
text boxes, and other items mentioned in the following descriptions.

Navigating in the Directory Tree

Go Lower in the Directory Tree

To go lower in the directory tree:

¢ Double click on a lower level directory in the Directory Structure pane.
or

& Click the directory and press Enter.

The Directory to Search box will show the selected directory, and the Directory Structure
pane and the Files pane are updated accordingly.

You can also type the directory path in the Directory to Search box and press Enter. This
has the same effect as clicking the directory in the Directory Structure pane.

Go Higher in the Directory Tree

To go higher in the directory tree, type the path of the higher level directory in the
Directory to Search box and press Enter. Pressing Enter updates the display (another way
to update the display is to click Update Display on the Edit menu).
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Show the Contents of a Directory

To see files that are in a directory, click the directory in the Directory Structure pane. The
contents appear in the Files pane.

Filter by Date

To show only files that were modified or backed up within a certain date range, set the
Range of Dates boxes to include those dates and press Enter to update the display:

& For abackup, specify the last modified dates.
& For arestore, specify backup dates.

You could set the range of dates to show only those modified before or after a certain date.
For example, you could pick only today’s files.

Filter by File Name

To show only specific file names that are under the Directory to Search box, use the
Filename Filter box. This makes selection easier if you want only specific files but there
are many files under Directory to Search box. For example, you can find files ending in
.doc by using the filter expression * . doc. When xbp starts, the filter is set to * and
displays everything.

Change the Number of Directory Levels Displayed

To set the number of directory levels displayed, change the number in the Directory Depth
box (default is 2).

Selecting File or Directory for Backup, Archive, or Restore

To select a file or directory in the Files pane, click its name to highlight it. Clear a file or
directory by clicking it again:

& To select everything in the current directory, click Select all in current directory on
the Edit menu. Clear an individual file or directory by clicking it again.

& To clear all selections for the current directory, click Clear selections for current
directory on the Edit menu.
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Caution If you click on Select all in current directory on the Edit menu to perform a
NetBackup operation, and the directory you select is large, the operation can be
very slow. Instead of selecting everything, consider using Restore search
directory, Backup search directory or Archive search directory.

During a backup, selecting a directory from the Files pane implicitly selects everything in
the directory, including subdirectories and files. During a restore, selecting a directory in
the Files pane restores only the files and subdirectories that are in the backups that
occurred during the indicated range of dates.

You select from the Directory Structure pane in the same manner as from the Files pane,
except that you can select only one item at a time. When you select a directory to highlight
it, the Files pane shows the directories and files in this directory.

When you are through selecting, start the NetBackup operation by choosing the
appropriate option from the Backup menu or Restore menu. This opens the xbp_confirm
dialog box and adds your selections to that dialog. If you made previous selections and
opened the xbp_confirm dialog box but did not confirm your selections (and therefore did
not perform the actual NetBackup operation), xbp remembers them and keeps them in
the xbp_confirm dialog box. This lets you return to the main window and make changes
before confirming.

To clear all selections from the xbp_confirm dialog box, click Discard selections for
previous directories on the Edit menu.

Previewing Selected Files

You can view the list of selected files at any time by clicking Inspect all selections on the
Edit menu. This opens a dialog box similar to xbp_confirm, except that it does not have an
OK button.

Change Directory Structure Pane and the Files Pane Format

You can change the following aspects of how directories and files appear in the panes.

Show Directory Structure

To indent items in the Directory Structure pane to show the directory hierarchy, click
Indented tree structure on the View menu. This is the default. To view the full pathnames
of directories in the Directory Structure pane, click Full Pathnames on the View menu.
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Show Number of Directory Levels Shown

To modify the number of subdirectory levels that appear in the Directory Structure pane
and the Files pane, modify the Directory Depth box.

Show Most Recent or All Backups

For a restore, you can choose from the View menu to display either All backup dates for
each file or Only most recent backup date.

Show File Details

To view file details (for example, file size and write permissions), click Verbose display of
attributes and filenames on the View menu. To view filenames without details, click
Brief display of filenames (default).

Update the Display

To update the NetBackup window to show the most recent changes (such as file additions
or deletions), click Update Display on the Edit menu.
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This chapter describes the various windows, screens, and menus associated with the xbp
and bp interfaces. Much of the information in this chapter is also available in the online
help for the interfaces. Refer to Chapter 4 “Using the X-Windows Interface” on page 75 or
Chapter 3 “Using the Menu Interface” on page 47 for instructions on using the interfaces.
For information on the Java interface, refer to Chapter 2 “Using the Backup, Archive, and
Restore Interface” on page 9 or the online help for that application.
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X-Windows Interface (xbp)

The xbp program provides a graphical interface for NetBackup users. This interface is
X-Windows based and uses the OSF/Motif conventions. A general description of Motif
usage is available in the OSF/Motif User’s Guide, authored by the Open Software
Foundation and published by Prentice Hall (ISBN 0-13-640509-6). The following topics
describe the windows, screens, and menus that you use to perform operations with xbp.

Note The current X-Windows interface does not support AFS restores. This restore can be

accomplished through the Backup, Archive, and Restore interface.

Special Symbols in Menus and Dialog Boxes

You will encounter the following symbols as you use the menus and dialog boxes:

2

An ellipsis (...) to the right of a menu item means that when you select the item, a
dialog box with additional choices appears. If there is no ellipsis in a menu item, the
operation occurs as soon as you select it.

A diamond shape to the left of a menu item means that two or more mutually
exclusive modes exist and the mode set by this menu item is currently in effect. For
example, if you intend to restore an archived file, you want the diamond to the left of
Browse archives (restore).

An underlined letter in a menu label means a keyboard shortcut. For example, on an

NCD terminal, pressing ALT in conjunction with a shortcut key opens the associated

menu. For example, pressing ALT+V opens the View menu. Note that some terminals
may require a key other than ALT.

Once a menu is opened, a letter (by itself) is sufficient to execute a menu item tagged
with that letter (pressing i on the View menu changes the Directory Structure pane
format to indented). You can use the up and down arrow keys to move the highlight
through the various menu items and press Enter to execute the highlighted item. The
Escape key closes a menu. The left and right arrow keys open adjacent menus.

If the pointer is over the main window, its shape changes to a wristwatch shape while
NetBackup is waiting for an operation to complete. For example, the pointer changes
to a wristwatch shape when NetBackup is updating its displays and then changes
back to an arrow when the update is complete.
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xbp Configuration

Borders on windows may vary depending on the window manager used at your site
(popular examples are twm and mwm). With some window managers, you may have to
click the left mouse button to position the window if it does not appear in a few seconds.
You can also use your window manager to resize the window.

The xbp program has enough space in its text fields to accommodate user-selected fonts
up to the 10x20 size. The windows can also fit on a 1024x768 screen with some room for
window manager borders.

There is no default font. If the XNB resource file is in the X search path, xbp uses the
values set in XNB. On some systems, the default font might be unpleasantly small. On
other systems, the default font has proportional spacing, causing column misalignment on
certain fields that have columnar text.

For an explanation of how to specify X resources to force a particular font, look near the
end of the Tutorial help files. For example:

1. From the Help menu in the xbp main window, click Tutorial. The Online Help Text
for xbp dialog box will appear.

2. Scroll to the “Customizing xbp™ section.

If your X server defaults to proportional fonts and you do not know which fonts are
available for your system, try the generic font name fixed.

Because the default window sizes are small enough to fit on a 1024x768 screen, you may
find that with larger fonts, the verbose display mode forces you to use a horizontal
scrollbar to see all the information. Widening the window at runtime with the window
manager may eliminate the scrollbar. You can also change X resources as described in the
“Customizing xbp” section of the Tutorial help file to enlarge the default geometry and
use a smaller font.

The xbp program depends upon the /usr/1ib/X11/XKeysymDB file to correctly use
editing keystrokes such as backspace and delete. The NetBackup installation procedures
are designed to install a nominal version of this file if it does not already exist. An existing
version of the file is not overwritten, thereby ensuring that user-customized versions of
XKeysymDB are not destroyed.

Sun systems typically have a version of XKeysymDB that does not define some editing
keys. Either you or the administrator must compare your current XKeysymbDB file to the
NetBackup standard version /usr/openv/netbackup/bin/XKeysymDB On
NetBackup server machines. Then:

¢ Append the NetBackup version onto the existing one.
or

& Replace the existing one with the NetBackup version.
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or

¢ Hand-edit the existing version to achieve your preferred keyboard support.

xbp Window

The xbp window opens when you start the X-Windows interface.

Tfoptsopeny/netbackupsbin/
01/01/1970 00:00:00 oa/s22/2001 23:59:59

adminemd/
bpdbm_child/
bpdbm_parent/
bprd.d/
bprd_child/
bprd_parent/
bpsched.d/f
driver/
goodies. 3,404/
goodies.4.5Prealphas
goodies/

BACKUP_CALLED
BACKUP_EXIT_CALLED
BPRD_CALLED
RESTORE_CALLED
SESSTON_CALLED
SESSTON_START_CALLED
KkeysynDB

KNE

HNB. dt

add_slave
add_slave_on_clients
backup_exit_notify
backup_exit_notify.3.4G4
backup_exit_notify.4.5Prealpha
backup_notify
backup_notify.3.4GA
backup_notify.4.5Prealpha

You can open menus from the menu bar to start backup, archive, and restore operations.
The text boxes let you enter specific values for finding and selecting directories and files.
The lists show information about selected directories and files.
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File Menu

,EiT Edit Wiew Backup Restore
|f2 Browse file swstem (hackup or archivel
Browse backups (restore)
Browse backups (true image restore)
Browse archives (restore)
Browse backups (restore raw partitions)
Browse backups (Auspex FastBackup raw partition)

Browse file swstem for Oracle backup scripts

Browse file swstem for Oracle restore scripts

Browse file swstem for Informix backup scripts
Browse file system for Informix restore scripts
Browse file swstem for SQL-BackTrack backup scripts
Browse file swstem for 5QL-BackTrack restore scripts
Browse file system for Swbase backup scripts

Browse file swstem for Sybase restore scripts

Browse file swstem for DEZ backup scripts

Browse file swstem for DEZ restore scripts

Browse Tile system for S&P backup scripts

Browse file swstem for SAF restore scripts

Configuration..
Quit

The File menu has commands for finding and selecting files for NetBackup operations.
You can also browse for and select database scripts.

Note The following are not supported for BusinesServer: Auspex FastBackup,
SQL-BackTrack, DB2, and SAP.

Browse file system Causes NetBackup to update its Directory Structure pane and the Files pane

(backup or archive) with directories and files that meet the criteria entered in the Directory to
Search box, the Range of Dates boxes, the Filename Filter box, and the
Keyword phrase to search for box.

Browse backups Causes NetBackup to build a list of the backups that exist for this client. The
(restore) completed list appears in a Backup Images pane that opens in the main
window.

Browse backups Causes NetBackup to build a list of the true image backups that exist for this
(true image restore) client. The completed list appears in a Backup Images pane that opens in the
main window.

Browse archives Causes NetBackup to build a list of the archives that exist for this client. The
(restore) completed list appears in a Backup Images pane that opens in the main
window.
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Browse backups Causes NetBackup to build a list of the raw partition backups that exist for

(restore raw this client. The completed list appears in a Backup Images pane that opens in
partitions) the main window.

Browse backups  Auspex FastBackup is not supported in NetBackup 4.5.

(Auspex

FastBackup raw

partition)

Browse file system NetBackup offers database extensions that you can use, in conjunction with
for database xbp, to back up and restore many of the most popular databases. These
extension NetBackup for database extensions are separately priced products which

must be installed, then configured to work with xbp. See the NetBackup
System Administrator Guides for the database extension for details.

The Browse File System commands enable the NetBackup for database
extension. They cause NetBackup to update its Directory Structure pane and
the Files pane to show all directories and files that meet the criteria of the
Directory to Search box, the Range of Dates boxes, Filename Filter box, and
the Keyword phrase to search for box.

Note: SQL-BackTrack, DB2, and SAP are not supported for BusinesServer.

Configuration Opens the xbp_config dialog box from which you can specify the master
server, the client to browse for restores, the client to restore to, and the policy
type of images to browse. For more information, see “xbp_config Dialog Box”
on page 126.

Quit Terminates the X-Windows interface.

Edit Menu

File @ Wiew Backup Restore

" |clear selections for current directory
Select all in current directory
Discard selections for previous directories
Inspect all selections..
Update Display

The Edit menu has commands to modify your selections.

Clear selections for Clears file selections from the Files pane. You must use Discard selections for
current directory  previous directories to clear the xbp_confirm dialog box.

Selectall in current Selects all the files in the Files pane.
directory

Discard selections Clears file selections from the xbp_confirm dialog box.
for previous
directories
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Inspect all Opens the xbp_viewselect dialog box, which shows you the files that are
selections currently selected. This dialog box has only information and no commands
except to close the dialog box or to obtain help.

Update Display Rereads your directory tree and updates the Directory Structure pane and the
Files pane. This is equivalent to pressing Enter in any of the text boxes.

View Menu

File Edit |Wiew Backup Restore
|ﬁ Brief display of filenames
Verbose display of attributes and filenames

@ |Indented tree structure
Full Pathnames
[

@ Resolve Links in Search Directory

Do WMot Resolve Links in Search Directory

The View menu has commands that modify how NetBackup shows directory and file
information in the Directory Structure pane and the Files pane.

Brief display of Shows filenames without details. The display starts in brief mode.
filenames

Verbose display of Shows file details such as size and file permissions.
attributes and

filenames

Indented tree Indents items in the Directory Structure pane to show the hierarchy of the

structure directory tree. You can use either Indented tree structure or Full Pathnames
mode, but not both. The default is indented mode.

Full Pathnames Shows full pathnames in the Directory Structure pane. You can use either Full

Pathnames or Indented tree structure mode (see above), but not both. The
X-Windows interface starts in the indented mode.

All backup dates  Shows all backups for each file in the Files pane. You can execute this

for each file command only when the File menu is set to one of the browse backups mode
or archives modes (diamond shape to the left of those entries). The choice is
unavailable when you browse the file system. The All backup dates for each
file and Only most recent backup date choices are mutually exclusive. You
can use either but not both. The X-Windows interface starts in the All backup
dates for each file mode.
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Only most recent
backup date

Resolve Links in
Search Directory

Do Not Resolve
Links in Search
Directory

Backup Menu

Shows only the most recent backup of a file in the Files pane. This command
is useful if you lose a directory and want to get the most recent copy of all files
(which may be spread across many backups). You can execute this command
only when the File menu is set to one of the browse backups mode or archives
modes (diamond shape to the left of those entries). The choice is unavailable
when you are browsing the file system. The All backup dates for each file
and Only most recent backup date choices are mutually exclusive. You can
use either but not both. The X-Windows interface starts in the All backup
dates for each file mode.

If you click this command, NetBackup automatically changes any links in
your search path so the path points to the actual file or directory. This is the
default.

If you click this command, NetBackup searches for the path as you type it in,
without resolving links.

File Edit Wiew | Backup Restore

|§ackup selected files and directories...

Backup search directory..
archive selected files and directories..
Archive search directory..

53

Report progress of backup..
Report progress of archive..

The Backup menu has commands to start a backup or archive of selected files and
directories. You can also obtain a progress report on backups or archives. The File menu
must be set to a browse file system mode (diamond shape to the left of the command)
before you can execute any Backup menu commands, other than the report on progress. If
the X-Windows interface is in a restore mode, when you pull down the Backup menu, the
backup commands are unavailable.
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Note If you click Backup selected files and directories or Archive selected files and
directories but then close the xbp_confirm dialog box without confirming your
selections, you are returned to the main window. Your file selections, however,
remain in the xbp_confirm dialog box. This feature is useful if you want to return to
the main window to edit your selections. To clear previous file selections, click
Discard selections for previous directories on the Edit menu.

Backup selected files Starts a backup of the current selections from the Files pane by opening the

and directories xbp_confirm dialog box. This dialog box shows the current selections. Click
OK to execute the backup. Click Cancel to abort and return to the main
window.

Backup search Starts a backup of the current selection from the Directory Structure pane by

directory opening the xbp_confirm dialog box. This dialog box shows the current

selection. Click OK to execute the backup. Click Cancel to abort and return
to the main window.

Backup database NetBackup offers database extensions that you can use, in conjunction with
using selected xbp, to back up and restore many of the most popular databases. These
scripts NetBackup for database extensions are separately priced products which

must be installed, then configured to work with xbp. See the NetBackup
System Administrator Guides for the database extension for details.

This command starts a backup of a database by opening the xbp_confirm
dialog box. This dialog box shows the scripts you selected from the Files
pane. Click OK to execute the backup. Click Cancel to abort and return to
the main window.

Archive selected Starts an archive of the current selections from the Files pane by opening the
files and directories xbp_confirm dialog box. This dialog box shows the current selections. Click
OK to execute the backup. Click Cancel to abort and return to the main

window.
Archive search Starts an archive of the current selection from the Directory Structure pane
directory by opening the xbp_confirm dialog box. This dialog box shows the current

selection. Click OK to execute the backup. Click Cancel to abort and return
to the main window.

Report progress of  Opens the xbp_progress dialog box, which shows the log files pertaining to
backup your backup operations. See “xbp_progress Dialog Box” on page 130 for
more information.

Report progress of  Opens the xbp_progress dialog box, which shows the log files pertaining to
archive your archive operations. See “xbp_progress Dialog Box on page 130 for
more information.
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Restore Menu

File Edit Wiew Backup | Restore Help

\Specify Destination Path.

s el red fed g

Restore search directory.

PRl

Report progress of restore..,

The Restore menu has commands to start a restore of selected files and directories. You
can also obtain a progress report on restores. The File menu must be set to a Browse mode
(diamond shape to the left of the command) before you can execute any Restore menu
commands, other than the report on progress. Otherwise, when you pull down the
Restore menu, those choices are unavailable.

Note If you click Restore selected files and directories but then close the xbp_confirm
dialog box without confirming your selections, you are returned to the main
window. Your file selections remain in the xbp_confirm dialog box. This feature is
useful if you want to return to the main window to edit your selections. To clear
those previous file selections, click Discard selections for previous directories on
the Edit menu.

Specify
Destination Path

Restore selected
files and
directories

Restore search
directory

Restore database
using selected
scripts

Opens the xbp_destpath dialog box. This dialog box lets you redirect the
restore to a directory other than the one from which they were backed up. If
you specify a path that does not exist, NetBackup creates it when restoring the
file.

In all browse modes except true image restore, this command starts a restore
of current selections in the Files pane. In true image restore mode, this
command starts a true image restore of the selected directory. In both cases
the xbp_confirm dialog box opens to show the current selections. Click OK to
execute the backup. Click Cancel to abort and return to the main window.

This command starts a restore of the current selection in the Directory
Structure pane by opening the xbp_confirm dialog box. This dialog box shows
the current selections. Click OK to execute the backup. Click Cancel to abort
and return to the main window.

This command is not available in Browse backups (true image restore) mode.

These commands start a restore of their respective type of database by
opening the xbp_confirm dialog box. This dialog box shows the scripts you
selected from the Files pane. Click OK to execute the backup. Click Cancel to
abort and return to the main window.

NetBackup offers database extensions that you can use, in conjunction with
xbp, to back up and restore many of the most popular databases. These
NetBackup for database extensions are separately priced products which
must be installed and configured to work with xbp. See the NetBackup System
Administrator Guide for the specific database extension for details.
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Report progress of Opens the xbp_progress dialog box, which shows the log files pertaining to
restore your restore operations. See “xbp_progress Dialog Box” on page 130 for more
information.

Help Menu

The Help menu has online instructions for using the X-Windows interface.

Directory to Search Box

- 3

Backed Up Expires Files KB Sched Type  Policy keyword

11/08/2001 14:55:20 11/22/20 5 32 User Backup hagar_user_backup test

Jfoptfopeny/netbackup Backup Date Filename

11/08/2001 14:55:20 release_notes. txt

Specifying the directory to search is the starting point when browsing for files to back up,
archive, or restore. The default is the directory you used to start the X-Windows interface.
You can change the directory to search by typing a new directory path in the Directory to
Search box and pressing Enter, or by double clicking on a directory in the Directory
Structure pane.
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When specifying the directory to search, you can also use the following wildcard
characters

*?[]
For example:

/home/s*
/home/ .??*
/home/ [a-z] *

If you are backing up or restoring a file path that has a wildcard character used literally
(that is, as a non-wildcard character), you must escape the wildcard using a backslash (\)
character. For example, the following path uses brackets that are not being used as
wildcards:

/home/abc/fun [ny] name

To back up or restore this file path, you must precede the brackets with backslashes as in
/home/abc/fun\ [ny\]name

so NetBackup interprets the brackets literally.

The backslash acts as an escape character only when it precedes a wildcard as in the above
example. This means that NetBackup normally interprets it literally and it is a legal
character to use in pathnames.

The Directory to Search box automatically scrolls horizontally to allow entry of long
pathnames. To view paths that do not fit in the window, a scroll bar allows you to scroll
horizontally.

- 116

NetBackup User’s Guide - UNIX



X-Windows Interface (xbp)

Range of Dates Boxes

-

optfopeny/netbackup/

Backed Up Expires Files KB Sched Type  Policy Keyword

1140872001 14:55:20 11/22/20 5 32 User Backup hagar_user_backup test

Joptfopeny/nethackup Backup Date Filename

11/08/2001 14:55:20 release_notes.txt

The Range of Dates boxes allow you to specify a date range for browsing and selecting
files. The left box is the start date and the right box is the end date.

& For arestore, enter the range of dates that includes the times when you suspect the
desired backups or archives occurred.

& For a backup or archive, enter the range of dates that includes the times when the
desired files were last modified.

The Directory Structure pane and the Files pane will show only those files that meet the
date range criteria. The administrator can change the initial browse default to show a
smaller range of dates by using the INITIAL BROWSE SEARCH LIMIT option in the
server and client /usr/openv/netbackup/bp.conf files.
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Browse Mode

When you start the X-Windows interface, it is in backup mode and the default date range
is from 01/01/70 to the current date. You can change this range by typing new values
with the keyboard and pressing Enter. In the United States, the format for:

& dates is month/day/year
01/23/93
& time is hours:minutes:seconds. Hours are expressed in terms of the 24 hour clock.

12 am is 00:00:00
12 pm is 12:00:00
11:30 pm is 23:30:00.

Leave the end date blank to search from the start date to the current date.

Restore Mode

When you switch from backup mode to restore mode, NetBackup normally changes the
starting date so that it defaults to the most recent full backup. However, if you type a
specific date just before changing modes, your specification is used.

If the client belongs to more than one policy, the start date defaults to the last full backup
that occurred first. For example, assume that the client belongs to PolicyW1 and PolicyW?2
and full backups occur for both of them. If the last full backup for PolicyW1 occurred
before the one for PolicyW2, then the display shows files ranging from the time of the
PolicyW1 full backup.
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Keyword phrase to search for Box

- 3

Yopt/openv/nethackup/

Backed Up Expires Files KB Sched Type  Policy keyword

1170872001 14:55:20 11/22/20 5 32 User Backup hagar_user_backup test

Foptsopenvinetbackup Backup Date Filename

11/08/2001 14:55:20  release_notes. txt

Enter a keyword phrase that NetBackup will associate with the backup being created by a
backup or archive operation. You can then restore the backup by specifying the keyword
phrase.

You can use this option in place of or in combination with the other restore options in
order to make it easier to restore your backups and archives. The following meta
characters can be used to simplify the task of matching keywords or parts of keywords in

the phrase:

* matches any string of characters.

? matches any single character.

[] matches one of the sequence of characters specified within the brackets.

[-1 matches one of the range of characters separated by the “-”.
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The keyword phrase is a textual description of the backup that is a maximum of 128
characters in length. All printable characters are permitted including space (*“ *“) and
period (*“.”). You must enclose the phrase in double quotes (“...””) or single quotes ( ‘...") to
avoid conflict with the UNIX shell.

The default keyword phrase is the null (empty) string.

Backup Images Pane

= wbp BE
File Edit Wiew Backup Restore Help
Directory to Search
ifoptfopenv/nethackup/
Range of Dates Kewword phrase to search for
H11/08/2001 14:55:20 71/08/2001 23:59:59 test
@ckup Images
/ Backed Up Expires Files KB Sched Type  Policy keyword
1170872001 14:55:20 11/22/20 5 32 User Backup hagar_user_backup test
N
=
Directory Depth Filename Filter
2 * tx
Directory Structure Files
Foptsopenvinetbackup Backup Date Filename

11/08/2001 14:55:20  release_notes. txt

£
f

The Backup Images pane opens within the main window when you execute Browse
backups (restore), Browse backups (true image restore), or Browse archives (restore)
from the File menu. This pane shows the backups or archives for your client. You can
search either all or some of the backups to find directories and files that meet the values in
the Directory to Search box, the Range of Dates boxes, the Directory Depth box,
Filename Filter box, and the Keyword phrase to search for box.

- 120 NetBackup User’s Guide - UNIX



X-Windows Interface (xbp)

The list starts with the most recent backup or archive. The list contains the following
information on each backup:

Backed Up Date and time at which the backup occurred.

Expires Date and time at which NetBackup expires the backup and removes it from
the Backup Images pane.

Files Number of files in the backup.

KB Size of the backup in kilobytes.

Sched Type Shows the type of schedule as follows:
- Full Backup
- Incr Backup

- User Backup
- User Archive

Policy Backup policy that created the backup. The system administrator configures
the policy names, as explained in the NetBackup System Administrator’s Guide
for UNIX or the NetBackup System Administrator’s Guide for Windows.

Keyword Shows the keyword entered by the user when the backup was initiated.

The rules for selecting backups from the Backup Images pane are:

& Selecting a specific backup changes both dates to show the backed up time for the
selected backup.

¢ Selecting a range of consecutive backups changes the date boxes to show the oldest
and newest times in the selected range.

& Selecting another backup cancels previous selections. If the list is longer than the
window, a vertical scroll bar appears along the right edge.

When you are satisfied with your selections, move the pointer over one of the text boxes
and press Enter. This updates the Directory Structure pane and the Files pane to show the
directories and files that are in the selected backups and that match the entries made in the
Directory to Search box, the Range of Dates boxes, the Directory Depth box, Filename
Filter box, and the Keyword phrase to search for box.

Note There may be a noticeable delay before the update occurs because the client must
obtain this information from the NetBackup master server.

Chapter 5, Reference Guide to xbp and bp 121 =



X-Windows Interface (xbp)

Directory Depth Box
S [

ifopt/openv/netbackup/

Backed Up Expires Files KB Sched Type  Policy Keyword

1170872001 14:55:20 11/22/20 5 32 User Backup hagar_user_backup test

Foptfopenvinetbackup Backup Date Filenane

1170872001 14:55:20 release_notes. txt

The Directory Depth box determines how deep to search the subdirectories of the current
directory. It has no effect on the Files pane. Increment or decrement the depth by typing a
new value with the keyboard and pressing Enter. The default is 2.

——
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xbp

File Edit Wiew Backup Restore

|
Help

Directory to Search
ifopt/openv/netbackup/
Range of Dates

111/08/2001 14:55:20 11140842001 23:59:59

Keyword phrase to search for
test

Eackup Images

Backed Up Expires Files

KB Sched Type  Policy

Keyword

11/08/2001 14:55:20 11/22/20 5

32 User Backup hagar_user_backup

test

Directory Depth
2

Directory Structure
Fopt/openv/netbackup

£
i

ilename Filter
* tuf]
T

Backup Date Filename

1170872001 14:55:20 release_notes. txt

The Filename Filter box determines the files of a selected directory that NetBackup shows
in the Files pane. When you start the X-Windows interface, the Filename Filter box has a
value of * and the Files pane shows all files. You can change the filter to limit the files that
NetBackup shows. In addition to specific file names, you can use the following types of

expressions to filter filenames:

matches all files that end with _log.

matches the logl, log2, and loga3 files.

Asterisk (*) matches one or more characters. For example, a search for * log
Question mark (?) matches a single character. For example, a search for Log?

Brackets ([]) specify any of the listed characters. For example, a search for

prog[1-4] finds all five-character files that start with prog and end with a digit

in the range 1 through 4.
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Directory Structure Pane and the Files Pane

xbp

|

File Edit Wiew Backup Restore

Help

Directory to Search
ifopt/openv/netbackup/

Range of Dates

111/08/2001 14:55:20 11140842001 23:59:59

Keyword phrase to search for
test

Eackup Images
Backed Up

KB Sched Type  Policy

Keyword

11/08/2001 14:55:20 11/22/20

32 User Backup hagar_user_backup

test

Directory Depth

Filename Filter

\

3 bl

2 *otud
/ﬂectory Structure Files
Foptfopenvinetbackup Backup Date Filenane

1170872001 14:55:20 release_notes. txt

~

/

These panes show the directories and files that you can select for NetBackup operations.
Directories in the Files pane are followed by a slash. The contents of these panes depends

on the browse mode.

For more information on browsing directory trees and selecting files, see “Finding and
Selecting Files and Directories” on page 101.

Browse file system (backup or archive) Mode

If you are in Browse file system (backup or archive) mode, the panes show the directories

and files in the filesystem that:

¢ Are in the Directory to Search box or in subdirectories below it in the client's
directory tree (the Directory Depth box determines number of levels shown).

& Have modified dates within the time frame specified in the Range of Dates boxes.
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¢ Areinthe currently selected directory which match the value in the Filename Filter
box.

When you start the X-Windows interface, it is in the Browse file system (backup or
archive) mode and shows all directories and files that reside under the directory from
which you executed the xbp command.

Browse backups (restore) or Browse archives (restore) Mode

If you are in Browse backups (restore) or Browse archives (restore) mode, the panes
show the directories and files that are in the selected backups or archives and meet the
following criteria:

¢ Are in the Directory to Search box or in subdirectories below it in the client’s
directory tree (the Directory Depth box determines number of levels shown).

& Were backed up within the time frame specified by the Range of Dates boxes.

& Arein the currently selected directory which matches the value in the Filename Filter
box.

Browse backups (true image restore) Mode

If you are in Browse backups (true image restore) mode, the panes show the directories
that are in the selected backups and meet the following criteria:

¢ Are in the Directory to Search box or in subdirectories below it in the client’s
directory tree (the Directory Depth box determines number of levels shown).

& \Were backed up by a scheduled full or incremental backup within the time frame
specified by the Range of Dates boxes.

& Arein the currently selected directory which matches the value in the Filename Filter
box.

Browse for Scripts Modes

When in the Browse for Scripts modes, the panes show the same type of information as
when you browse the file system for backups or archives.

NetBackup offers database extensions that you can use, in conjunction with xbp, to back
up and restore many of the most popular databases. These NetBackup for database
extensions are separately priced products which must be installed and configured to work
with xbp. See the NetBackup System Administrator Guide for the specific database for

details.
R ————
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Browse backups (restore raw partitions) Mode

When in the Browse backups (restore raw partitions) mode, the panes show the same
type of information as when you browse the file system for backups or archives.

Browse backups (Auspex FastBackup raw partition) Mode

Note Auspex FastBackup is not supported in NetBackup 4.5.

xbp_config Dialog Box

The xbp_config dialog box opens when you click Configuration on the File menu.

Server

your server

Client to browse for restores

vour client]

Client to restore to

vour client or different client |

Policy tupe of images to browse
Standard = |

OK | Cancel | Help.. |

The xbp_config dialog box lets users change the following values. After completing your
changes:

& Click OK to use the new values.
or

¢ Click Cancel to cancel the changes so the previous values are still used.
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Server This is the current master server to which NetBackup sends backup and
archive requests and also the server that has the backup you can browse for
files to restore to your client. The master server is the first line listed under the
SERVER option in the /usr/openv/netbackup/bp . conf file on the client.
See the NetBackup System Administrator’s Guide for UNIX for more information
on the bp . conf file.

When you start the X-Windows interface, this box shows the default master
server configured for your client. You can change the name of the master
server. If you specify an invalid name or your client does not belong to a
configured policy on that server, you get an error message.

Clientto browse  Client whose backed up files you can currently browse. The administrator on

for restores the master server can change this hame to that of another client and can grant
you permission to do the same by making the necessary changes to the
/usr/openv/netbackup/altnames file on the master server.

When you start the X-Windows interface, this box shows the name of the
client on which you are running as specified by the CLIENT NAME parameter
in the /usr/openv/netbackup/bp.conf file on the client.

See the NetBackup System Administrator’s Guide for UNIX for more information
on the altnames file and the bp . conf file.

Client to restore to  When you start the X-Windows interface, this field shows the name of the
client on which you are running.
The administrator running the X-Windows interface on the master server can
change this name in order to direct files to another client. This ability is not
available to other users.

Policy type of Type of client to which you are restoring files when you redirect a restore to a
images to browse  different client.

The client type must match that in Client to restore to box and the Client to
browse for restores box. You cannot restore clients from one type to another.
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xbp_destpath Dialog Box

The xbp_destpath dialog box opens when you click Specify Destination Path on the
Restore menu. This dialog box lets you set up a restore to a path other than the one from
which files were originally backed up.

Restore From
|Ph0me/g]a/samn]e/

Restore To
fhomesglassample/tests

® Rename Hard Links

¥ Rename Soft Links

OK | Cancel | Current Directary ‘ Help... |

The text boxes at the top of the dialog box show the restore paths:

Restore From Full or partial pathname that NetBackup uses to find the files to restore.

Restore To The path to which you want NetBackup to restore the selected files.

When you start the X-Windows interface, these paths are set to your current directory to
search.

Use the mouse and keyboard to change the paths in the Restore From box and the Restore
To box. You can click the Current Directory button to change the values in both boxes to
their default, which is your current directory to search. If you specify a path that does not
currently exist, NetBackup creates it when restoring the file.

After completing your changes to the paths:

¢ Click OK to use the Restore From and Restore To paths on the next restore.
or

4 Click Cancel to cancel the changes so the previous paths are still used.

You can also rename soft (symbolic) and hard links to the files so those links show the
Restore To pathname:

Rename Hard Links Select to rename hard links so they point to the new path. The button is
enabled when highlighted.

Rename Soft Links Select to rename soft (symbolic) links so they point to the new path. The
button is enabled when highlighted.

- 128

NetBackup User’s Guide - UNIX



X-Windows Interface (xbp)

xbp_confirm Dialog Box

The xbp_confirm dialog box opens when you execute a NetBackup operation. This dialog
box shows the items you picked in the Directory Structure pane or Files pane and lets you
confirm them before continuing. If the list of selections is longer than the dialog box, a
vertical scroll bar appears along the right edge.

~i wbp_confirm = iJ

OK to restore directory?
foptfopenv/netbackups

M Use log file
Log filename
¥bplog.rest.009

_| Overwrite existing files

OK Cancel Help..

Use log file The Use log file checkbox lets you select whether you want NetBackup to
create a progress log file in your home directory and write to this file as the
operation progresses.

Enable the Use log file checkbox to use the log file (this is the default). The
name of the log file appears in the Log Filename box. Use report progress
commands from the Backup menu or the Restore menu to read these files.
(See “xbp_progress Dialog Box™ on page 130 for more information.)

Log Filename When the Use log file checkbox is selected, the default log file name displays
in the Log Filename box. Use report progress commands from the Backup
menu or the Restore menu to read these files. (See “xbp_progress Dialog Box”
on page 130 for more information.)

Overwrite existing If you are restoring files or directories, the Overwrite existing files checkbox
files lets you choose whether you want to overwrite existing files.

Select the Overwrite existing files checkbox to overwrite. See “File
Permissions Required By NetBackup” on page 7 for an explanation of how file
ownership and permissions affect overwriting of files and directories.

Clear the Overwrite existing files checkbox if you do not want to overwrite
existing files. The restore will not occur if the file exists.
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Redirected restore If you previously changed the destination path, the Redirected restore
checkbox is active and lets you restore files into a directory other than the one
from which they were backed up (see “xbp_destpath Dialog Box™ on
page 128). If you did not change the destination path, the checkbox is
unavailable.

Select the Redirected restore checkbox to restore the files to the alternate
directory.

Clear the Redirected restore checkbox to cancel the redirected restore to a
different path.

Restore directories To skip over file systems mounted in the selected directories, select the
without crossing  Restore directories without crossing mount points checkbox. This option is
mount points selected by default).

Note Mount points inside will get restored whether or not the Restore directories
without crossing mount points box is selected.

When you are satisfied with your selections, click OK to start the NetBackup operation.

To cancel and return to the main window without performing a NetBackup operation,
click Cancel. The cancel does not affect your selections. After canceling, you can either
edit your selections or clear them by clicking Discard selections for previous directories
on the Edit menu.

xbp_progress Dialog Box

The xbp_progress dialog box opens when you execute a Report progress of backup,
Report progress of archive, or Report progress of restore from the appropriate menu.
This dialog box shows the related progress log files in your home directory and lets you
view them in order to monitor the progress of the operation.
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See “Checking Progress of Operations” on page 98 for information on using this dialog
box.

/bplog. rest. 001
/bplog. rest. 002
fbplog. rest. 003

Restore started Wed Aug 22 14:02:04 2001

.001) Restoring from image created Wed Aug 22 13:47:19 2001

.001) TAR STARTED

L0013 INF - Beginning restore from server hagar to ¢lient hagar, file /nbstuni
L001) fhomefglafsanple/sanple. txt

L0013 Changed fhome/gla/sample/sample.txt to fsample. txt

L0013 INF - TAR EXITING WITH STATUS = 0

L0013 IMF - TAR RESTORED 1 OF 1 FILES SUCCESSFULLY

.001) INF - TAR KEPT 0 EXISTING FILES

L0013 IWF - TAR PARTIALLY RESTORED O FILES

L0013 Status of restore from image created Wed Aug 22 13:47:19 2001 = the requ

Luwwd INF - Status = the reguested operation was successfully completed.

eteisarie]

Chapter 5, Reference Guide to xbp and bp 131 ¥



Menu Interface (bp)

Menu Interface (bp)

The bp program is a menu-driven user interface to NetBackup. When using the menus,
execute an operation by typing the letter to the left the related menu item. For example,
typing b from the main menu takes you to the Backup Menu (it is usually unnecessary to
press Enter). An ellipsis (...) to the right of an option means that when you choose the
option, another menu or screen appears from which you can make further choices. If there
is no ellipsis, the operation occurs immediately.

Main Menu

window  Edit Options Help

NetBackup 4.5

Master Server: hagar
Client: hagar

Main Menu

b} Backup...
r) Restore...

h} Help
q) Quit

ENTER CHOICE:

Master Server Master server to which NetBackup sends operation requests. Use the m
(Change Master Server) option from the Backup Menu or the Restore Menu to
specify another master server.

Client Displays the name of the client for which the backup or archive will be
performed.

b (Backup) Opens the Backup Menu.

r (Restore) Opens the Restore Menu.

h (Help) Help information for the Main Menu. Each secondary menu also has this
option.

q (Quit) Terminates the program and returns to the shell prompt.

——— _
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Backup Menu

= Console ==
window  Edit Options Help

Master Server: hagar
Client: hagar

Backup Menu
b} Backup Files and Directories...
a) Archive Files and Directories...
o} Backup Oracle DE...
i) Backup Informix DE...
s} Backup Sybase DEB...
p) Backup SAP DB...
2} Backup DBZ DEB...
£} Backup SQL-BackTrack DB...

m} Change Master Server...
h} Help
q) Quit Menu

ENTER CHOICE:

Note The following menu items do not apply to BusinesServer: Backup SAP DB, Backup
DB2 DB, and Backup SQL-BackTrack DB.

Master Server This is the master server to which NetBackup sends backup and restore
requests. You can use the m (Change Master Server) option to specify another
master server.

Client Displays the name for the client for which the backup or archive will be
performed.

b (Backup Filesand Opens the Backup of Files and Directories menu.
Directories)

a (Archive Filesand Opens the Archive of Files and Directories menu.
Directories)

Backup database NetBackup offers database extensions that you can use, in conjunction with

options bp to back up and restore many of the most popular databases. These
NetBackup for database extensions are separately priced products which
must be installed. See the NetBackup System Administrator Guide for the specific
database for details.

o (Backup Oracle Opens the Backup Oracle DB menu.
DB)

i (Backup Opens the Backup Informix DB menu.
Informix DB)
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s (Backup Opens the Backup Sybase DB menu.
Sybase DB)

p (Backup SAP  Opens the Backup SAP DB menu.
DB)

2 (Backup DB2  Opens the Backup DB2 DB menu.
DB)

t (Backup Opens the Backup SQL-BackTrack DB menu.
SQL-BackTrack
DB)

m (Change Master Lets you change the master server to which NetBackup sends backup and

Server) restore requests. If it is an invalid server or the client does not belong to a
user-directed backup policy on that server, you receive an error message. The
master server is set to the configured default for your client each time you
start the menu interface.

h (Help) Help information for the Backup Menu. Each secondary menu also has a Help
option.
g (Quit Menu) Closes the Backup Menu and returns to the Main Menu.

Backup of Files and Directories Menu

window  Edit Options Help

Search Path: foptfopenv/netbackup/bin/
Start Date: 01/01/1970 00:00:00
End Date: 08/22/2001 23:59:59
Master Server: hagar
Display Mode: Brief
Files selected: 0O
Keyword Phrase:

Backup of Files and Directories

s) Select Files and Directories...
e) Edit/view Selected Files...

i) Initiate Backup

p) Change Search Path...

d} Change Date Range...

m} Change Master Server...

k} Change Keyword Phrase...

%) Change Display Mode to Verbose
h} Help

q) Quit Menu

ENTER CHOICE:

Search Path This is the starting point for searches that you start with the s (Select Files and
Directories) option. You can change the current directory with the p (Change
Search Path) option from the menu.
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Start Date

End Date

Master Server

Display Mode

Files Selected

Keyword Phrase

S (Select Files and
Directories)

e (Edit/View
Selected Files)

i (Initiate Backup)

p (Change Search
Path)

d (Change Date
Range)

The Start Date and End Date show the range of dates that the search will
include. Start Date is the earliest modified date and time that a file can have for
NetBackup to be included in the search. You can change the Start Date with
the d (Change Date Range) option from the menu. When you start the menu
interface, the Start Date is set to 01/01/70 00:00:00 for backups and archives.

The Start Date and End Date show the range of dates that the search will
include. End Date is the latest modified date and time that a file can have for
NetBackup to be included in the search. You can change the End Date with the
d (Change Date Range) option from the menu. When you start the menu
interface, the End Date is set to 23:59:59 of the current day.

This is the master server to which NetBackup sends NetBackup operation
requests. You can use the m (Change Master Server) option to specify another
master server.

Displays the display mode, either verbose or brief. Refer to “x (Change
Display Mode to Verbose)” on page 136 for more details.

Number of files currently selected for backup. This number changes as you
select or deselect files with the s (Select Files and Directories) option or e
(Edit/View Selected Files) option.

Displays the keyword phrase entered for the backup.

Displays the list of files and directories for the indicated path. Select files
and/or directories from this list to back up.

Displays the list of files and directories previously selected for backup. You
can also add or delete selections from the list. For more information, see
“Edit/View Selections Screen” on page 149.

Starts the backup operation. Prompts for creating a log file in your home
directory and writing to this file as the operation proceed are displayed.

Changes the directory at which subsequent search operations begin.

Changes the Start Date and End Date as shown at the top of the menu. These
dates specify the range in which a file's modification date must be in order to be
included in the search for files to back up. Entering this option displays
prompts for typing new start and end dates.

Some basic rules for typing dates are as follows:
The format for dates is month/day/year. For example, 01/23/93.

The format for time is hours:minutes:seconds and in terms of the 24-hour clock.
For example, 12 am is 00:00:00, 12 pm is 12:00:00, and 11:30 pm is 23:30:00.

To leave a date unchanged, press Enter at the prompt.

If you change only part of the date or time and press Enter, NetBackup
completes the entry.
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m (Change Master
Server)

k (Change
Keyword Phrase)

X (Change Display
Mode to Verbose)

h (Help)

g (Quit Menu)

Changes the master server to which NetBackup sends backup and restore
requests. If an invalid server is selectede, or the client does not belong to a
user-directed backup policy on that server, you will receive an error message.
The master server is set to the configured default for your client each time you
start the menu interface.

Changes the keyword phrase entered for the backup.

Selects whether the Search screen shows only names or also includes file
details such as permissions. Toggle the Display Mode indication to Verbose for
file details and to Brief to deselect them.

Help information for the Backup of Files and Directories menu. Each
secondary menu also has a Help option.

Closes the Backup of Files and Directories menu and returns to the Main
Menu.
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Archive of Files and Directories Menu

The Archive of Files and Directories menu has choices for archive operations. Archive and
backup operations are the same except that an archive deletes the file after backing it up,
thus freeing disk space.

window  Edit Options

Search Path:
Start Date:

End Date:
Master Server:
Display Mode:
Files selected:
Keyword Phrase:

Joptiopeny/netbackupsbing
01/01/1970 00:00:00
08/22/2001 23:59:59

hagar

Brief

1}

Archive of Files and Directories

s)
el
i)
pJ
)
m)

Select

Files and Directories...

Edit/view Selected Files...
Initiate Archive

Change
Change
Change
Change
Change
Help

Search Path...

Date Range...

Master Server...
Keyword Phrase...
Display Mode to Verbose

Quit Menu

ENTER CHOICE:

The information at the top of the menu, as well as the menu choices, are the same as the
Backup of Files and Directories menu. The one exception is the i (Initiate Archive) option,
which starts the archive operation.
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Database Backup Menus

The database backup menus have choices for their respective types of database backups.
The following figure is an example of the Backup Oracle DB menu.

window  Edit Options

Help

Search Path:
Start Date:
End Date:
Master Server:
Display Mode:

Keyword Phrase:

s} Select
e) Edit/vi

p) Change
d} Change
n} Change
k} Change
%) Change
h} Help

Joptiopeny/netbackupsbing
01/01/1970 00:00:00
08/22/2001 23:59:59

hagar

Brief

Scripts Selected: 0

Backup Oracle DB

Scripts...
ew Selected Scripts...

i} Initiate Oracle DB Backup Using Selected Script(s)

Search Path...

Date Range...

Master Server...
Keyword Phrase...
Display Mode to Verbose

q) Quit Menu
ENTER CHOICE: W

The information at the top of the menu, as well as the menu choices, are the same as the
Backup of Files and Directories menu. The one exception is the i (Initiate Oracle DB
Backup Using Selected Script(s)) option. Choosing this option uses the scripts you
selected with the s (Select Scripts) option and e (Edit/View Selected Scripts) option to
back up Oracle databases. The other Backup DB menus are the same, except for the menu
choice that starts the backup.

Refer to the NetBackup System Administrator’s Guide for the specific database for more

information.
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Restore Menu

window  Edit Options

Master Server:
Client:

Restore Menu

r)} Restore From
f) Restore From
d) Restore From

o) Restore From
i) Restore From
s) Restore From
t) Restore From
p) Restore From
2) Restore From

h} Help
q) Quit Menu

EWTER CHOICE:

hagar
hagar

b} Restore Files and Directories From Backups...
a) Restore Files and Directories from Archives...

Raw Partition Backups...
Auspex FastBack Backups...
True Image Backups...

Oracle DB Backups...
Informix DB Backups...
Sybase DB Backups...
SQL-BackTrack DB Backups...
SAP DB Backups...

DE2 DB Backups...

m} Change Master Server...

i

Note Auspex FastBack Backups is not supported in NetBackup 4.5.

Note The following menu items do not apply to BusinesServer: Restore From Auspex
FastBack Backups, Restore From SQL-BackTrack DB Backups, Restore From SAP
DB Backups, and Restore From DB2 DB Backups.

Master Server This is the master server that has the backup for the files you are browsing.
You can use the m (Change Master Server) option to select another master
server.

Client Client that backed up the files you are permitted to browse and restore.

b (Restore Filesand Opens the Restore Backups menu.

Directories from
Backups)

a (Restore Filesand Opens the Restore Archives menu.

Directories from
Archives)

r (Restore From Opens the Restore Raw Partition Backups menu.

Raw Partition
Backups)

f (Restore From Auspex FastBack Backups is not supported in NetBackup 4.5.

Auspex FastBack
Backups)
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d (Restore From Opens the Restore True Image Backups menu.
True Image
Backups)

Restore database NetBackup offers database extensions that you can use, in conjunction with

options bp, to back up and restore many of the most popular databases. These
NetBackup for database extensions are separately priced products which
must be installed. See the NetBackup System Administrator Guide for the specific
database for details.

0 (Restore From Opens the Restore Oracle DB menu.
Oracle DB
Backups)

i (Restore From Opens the Restore Informix DB menu.
Informix DB
Backups)

S (Restore From Opens the Restore Sybase DB menu.
Sybase DB
Backups)

t (Restore From Opens the Restore DB using SQL-BackTrack menu.
SQL-BackTrack
DB Backups)

p (Restore From Opens the Restore SAP DB menu.
SAP DB
Backups)

2 (Restore From Opens the Restore DB2 DB menu.
DB2 DB
Backups)

m (Change Master Allows you to change the master server to which NetBackup sends backup

Server) and restore requests. If it is an invalid server or the client does not belong to a
user-directed backup policy on that server, you receive an error message. The
master server is set to the configured default for your client each time you
start the menu interface.

h (Help) Help information for the Restore Menu.
g (Quit Menu) Closes the Restore Menu and returns to the Main Menu.
——— _
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window  Edit Options

Restore Backups Menu

Help

q) Quit Menu
h} Help

ENTER CHOICE:

Search Path: Jfopt/openv/netbackup/bin/ =

Start Date:

End Date:

Files Selected:
Directory Depth:
Display Mode:

s} Select Files and Directories... p)
e) Edit/view Selected Files... d)
i) Initiate Restore (]
#) Change Display Mode to Verbose m)
1) List Backup Images... bl

08/22/2001 11:04:25 Master Server: hagar
08/22/2001 23:59:59 Source Client: hagar
1] Destination Client: hagar

1 level Policy Type: Standard
Brief Keyword Phrase:

Restore Backups

Search Path...

Date Range...
Directory Depth...
Master Server...
Source Client...
Destination Client
Destination Path...
Policy Type
Keyword Phrase

Change
Change
Change
Change
Change
£} Change
a}) Change
v) Change
k) Change

Search Path

Start Date

End Date

Files Selected

Directory Depth

Display Mode

Master Server

Source Client

This is the starting point for searches that you start by choosing the s (Select
Files and Directories). You can change the current directory with the p
(Change Search Path) option from the menu.

Start Date and End Date show the range of backup dates NetBackup searches
for files to restore. Start Date is the earliest backup date and time that
NetBackup checks when searching backups. You can change this with the d
(Change Date Range) option from the menu.

The Start Date and End Date show the range of backup dates that NetBackup
searches for files to restore. End Date is the latest modified date and time that
a file can have for NetBackup to be included in the search. You can change this
with the d (Change Date Range) option from the menu.

Number of files currently selected. This number changes as you select or
deselect files with the s (Select Files and Directories) or e (Edit/View Selected
Files) option.

This number indicates how many levels of directories and files NetBackup
shows on the Search screen. You can increment or decrement the depth with
the ¢ (Change Directory Depth) option. The default is 1.

Displays the display mode, either verbose or brief. Refer to “x (Change
Display Mode to Verbose)” on page 136 for more details.

Master server that has the backup for the files you are browsing. You can use
the m (Change Master Server) option to select another master server.

Client that backed up the files you are permitted to browse and restore. You
can use the b (Change Source Client) option to select another client.
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Destination Client  Client to which NetBackup will restore the selected files. This option will be
displayed when you log in as root. Only the administrator on the master
server can change this name to that of another client. See the t (Change
Destination Client) option for information on changing this name.

Policy Type Your client type. See the y (Change Policy Type) option for information on
changing the policy type.

Keyword Phrase Displays the keyword phrase entered for the backup.

S (Select Filesand  Takes you to the Search screen from which you can browse the backup. From

Directories) this screen, you can select files and directories to restore.
e (Edit/View Shows the list of files and directories previously selected for restore. You can
Selected Files) also add or delete selections from the list.

i (Initiate Restore)  Brings up the Initiate Restore screen from which you can start the operation.
Prompts for specifying the following display:
- NetBackup creates a log file in your home directory and writes to this file
as the operation proceeds.

- existing files that have the same names as those you are restoring should
be overwritten.

If you selected a (Change Destination Path), you will be prompted to verify
that you want to:

- restore to an alternative path
- rename hard links
- rename soft links
X (Change Display Selects whether the Search screen shows only names (Brief mode) or also

Mode to Verbose) includes file details such as permissions (Verbose mode). Toggle the Display
Mode indication to Verbose to select file details and Brief to deselect them.

| (List Backup Lists the backups for the client that meet the entries in the Search Path, Start
Images) Date, End Date, Directory Depth, and the Keyword Phrase fields.

g (Quit Menu) Closes the Restore Backups menu and returns to the Main Menu.

h (Help) Help information for the Restore Backups menu.

p (Change Search  Changes the directory at which subsequent search operations begin. To find a
Path) specific file, type its complete pathname at the prompt. You can also use
wildcard characters *, ?, [, and ] to find multiple files and directories.

d (Change Date Changes the Start Date and End Date at the top of the menu. These dates
Range) specify the range of backup dates that NetBackup searches during a restore.
Entering this option displays prompts for typing new start and end dates.

¢ (Change Directory Changes the number of levels of directories and files that appear on the
Depth) Search screen. The new number appears in the Directory Depth field at the
top of the screen. The default depth is 1.
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m (Change Master Specifies the master server with the backup for the files you want to restore. If

Server) it is an invalid server or the client does not belong to a user-directed backup
policy on that server, you receive an error message. The master server is set to
the configured default for your client each time you start the menu interface.

b (Change Source  Lets the administrator on the master server browse and restore files for

Client) another client. The administrator can also change the configuration to give
this ability to other users. When you start the menu interface this name is set
to the default (normally the client on which you are running).

t (Change Lets the administrator on the master server direct restored files to another
Destination Client) client. When you start the menu interface, this name is set to the default
(normally the client on which you are running).

a (Change Restores files to a directory other than the one from which they were backed
Destination Path)  up. If you specify a path that does not currently exist, NetBackup creates it
when restoring the file.

Y (Change Policy  Lets the administrator on a server direct client restores. The policy type must
Type) match that specified in the Source Client and Destination Client fields. You
cannot restore files from one client type to another.

Note The following policy types do not apply to BusinesServer:
DataTools-SQL-BackTrack, Auspex-FastBackup, SAP, DB2, and
FlashBackup.

k (Change Change or enter the keyword phrase for your search.
Keyword Phrase)
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Restore Archives Menu

The Restore Archives menu is the same as the Restore Backups menu, except that the

restore of archived files and directories can be initiated.

=

window  Edit Options

Search Path: Jfopt/openv/netbackup/bin/

Start Date: 01/01/1970 00:00:00
End Date: 08/22/2001 23:59:59
Files Selected: 0O
Directory Depth: 1 level
Display Mode: Brief

Restore Archives

s} Select Files and Directories... p) Change
e) Edit/view Selected Files... d} Change
i} Initiate Restore ¢} Change
%) Change Display Mode to Verbose m) Change
1) List archive Images... b} Change
q) Quit Menu t) Change
h} Help a}) Change

v) Change

k) Change

ENTER CHOICE:

Master Server: hagar
Source Client: hagar
Destination Client: hagar

Policy Type: Standard
Keyword Phrase:

Search Path...

Date Range...
Directory Depth...
Master Server...
Source Client...
Destination Client
Destination Path...
Policy Type
Keyword Phrase

Restore Raw Partition Backups Menu

The following figure shows the Restore Raw Partition Backups menu. You use the choices
on this menu to select and initiate restores of raw partition backups. See “Restore Backups

Menu” on page 141 for an explanation of the menu items.

window  Edit Options

=

Help

Search Path: Jfopt/openv/netbackup/bin/

08/22/2001 11:04:25
08/22/2001 23:59:59

Start Date:
End Date:

Master Server: hagar
Source Client: hagar

ENTER CHOICE:

Files Selected: 0O
Directory Depth:
Display Mode:

s} Select Files and Directories... p) Change Search Path...

e) Edit/view Selected Files... d} Change Date Range...

i} Initiate Restore ¢} Change Directory Depth...

®) Change Display Mode to VWerbose m) Change Master Server...

1) List Backup Images... b} Change Source Client...

q) Quit Menu t} Change Destination Client

h} Help a} Change Destination Path..
k) Change Keyword Phrase

Destination Client: hagar
Policy Type: Standard
Keyword Phrase:

1 level
Brief

Restore Raw Partition Backups
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Restore True Image Backups Menu

The following figure shows the Restore True Image Backups menu. The menu options can
be used to select and initiate restores of true image backups. See “Restore Backups Menu”
on page 141 for an explanation of the menu items.

window  Edit Options Help

Search Path: Jfopt/openv/netbackup/bin/

Start Date: 08/22/2001 11:04:25 Master Server: hagar
End Date: 08/22/2001 23:59:59 Source Client: hagar
Files Selected: 0 Destination Client: hagar
Directory Depth: 1 level Policy Type: Standard
Display Mode: Brief Keyword Phrase:

Restore True Image Backups

s} Select Files and Directories... p) Change Search Path...

e) View/Delete Selected Files... d) Change Date Range...

i} Initiate Restore ¢} Change Directory Depth...

®) Change Display Mode to Verbose m) Change Master Server...

1} List TIR Backup Images... b} Change Source Client...

q) Quit Menu t} Change Destination Client

h} Help a} Change Destination Path..
k) Change Keyword Phrase

ENTER CHOICE:

Restore Database Menus

The Restore Menus for databases have choices for restoring their respective database
backups. The following figure is an example of the Restore Oracle DB menu.

window  Edit Options Help

Search Path: foptfopenv/netbackup/bin/
Start Date: 01/01/1970 00:00:00
End Date: 08/22/2001 23:59:59
Master Server: hagar
Display Mode: Brief
Scripts Selected: 0
Keyword Phrase:

Restore Oracle DB

s} Select Scripts...

e} Edit/view Selected Scripts...
i) Initiate Oracle DB Restore Using Selected Scriptis)
p) Change Search Path...

d} Change Date Range...

m} Change Master Server...

k} Change Keyword Phrase...

%) Change Display Mode to Verbose
h} Help

q) Quit Menu

ENTER CHOICE:
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The information at the top of the menu and the menu options have the same meaning as
the corresponding lines and options on the Restore Backups menu. The one exception is
the i (Initiate...) option which starts the restore operation for the selected database.

When you choose the i (Initiate Oracle DB Backup Using Selected Script(s)) option,
NetBackup uses the scripts you selected with the s (Select Scripts) option and the e
(Edit/View Selected Scripts) option to restore Oracle databases. The other Restore DB
menus are the same, except for the menu choice that starts the restore.

Refer to the NetBackup System Administrator’s Guide for the specific database for more
information.

Common Screens

The content of these screens varies depending on whether you are doing a backup,
archive, or restore.

Backup or Archive Search Screen

During a backup or archive, the Search screen appears when you choose the s (Select Files
and Directories) option from the archive or backup menu. Use this screen to select
directories and files for archive or backup.

~i Console = iJ

window  Edit Options Help

Selections: 0 Current Path: foptfopenv/netbackup/

-B/optsopeny/nethackup/
.upgrade. to. 3,404
.upgrade.to.4.5
.upgrade.to.4.5
MediaMgr_DeviceConfig_cuide. txt
bins
bp. conf
catalog/
clients
db/
dbext/
axt/
helps
help.3.4G04/
help.4.5Predlpha/

Togs/
nbesa
release_notes. txt

dk,

sdks
Zoom{Iin (Z)oomOut {Sielect (Black (Flwd (UWp (DIn (Lleft (Riight (0Dk
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Selections Number of files or directories previously selected. This number changes as
you select or deselect files.

Current Path Current directory. This is the directory where currently displayed files and
directories reside and is the highest level directory that you can currently
show on the screen. Use Zoom(l)n or(Z)oomOut to move up or down in the
directory tree from the current directory.

File List The file list shows directories and files that are in the current directory. The
options at the bottom of the screen let you browse the directory tree and to
make selections (see “Search Screen Options” on page 148).

Q (not shown on screen) Type Q to exit without making any changes.

Restore Search Screen

During restores, the Search screen appears when you choose the s (Select Files and
Directories) option and NetBackup has completed its search for files and directories. Use
this screen to select files and directories to restore.

~i Console = iJ

window  Edit Options Help
Selections: 0 Current Path: foptfopenv/netbackup/
Backup Date
-»11/08/2001 14:10:26 Jopt/openv/nethackup/release_notes. txt
|
Zoom{Iin (Z)oomOut {Sielect (Black (Flwd (UWp (DIn (Lleft (Riight (0Dk "

The information fields on the top line have the same meanings as the Backup or Archive
Search screen. The list shows the contents of the current directory at the time that the
backup or archive occurred.

& For arestore archive, the list contains files and directories from user-directed archives.

& For arestore backup, the list contains files and directories from user-directed and
administrator scheduled backups.
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¢ For atrue image restore, the list contains only the directories from scheduled full and
incremental backups. Files do not appear, nor do the results of user-directed backups
or archives.

Type @ (not shown on screen) to exit without making any changes.

Search Screen Options

The options at the bottom of the Search screen let you browse the directory tree and make
selections. Remember that it usually takes longer to search the backups than the file
system (as is done during a backup or archive).

Execute an option by typing the letter in parentheses. For example, Z moves you up to the
parent of the current directory. Type Q (not shown on screen) to exit without making
changes. You can use either upper or lower case letters.

Zoom(l)n Moves you down one level in the tree to show the files and directories that are
in the directory to which the arrow symbol currently points.

(Z2)oomOut Moves you up one level in the tree to show the files and directories that are in
the parent of the current directory.

(S)elect Selects the directory or file indicated by the current position of the pointer and
adds an asterisk * to the left of the line. Pressing S again clears the item.

(B)ack Shows the previous screen of information.

(F)wd Shows the next screen of information.

(U)p Moves the pointer up one item in the list.

(D)n Moves the pointer down one item in the list.

(L)eft Shifts the display to the left, if you had previously shifted it to the right in
order to show lines that are too wide for the screen.

(R)ight Shifts the display to the right in order to show lines that are too wide for the
screen.

(O)k Retains your current selections and returns to the previous menu.
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Edit/View Selections Screen

The Edit/View Selections screen appears when you choose the e (Edit/View Selected
Files) option from a Backup, Archive, or Restore (other than true image) menu. This screen
shows the directories and files that you have selected for backup, archive, or restore
(depending on the operation you are performing).

~i Console = iJ
Help

window  Edit Options

Humber of Selections = 1

-B/opt/openy/nethackup/release_notes. txt

(A)dd Selection Un{Sielect (Cilear (Black ({Fwd (Uip (DIn (Lleft (R}ight (0Jk J

Note This screen is called View/Delete for true image backups and restores and lets you
delete, but not add, selections.

The top line on the screen shows the number of total selections. This number changes as
you select or deselect files.

Chapter 5, Reference Guide to xbp and bp 149 =



Menu Interface (bp)

The options at the bottom of the screen let you alter your selections. Select an option by
typing the letter in parentheses. You can use either upper or lower case letters. For
example, B shows the previous screen. Type Q (not shown on screen) to exit without
making any changes.

(A)dd Selection This option does not appear on the View/Delete screen for true image
restores. Lets you add a selection to the list. Choosing this option shows a
dialog box in which you type the pathname of the file or directory you are
adding. Pressing Enter adds the new selection to the list.

If you add a selection for a restore, bp uses the range of dates determined by
the current values of Start Date and End Date when searching for files. This
provides some added versatility when searching for backups. For example, if
you want to add a file that is outside the date range used for existing
selections, you can exit to the restore screen, change the date range, then
return to the Edit/View Selections screen and add the extra file.

You can also use wildcard characters *, ?, [, and ] to specify multiple files and

directories.

un(S)elect Unselects the directory or file to which the arrow symbol currently points and
deletes it from the list.

(C)lear Clears all previous selections.

(B)ack Shows the previous screen of information.

(Fywd Shows the next screen of information.

(8)]] Moves the pointer up one item in the list.

(D)n Moves the pointer down one item in the list.

(L)eft Shifts display to the left, if you had previously shifted it to the right in order to
show lines that are too wide for the screen.

(R)ight Shifts the display to the right in order to show lines that are too wide for the
screen.

(O)k Retains your current selections and returns you to the previous menu.

View/Delete Selections Screen

The View/Delete Selections screen appears when you choose e (View/Delete Selected
Files) from the Restore True Image Backups menu. This screen shows the directories you
have selected for the true image restore.
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This section contains additional information on the Backup, Archive, and Restore
interface for the NetBackup Administrator.

Redirecting Restores to Different Clients

There are two types of redirected restores: those that can be performed by the user, and
those that can be performed by the system administrator.

User-Directed

Users can restore files to their client that were backed up by another client. The
NetBackup Master server must be configured to allow a redirected restore to a different
client, and the user must have authorization to perform the restore.

Server-Directed

Any administrator on any NetBackup server can direct a restore to the client that backed
up the files. The administrator can also perform a redirected restore to a different
client—that is, files backed up from one NetBackup client can be restored to another
NetBackup client of the same type. Server-directed restores can be useful, for example, if
users do not have permission to restore the files themselves.

Files or raw partitions can be restored to any client of the same type that backed up the
files. It is not possible to perform a server-directed restore through a database-extension
product such as NetBackup for Oracle.
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Policy Type Settings

When redirecting from or to a different client, the source and destination clients must be
of same type. Refer to the Table “Policy Settings for Clients” below to select the

appropriate policy type.

Policy Settings for Clients

Client Policy
UNIX Standard
Macintosh Standard

Microsoft Windows 98 or 95 Standard
Microsoft Windows NT/2000 MS-Windows-NT
NetWare Target Standard

NetWare Non-Target NetWare

Restore Path Formats

When redirecting a restore to a different client, the appropriate path format must be used
when specifying the source and destination information. Refer to the Table “Restore Path
Formats” below.

Restore Path Formats

Client Path Format Example

UNIX (from a Normal /directory/ /usr/openv/netbackup/
Backup image)

UNIX (from a Backup Exec export_path\directory exported_path\netbackup

image) (where exported_path is defined in the
agent.cfg file)

Macintosh folder/folder/ NetBackup Admin/Configuration Files Dist/

Microsoft Windows (from a drive:\directory\ CA\VERITAS\NetBackup\
Normal Backup image)

Microsoft Windows (from a \NT_share_name\directory\ \C$\VERITAS\NetBackup
Backup Exec image)
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Restore Path Formats

Client Path Format Example

NetWare NonTarget /drive/directory/ /C/VERITAS/NetBackup/
NetWare Target /target/volume/data_path /MARGE/SYS/veritas/netbackup/
IBM OS/2 drive:\directory ¢:\veritas\netbackup

Redirecting a Restore from a Backup Exec Image

When restoring a group of files from both Backup Exec and NetBackup images,
redirection is not allowed. Redirecting a restore from a Backup Exec image must be done
separately. Within the Backup Exec image, files cannot be restored to different paths. All of
the files in the image must be redirected to the same path.

The following types of restores are allowed when redirecting a restore from a Backup Exec
image:

2

Redirecting a Restore to a Windows Client

Backups of a Windows, UNIX, or NetWare client can be restored to a Windows client
using the following redirection path:

\share name\dirl

For example, if you wanted to redirect a restore to C: \ temp, and the sharename for
the drive C: is C$, then the path should be specified as \C$\ temp.

Note When restoring a NetWare client backup to a Windows client, the NetBackup

Windows client interface (nbwin. exe), NetBackup Java interface, or the
bprestore command line command should be used. The NetBackup Windows
NetWare client (nbnwnt . exe) should NOT be used to restore NetWare client
backups to Windows clients.

Redirecting a Restore to a UNIX Client

Backups of a Windows, UNIX, or NetWare client can be restored to a UNIX client
using the following redirection path:

export path\dirl

where export path is defined in the agent . c£g file on the UNIX client. The
agent . cfg file is a Backup Exec configuration file for the Backup Exec UNIX client.
Files can be redirected and restored only to paths that have been exported in the
agent .cfgfile.
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For example, if the agent . cfg file on the UNIX client contains the following lines:

export/space/home as space home
export/homel as homel

To redirect to /space/home/dir1 the redirection path should be specified as
space_home/dirl. To redirect to /homel/dirl the redirection path should be
specified as homel/dirl/.

Note When restoring a NetWare client backup to a UNIX client, the NetBackup Windows

client interface (nbwin. exe) should be used. To restore a Backup Exec image to a
NetWare client, the NetWare client must also be a NetBackup NetWare client. Refer
to the NetBackup User’s Guide for Novell NetWare NonTarget for information on
restoring NetWare backups to NetWare clients.

Redirecting a Restore to a NetWare Client

When restoring a NetWare client backup to a NetWare client, the NetBackup
Windows NetWare client interface (nbnwnt . exe) should be used. To restore a
Backup Exec image to a NetWare client, the NetWare client must also be a NetBackup
NetWare client. Refer to the NetBackup User’s Guide for Novell NetWare NonTarget for
information on restoring NetWare backups to NetWare clients.

To redirect arestore to a different client

The following are general instructions for performing a server-directed restore to a client.

1.

2.

Log on as root to the UNIX master server that backed up the files.

Start the Backup, Archive, and Restore interface.

Click the Restore Files tab.

From the Actions menu, choose Specify NetBackup Machines.

Click on the NetBackup server tab.

Select the NetBackup master server that backed up the files and click Make Current.
This gives you access to the image catalog on that system so you can browse the

desired backups.

Click on the Source client/Policy type tab.
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a. Select the client that originally backed up the files and click Make Current. This
allows browsing and restoring files backed up from that client.

b. Select the policy type for the images that you are going to browse. Refer to the
table “Policy Settings for Clients” on page 152.

Note The Source and Destination client must always be of the same type.

Note The Destination Client tab is enabled only if the user is root or a non-root
administrator and the machine jbpSA is connected to is a server. jbpSA determines
this by checking the name of the machine jbpSa is connected to against the server
list.

8. Click on the Destination Client tab.

9. Select the client to which to redirect the files.
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The following example screen shows a restore of files that were backed up to hagar
(NetBackup server) from windows (source client) and are now being restored to a
client named folip (destination client). Both clients are standard.

ﬂNetBackup Administration Console [logged into hagar] ;|g|5|
VERITAS NetBackup~ [FH s
File Edit “iew Actions Help |
g & = ‘
N MetBackup server: Source client: Folicy type: Destination client: ﬂ
hagar windows Standard folip
Backup Files] Restore FHESW Task Progress]
Restare Type:
INormaI Backups ll
:ai?zgrcdkupgrase. @ 5231?1?23;3215:58:05 E;ﬂﬁ;tﬂeﬂéﬁ:ﬁa:% g

Browse directany: jFiIename filter: .
Ihomeeblaufus/ I Fir 'ﬁ,l | @l
Directory Structure Contents of selected directory

Mame | Backup Date | Size | Modified |

Ereview | B Resiore, |

10. On the Actions menu, point to Select Restore Type and choose the desired restore
type, or select a type from the Restore Type list box.

11. To refresh the list of items available for restore, click Refresh on the View menu.

12. Select the files or folders you want to restore.

Note The Browse directory box is unavailable when browsing Windows, Lotus Notes, or
MS Exchange clients.

13. Click Restore.
The Restore Marked Files dialog box appears.

14. Select the desired Destination to which to restore the files.
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Redirecting Restores to Different Clients

For more information on redirecting restores to different paths, see “Redirecting Files
to a Different Path” on page 36.

The paths in the Source and Destination boxes must use the formats required by the
clients as shown in the table “Restore Path Formats” on page 152.

15. Select the desired restore Options.

16. To begin the restore, click Start Restore.

Preventing Server-Directed Restores

To prevent server-directed restores, either add or delete settings on the client as shown in
the following table:

Settings to Prevent Server-Directed Restores

Client Type

Location of Setting

To Prevent Server-
Directed Restores

Microsoft Windows

UNIX

Macintosh

NetWare
(Target and Non-Target)

General tab in NetBackup Client Properties dialog box on
the client (click NetBackup Client Properties on the Files
menu to display this dialog box)

/usr/openv/netbackup/bin/bp.conf

/NetBackup Admin/Configuration Files
Dist/bp.conft

Clear Allow server
directed restores box

Add
DISALLOW_SERVER
FILE_WRITES

Add
DISALLOW_ SERVER
FILE WRITES

General tab in NetBackup Configuration dialog box on the Clear Allow server
client (click Configure on the Actions menu to display this directed restores box

dialog box)
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Restoring AFS Backups

Restoring AFS Backups

Note AFS does not apply to BusinesServer.

This section notes the differences in the interface that the user will encounter when
restoring backups from an AFS client.

All restores must be performed by the administrator either on the NetBackup for AFS
client or the master server. The administrator can use the Backup, Archive, and Restore
interface on the master server to restore volumes to the same or to redirect the restore to a
different NetBackup for AFS client (AFS file server).

Restores are performed on the basis of volumes. To restore a vice partition, the
administrator must select all the volumes in that partition.

Browsing and Marking Volumes/Vice Partitions

When browsing for AFS backups, you cannot use the Browse directory field to enter a
specific path. Instead, select the vice partition you wish to view in the Directory Structure
pane and its contents will be displayed in the right pane.

Note The full path is not displayed in the Directory Structure pane. For example,
/vicepa/user.abc is displayed instead of /AFS/eagle/vicepa/user.abc.

Restoring to Different Volumes/Vice Partitions

The Backup, Archive, and Restore interface provides a convenient mechanism for
specifying a different name for a volume and/or vice partition. Specifying a different
volume name prevents an existing volume from being overwritten by the restore.

¢ Ifyou do not specify Overwrite existing files or a different name for the volume, then
NetBackup adds an “R” to the name of the restored volume as follows:

¢ If the volume name is less than 22 characters long, NetBackup adds a leading “R”
to the name of the restored volume. For example:

If the volume name is: /vicepa/user.abc
The restored name is: /vicepa/Ruser.abc

& If the volume name is 22 characters long (maximum allowable length for a
volume name), the first character of the original volume name is replaced with an
R. For example:

If the volume name is: /vicepa/engineering.documentsl
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Restoring Raw Partitions

2

The restored name is: /vicepa/Rngineering.documentsl

If you are redirecting the restore to a different path and specify an existing volume,
you must select the Overwrite existing files option for the restore to succeed. In this
case, the entire volume is overwritten. If you do not select the Overwrite existing
files option, the restore will fail.

When redirecting a restore of a volume to a different vice partition, the vice partition
must exist or the restore will fail.

Restoring Raw Partitions

A raw partition restore will restore a bit-by-bit backup of a partition of a disk drive on
UNIX (on Windows thisis called a disk-image backup). In order to restore a raw partition, you
must have administrator capabilities on the master server or UNIX client. For further
information on restoring FlashBackup raw partitions, refer to the NetBackup FlashBackup
System Administrator’s Guide.

Note FlashBackup does not apply to BusinesServer.

Notes on Raw Partitions

4

Ensure that the partition is not mounted and not in use (if the partition is being used
by a database, make sure to shut down the database). The partition must be the same
size as when it was backed up. Otherwise, the results of the restore are unpredictable.

Ensure that the device file for the raw partition exists prior to the restore.

The overwrite option is ignored during raw partition restores (except for Windows
disk image restores). The device file must exist and the disk partition is overwritten
whether this option is set or not.

When restoring a Windows disk image, the Overwrite existing files option must be
selected in the Restore Files dialog.

If you performed a raw partition backup of a disk partition used for file systems, you
must restore the entire partition to recover a single file. To avoid overwriting the
entire partition, redirect the restore to a different path, restoring the raw partition to
another raw partition of the same size, and then copy individual files to the original
file system.
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Restoring Raw Partitions

V¥ To restore an entire raw partition

v

Note An entire raw partition can only be restored from a full backup. (NetBackup does

not distinguish between full and incremental backups when performing a standard
raw partition backup.)

8.

9.

Log on as root to the UNIX master server that backed up the files.
Start the Backup, Archive, and Restore interface.

Click on the Restore Files tab.

Select the Policy type.

a. From the Actions menu, choose Specify NetBackup Machines.
b. Click the Source Clients tab.

c. Select the Policy type. For most clients this is “Standard.”

d. Click OK.

From the Actions menu, point to Select Restore Type and choose Raw Partition
Backups.

In the Browse directory box specify the directory path to the device file, for example,
/dev/rdsk/.

Click the Refresh button to refresh the list of raw partition backups available for
restore.

In the right pane, select the device file.

To begin the restore operation, click Restore.

To restore individual directories or files

Note In order to restore individual directories or files from a raw partition backup, the

client must be in a FlashBackup or Auspex-FastBackup policy and the server must be
configured to allow for individual file restores from raw partition backups.

1.

2.

Log on as root to the UNIX master server that backed up the files.

Start the Backup, Archive, and Restore interface.
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Restoring Raw Partitions

8.

9.

Click on the Restore Files tab.

Select the Policy type.

a. From the Actions menu, choose Specify NetBackup Machines.

b. Click the Source Clients tab.

c. Select the Policy type. For most clients this is “Standard.”

d. Click OK.

On the Actions menu, point to Select Restore Type and choose Normal Backups.
In the Browse directory specify the directory path to the device file.

Click the Refresh button to refresh the list of raw partition backups available for
restore.

In the right pane, select the desired files or folders.

To begin the restore operation, click Restore.

V¥ To restore a Windows NT or Windows 2000 disk-image backup

1.

2.

Click on the Restore Files tab.

Select the Policy type.

a. From the Actions menu, choose Specify NetBackup Machines.

b. Click the Source Clients tab.

c. From the Policy type list, choose MS-Windows-NT.

d. Click OK.

From the Actions menu, point to Select Restore Type and choose Normal Backups.
Click Refresh to refresh the list of items available for restore.

In the right pane, select the disk image, for example, \\ . \c:.

To begin the restore operation, click Restore.
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Previewing Required Media

7. Inthe Restore Files dialog, be sure to select Overwrite existing files.

Previewing Required Media

The Preview Media Required option allows you view a list of the media IDs which were
used to backup or archive the selected files and directories. This feature is only available if
your client is also a NetBackup server and if you have administrator capabilities.

1. Click the Restore Files tab.

2. Select the files and folders that you want to restore.

3. Click Preview.

4. To begin the restore operation, click Restore.
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Glossary

access control list (ACL)

Security information associated with files on some file systems.

ACS
Automated Cartridge System. ACS can refer to any of the following:

& A type of Media Manager robotic control. This robot type is supported only by
NetBackup DataCenter servers.

& The StorageTek (STK) system for robotic control.

¢ The highest-level component under STK’s ACS library software, which refers to a
specific standalone robotic library or to multiple libraries connected with a media
passthru mechanism.

active job

A job for which NetBackup is currently processing backup or restore data.

activity logs

See “debug logs.”

activity monitor
A NetBackup administration utility that displays information about NetBackup jobs and
provides limited control over them.

administration client

See “remote administration console.”

administrator

A user that is granted special privileges to install, configure, and manage the operation of
a system, network, or application
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AIT
Sony Advanced Intelligent Tape, a type of tape drive or media type.

alternate-client restore

See “redirected restore (different client).”

alternate-target restore

See “redirected restore (different target).”

alternate path restore

See “redirected restore (different path).”

alternate read server

A server used to read a backup image which was originally written by a different media
server. The media server specified as Alternate Read Server must have access to the media
containing the backup image or images it is configured to read.

archive
A special kind of backup where NetBackup backs up the selected files, and if the backup
is successful, deletes the files from the local disk. In this manual, references to backups
also apply to the backup portion of archive operations except where otherwise noted.
archive bit

A file-status bit that the Microsoft based operating system sets when it writes a file,
thereby indicating that the file has changed.

attributes for a policy
Configuration parameters that control the behavior of NetBackup during operations
involving this policy.

autochanger

See “robotic library.”

autoloader

See “robotic library.”

automatic backup

A scheduled backup by the master server.
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back up

The act of copying and saving files and folders to storage media.

backup

Refers to the process of copying and saving files and directories to storage media. For
example, the backup is complete. This term can also refer to the collection of data that
NetBackup saves for a client during a backup or archive. For example, duplicate the backup.

Backup is two words when used as a verb. For example, back up the file.

backup, archive, and restore interface

The name of the NetBackup Microsoft Windows and Java based user interfaces for clients.
On servers, these interfaces can be started through the NetBackup Administration
Console.

backup window

The period of time during which backups can begin.

block size

The number of bytes in each block of data written on the media during a backup.

bp
A backup, archive, and restore utility for users on NetBackup UNIX clients. It has a
character-based, menu interface that can be run from terminals that do not have X
Windows capabilities.
bpadm
An administrator utility that runs on NetBackup UNIX servers. It has a character-based,
menu interface that can be run from terminals that do not have X Windows capabilities.
bp.conf file
A NetBackup configuration file on UNIX servers and also on UNIX, Macintosh, and OS/2
clients.
bp.ini file
NetBackup initialization file for Novell NetWare target clients.
bpcd
NetBackup Client service on Windows and the NetBackup Client daemon on UNIX.
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bprd

NetBackup Request Manager service on Windows and NetBackup Request daemon on
UNIX.

cancel a job

Terminating a job and removing it from the job queue.

carousel
See “robotic library.”

catalogs
Internal NetBackup and Media Manager databases. These catalogs contain information
about configuration, media, devices, status, errors, and the files and directories in the
stored backup images.

CDF
Context-dependent file, which is a type of directory structure on a Hewlett-Packard
system.

changer
See “robotic library.”

class
See “policy.”

client

The system with the files to back up, archive, or restore.

client-user interface

See “user interface.”

cluster

See master and media server cluster.

command lines

Commands that users can execute either from the system prompt or in scripts.

compression

The process of compacting data to enable more efficient transmission and storage.
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configuration

The parameters that govern the behavior of an application. This term can also refer to the
manner in which a network or system is laid out or connected (for example, a network
configuration).

consolidated eject

A process of ejecting media for more than one Vault session at a time. A Consolidated
Eject can be performed for one or more logical vaults at one time.

consolidated report

cpio

ctime

A process of generating reports for more than one Vault session at a time. A Consolidated
Report can be performed for one or more logical vaults at one time. Consolidated reports
are organized by report title, not by vault.

A UNIX command that can be used for copying files to or from a cpio archive on disk or
tape.

The time that a UNIX inode was changed.

cumulative-incremental backup

daemon

A backup that is scheduled by the administrator on the master server and backs up files
that have changed since the last successful full backup. All files are backed up if no prior
backup has been done. Also see “differential-incremental backup.”

A program on a UNIX system that runs in the background and performs some task (for
example, starting other programs when they are needed). Daemons are generally referred
to as services or processes on Windows server systems.

database-agent clients

Clients with additional NetBackup software that is designed to back up relational
databases.

database-extension clients

See “database-agent clients.”
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debug logs
Logs that can be optionally enabled for specific NetBackup and Media Manager programs
and processes and then used to investigate problems.

destination storage unit
A storage unit to which Vault sends the data from a duplication operation. If the
duplicated backup images are to be vaulted, then the destination storage unit must
correspond to the robotic volume group.

device delays
Delays caused by the device that are beyond the control of the storage application. An
example is the time required to position tape under the read and write heads.

device host
A host (that has Media Manager installed) where a drive or robotic control is attached or is
defined.

device monitor

A Media Manager administration utility that provides monitoring and manual control of
Media Manager storage devices. For example, an administrator or computer room
operator can use this utility to manually reset devices or set them to the UP or DOWN
state.

DHCP
Dynamic host configuration protocol. This TCP/IP protocol automatically assigns
temporary IP addresses to hosts when they connect to the network.

differential-incremental backup

Scheduled by the administrator on the master server and backs up files that have changed
since the last successful incremental or full backup. All files are backed up if no prior
backup has been done. Also see “cumulative-incremental backup.”

directory depth
The number of levels below the current directory level that the NetBackup interfaces
show in their directory and file list displays.

directory tree

The hierarchical structure in which files are organized on a disk. Each directory lists the
files and directories that are directly below it in the tree. On UNIX, the topmost directory
is called the root directory.
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disaster recovery

Recovering data from backups after a disk crash or other catastrophe.
disk
Magnetic or optical disk storage media.
disk-image backup
A bit-by-bit rather than a file system backup of a disk drive on a Windows platform.

DLT

Digital-linear tape or tape drive type.

Domain Name Service (DNS)

A program that handles name translation for network communications.

drive cleaning

The use of a special cleaning tape to clean the heads on a drive.
duplicate image

A copy of a backup image.
eject

Move media out of a robotic library.

encryption

Provides additional security by encrypting backup data on the client. This capability is
available only with the NetBackup Encryption option.

entry and exit ports

See “media access port.”

exclude list
A list that designates files or directories to exclude from automatic backups.
expiration (image)

The date and time when NetBackup stops tracking a backup image.
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expiration (volume)

The date and time when the physical media (tape) is considered to be no longer usable.

external media ID

This is an identifier written on a media cartridge or canister to help the operator identify
the volume before inserting it into a drive or robot. For labeled media, the external media
ID should be the same as the media ID recorded on the media.

EVSN

See “external media ID.”

FlashBackup
A special type of raw-partition backup that requires the NetBackup FlashBackup
separately-priced option (this option is available only for NetBackup DataCenter).

flush level
Controls how often Netbackup clears its log files on a Novell NetWare or Microsoft
Windowvs client platform.

fragment
A part of a backup or archive image. NetBackup can be configured to divide images into
fragments when they exceed a certain size or span tapes.

frequency (backup)
How often NetBackup performs scheduled backups. For example, if the frequency is
seven days then backups occur once a week.

FROZEN media state
If a volume is FROZEN, NetBackup keeps it indefinitely and can restore from it but not
use it for further backups or archives.

full backup
A backup that copies, to a storage unit, all files and directories that are beneath a specified
directory.

FULL media state

If this appears in a report or listing, it indicates the volume is FULL and cannot hold more
data or be used for further backups.
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global attributes

NetBackup configuration attributes that affect all policies.

GDM Dashboard
The name for the Global Data Manager interface. The Dashboard enables monitoring job
and drive activity on multiple master servers, as well as providing alerts to problem
conditions.

GDM Managed Server
A NetBackup master server that appears as a managed master server in the left pane of
the GDM Dashboard.

GDM Server

A NetBackup master server that has the Global Data Manager license activated. When
logging into this host, the user can monitor the activity on multiple master servers using
the GDM Dashboard interface. If the host has installed the Advanced Reporter option, the
reports show information on multiple master servers.

Global Data Manager (GDM)

A separately-priced option (for UNIX servers) that provides an interface with a tree view
where the administrator can view and administer multiple master servers. The server
where the option is installed is called a GDM Server.

Global Device Database

A single host that serves as the repository for global device configuration information.
When you install NetBackup, by default the master server is configured as the global
device database host.

GNU tar

A public domain version of the UNIX tar program.

goodies directory

A directory containing programs, scripts, and other files that are not formally supported.

GUI
Graphical user interface.
e
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hard link

heap level

On UNIX, a hard link is a pointer to the inode for the data. On a Windows server, a hard
link is a directory entry for a file. Every file can be considered to have at least one hard
link. On NTFS volumes each file can have multiple hard links, and a single file can appear
in many directories (or even in the same directory with different names).

A parameter for memory-heap debugging on a Novell NetWare or Windows NetBackup
client.

hierarchical storage management

host

host name

HSM

image

import

include list

The process of automatically migrating selected files from a managed file system to
specified migration levels on secondary storage, while maintaining transparent access to
those files.

A computer that executes application programs.

Name by which a host computer is identified by programs and other computers in the
network.

See storage migrator.

The collection of data that NetBackup saves for an individual client during each backup or
archive. The image contains all the files, directories, and catalog information associated
with the backup or archive.

The process of recreating NetBackup records of images so the images can be restored.

A list that designates files or directories to add back in from the exclude list.

incremental backup

See “cumulative-incremental backup” and “differential-incremental backup.”
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inject

Move media into a robotic library.

inport
See “media access port.”
inode
A UNIX data structure that defines the existence of a single file.
install_path
Directory where NetBackup and Media Manager software is installed. The default on
Windows servers is C: \Program Files\VERITAS and on UNIX itis /usr/openvw.
jbpSA
The Java-based NetBackup interface for performing user backups, archives, and restores.
jnbSA
The Java-based NetBackup interface for administrators.
job
A parcel of work submitted to a computer. NetBackup jobs are backups, archives, or
restores.
kernel

The nucleus of an operating system.

keyword phrase

A textual description of a backup.

kill a job
See “cancel a job.”

label
Identifier of a tape or optical disk volume. A recorded label includes a media ID.
A barcode label allows a barcode scanner to be used for media tracking.

library

See “robotic library.”
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link

See “hard link” or “symbolic link.”

LMF - Library Management Facility

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

load
(noun) Amount of work that is being performed by a system or the level of traffic on a
network. For example, network load affects performance.
(verb) Copy data to internal memory. For example, load the installation program.
(verb) Used to indicate tape drive initialization done when new media is being added.
logs
Files where a computer or application records information about its activities.
mailslot
See “media access port.”
man pages

Online documentation provided with UNIX computer systems and applications.

Master and media server cluster

A NetBackup master server and the remote media servers that it is using for additional
storage. It is possible to configure clusters only with NetBackup DataCenter servers.
NetBackup BusinesServer supports only a single server, the master.

Master of Masters

A NetBackup host where Global Data Manager software is installed. When logging into
this host, the interface has a tree view where the administrator can view and administer
multiple master servers.

master server

The NetBackup server that provides administration and control for backups and restores
for all clients and servers in a master and media server cluster. NetBackup BusinesServer
supports only a single server and it is the master.
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media

Physical magnetic tapes, optical disks, or magnetic disks where data are stored.

media access port

A slot or other opening in a robot where you can insert or remove a tape without having
to access the interior of the robot. After inserting a tape, you move it to a slot by using an
inject command. Prior to removing a tape, you move it to the port by using an eject
command. The inject and eject commands are supported through the add and move
screens in the Media Manager administration interface.

media host

NetBackup server to which the job (client) is sending the data.

media ID

An identifier that is written on a volume as part of the recorded label.

Media Manager
Software that is part of NetBackup and manages the storage devices and removable
media.

Media Manager Host

Host where Media Manager is installed (may have devices attached)

media server

A NetBackup server that provides storage within a master and media server cluster. The
master can also be a media server. A media server that is not the master is called a remote
media server. NetBackup BusinesServer does not support remote media servers.

menu interface

A character-based interface for use on terminals that do not have graphical capabilities.

mount

Make a volume available for reading or writing.

mount point

The point where a file system on a disk logically connects to a system’s directory structure
so the file system is available to users and applications.
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MPX

See “multiplexing.”

mtime

The point in time when a UNIX or NTFS file is modified.

multiplexing
The process of sending concurrent-multiple backups from one or more clients to a single
storage device and interleaving those images onto the media.

multiplexed group

A set of backups that were multiplexed together in a single multiplexing session.

NDMP
Network data management protocol. NetBackup requires the NetBackup for NDMP
separately-priced option to support NDMP.

NetBackup Client service

NetBackup Windows service that runs on clients and servers and listens for connections
from NetBackup servers and clients in the network. When a connection is made, this
service starts the necessary programs.

NetBackup configuration options

On UNIX servers and on UNIX and Macintosh, clients, these settings are made in the

bp . conf file. On NetWare target and OS/2 clients, they are in the bp . ini file. On
Windows servers and Windows clients, these settings are called properties and are made
through the Backup, Archive, and Restore interface or the Host Properties dialog in the
NetBackup Administration Console.

NetBackup databases

See catalogs.

NetBackup Database Manager service

NetBackup Windows service that runs on the master server and manages the NetBackup
internal databases (called catalogs). This service must be running on the master server
during all NetBackup administrative operations.
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NetBackup Device Manager service
The NetBackup Windows service that runs on a NetBackup server and starts the robotic
control processes and controls the reservation and assignment of volumes. This service
runs only if the server has devices under Media Manager control. The process is 1tid.

NetBackup properties
Same as NetBackup configuration options but are called NetBackup properties on
Microsoft Windows platforms.

NetBackup Request Manager service
The NetBackup Windows service that runs on the master server and starts the scheduler
and receives requests from clients.

NetBackup Volume Manager service

A NetBackup Windows service that runs on a NetBackup server, allows remote
administration of Media Manager, and manages volume information. The process is vmd.

NIS

Network information service.
NLM

NetWare loadable module.
NFS

Network file system.
nonrobotic

See “standalone.”
ODL

Optical disk library. This robot type is supported only by NetBackup DataCenter servers.

offsite volume group

A volume group in which media will appear after having been ejected from the robot for
vaulting. When Vault ejects media it is moved from the robotic volume group to the
off-site volume group.
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offsite volume pool

A volume pool that contains media that is to be ejected and vaulted. Backup images
written to an off-site volume pool by an original NetBackup backup policy or by Vault’s
duplication feature will be ejected and vaulted. More than one off-site volume pool can be
specified for the Eject step of a Vault profile.

original backup

outport

partitions

patch

path length

pathname

PC clients

peername

policy

A backup image created by a backup job. A single backup image or all backup images
created by an Inline Tape Copy (multiple copy) configuration are considered original
backups. A backup image created by a duplication job is not an original backup.

See “media access port.”

The logical partitions into which a magnetic disk is divided.

A program that corrects a problem or adds a feature to an existing release of software.

Number of characters in a pathname.

The list of directories in the path to a destination directory or file.

NetBackup clients that have Microsoft Windows, Macintosh, or IBM OS/2 operating
systems.

The name by which a computer identifies itself when establishing connections to other
systems.

Defines the backup characteristics for a group of one or more clients that have similar
backup requirements.
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port
A location used for transferring data in or out of a computer.

Also see “media access port.”

primary copy
The copy of an image that NetBackup uses to satisfy restores. When NetBackup duplicates
an image, the original is designated as the primary copy.

privileges

The tasks or functions that a user, system, or application is authorized to perform.

profile

A vault profile is a way to save configuration settings. Specific parameters for duplication,
catalog backup, eject, and report or any combination of these steps, are configured within
a profile.

progress report

Log where NetBackup records events that occur during user operations.

proxy restore

A proxy restore allows the user to restore files that he has write access to, on a machine
other than his desktop. The files must be in a backup of the machine to which they are
being restored.

QIC

Quarter-inch-cartridge tape.

gueued job

A job that has been added to the list of jobs to be performed.

raw-partition backup
Bit-by-bit backup of a partition of a disk drive on UNIX. On Windows, this is called a
disk-image backup.

rbak

The program that Apollo clients use to read data from tape during a restore.
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recorded media ID

This is an identifier written as part of the label on a volume and used by Media Manager
to ensure that the correct volume is mounted. The recorded media ID should match the
external media ID.

redirected restore (different client)

Restoring files to your client when they were originally backed up from a different client.
The administrator using the interface on the master server can direct a restore to any client
(this variation is called a server directed restore).

redirected restore (different target)

On a Novell NetWare server platform running the NetBackup target version of client
software, this operation restores files to a different target than the one from which they
were backed up.

redirected restore (different path)

Restores files to a different directory than the one from which they were backed up.

registry

A Microsoft Windows database that has configuration information about hardware and
user accounts.

remote administration console
A Windows NetBackup client that has the administration interface software installed and
can be used to administer NetBackup servers.

remote media server
A media server that is not the master. Note that only NetBackup DataCenter supports
remote media servers. NetBackup BusinesServer supports only a single server, the master.

residence

In Media Manager, information about the location of each volume is stored in a volume
database. This residence entry contains information, such as robot number, robot host,
robot type, and media type.

resource

A Novell NetWare term that refers to a data set on the target. For example, in DOS,
resources are drives, directories, and files. Also see “target service.”
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restore

(verb) The act of restoring selected files and directories from a previous backup or archive
and returning them to their original directory locations (or to a different directory).

(noun) The process of restoring selected files and directories from a previous backup and
returning them to their original directory locations (or to a different directory).

retention level
An index number that corresponds to a user-defined retention period. There are 10 levels
from which to choose (0 though 9) and the retention period associated with each is
configurable. Also see “retention period.”

retention period
The length of time that NetBackup keeps backup and archive images. The retention
period is specified on the schedule.

robotic arm

The component of a robotic library that physically selects the media (tape or optical disk).

robotic library

Refers to a robot and its accompanying software. A robotic library includes a collection of
tapes or optical platters used for data storage and retrieval. For example, a Tape Library
DLT (TLD) refers to a robot that has TLD robotic control.

robotic volume group

A volume group from which media will be ejected and vaulted. When Vault duplicates
backups, they are duplicated to media in the robotic volume group.

root
The highest level directory in a hierarchical directory structure. In MS-DOS, the root
directory on a drive is designated by a backslash (for example, the root on drive C is C:\).
On UNIX;, the root directory is designated by a slash (/).
Also, a UNIX user name having administration capability.

RS-232
An industry-standard interface for serial communications and sometimes used for
communicating with storage peripherals.
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RSM Interface

Application in Windows 2000 used to manage Removable Storage Manager (RSM)
devices.

RSM - Removable Storage Manager

RVSN

schedules

SCSI

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

Also, a component of the Windows 2000 operating system that manages storage devices.

See “recorded media ID.”

Controls when backups can occur in addition to other aspects of the backup, such as: the
type of backup (full, incremental) and how long NetBackup retains the image.

Small computer system interface. This is a type of parallel interface that is frequently used
for communicating with storage peripherals.

server-directed restore

Using the user interface on the master server to restore files to any client. Only the
administrator can perform this operation.

server independent restore

server list

service

Restoring files by using a NetBackup server other than the one that was used to write the
backup. This feature is available only with NetBackup DataCenter.

The list of servers that a NetBackup client or server refers to when establishing or
verifying connections to NetBackup servers. On a Windows server and Microsoft
Windows clients, you update the list through a dialog box in the interface. On a UNIX
server and UNIX and Macintosh clients, the list is in the bp . conf file. On NetWare target
and OS/2 clients, the list is in the bp . ini file.

A program on a Windows server system that runs in the background and performs some
task (for example, starting other programs when they are needed). Services are generally
referred to as daemons on UNIX systems.
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session

An instance of NetBackup checking its schedules for backups that are due, adding them to
its worklist, and attempting to complete all jobs in the worklist. For user backups and
archives, a session usually consists of a single backup or archive.

Session (Vault)

A vault session consists of executing a particular profile or profiles.

shared drives

See “Shared Storage Option (SSO).”

Shared Storage Option (SSO)

A separately priced VERITAS software option that allows tape drives (standalone or in a
robotic library) to be dynamically shared among multiple NetBackup and Storage
Migrator servers.

This option is supported only on NetBackup DataCenter servers.

SMDR
Storage management data requestor, a Novell NetWare program that provides its services
transparently to all SMS modules and lets remote and local modules communicate with
one another.

SMS

Novell NetWare storage management services.

source volume group

A volume group from which Vault can select backups to duplicate. This parameter is used
to restrict the list of backups from all backups that reside on media in any volume group
to backups that reside on media in a single volume group. Where a volume group
corresponds to a particular robot, the profile will duplicate only backups on media in that
robot. The Source Volume Group is normally only specified if you have multiple robots
attached to the same server, for example you want to duplicate backups that reside in
robot 0 to media that reside in robot 1.

SSO

See “Shared Storage Option (SSO).”
stacker

Usually a small robotic library that contains one drive only. See “robotic library.”
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standalone

A qualifier used with drives and media to indicate they are not associated with a robot.
For example, a standalone tape drive is one where you must manually find and insert
tapes before using them. A standalone volume is one that is located in a standalone drive
or is stored outside of a drive and designated as standalone in the volume configuration.
status code
A numerical code, usually accompanied by a troubleshooting message, that indicates the
outcome of an operation.
storage migrator

Refers to the VERITAS Storage Migrator line of hierarchical storage management products
for UNIX and Windows. These products make extra room on a disk by transparently
moving data to other storage and then transparently retrieving the data when it is needed
by a user or application.

Storage Migrator is available only for NetBackup DataCenter servers.

storage unit

Refers to a storage device where NetBackup or Storage Migrator stores files. It can be a set
of drives in a robot or consist of one or more single tape drives that connect to the same
host.

SUSPENDED media state

If a volume is SUSPENDED, NetBackup can restore from it but cannot use it for backups.
NetBackup retains a record of the media ID until the last backup image on the volume
expires.

symbolic link

On a UNIX system, this is a pointer to the name of the file that has the source data.

TapeAlert

Allows reactive cleaning for most drive types and is a function of the tape drive.

tape format

The format that an application uses to write data on a tape.

tape marks

A mark that is recorded between backup images on a tape.
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tape overhead
The space required for data that is not part of the backup images. For example, tape marks
and catalogs of what are on the tape are considered overhead.

tape spanning

Using more than one tape to store a single backup image.

tar

Tape Archive program that NetBackup uses to extract backup images during a restore.

target

See “target service.”

target service
A Novell NetWare service that needs storage management. The SMS views all services
(for example, print services, communication services, workstations) as targets.

Target Service Agent
A Target-service agent is a Novell NetWare agent that prepares the target's data for SMS
during a backup and for the target during a restore.

TLD - Tape Library DLT
A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

TLH - Tape Library Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

TLM - Tape Library Multimedia

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

TL4 - Tape Library 4AMM

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.
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TL8 - Tape Library 8MM
A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

timeout period

The period of time that an application has allotted for an event to occur.

TIR

See “true image restore.”

tpconfig

A Media Manager administration utility for configuring devices which is started from the
command line. On UNIX; it has a character-based menu interface that can be run from
terminals that do not have X Windows capabilities. tpconfig also has a command line
interface.

transfer rate

The rate at which computer information is transferred between a source and a destination.

transport

See “robotic arm.”

true image restore

Restores the contents of a directory to what it was at the time of any scheduled full or
incremental backup. Previously deleted files are ignored.

TS8 - Tape Stacker 8MM

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

TSA

See “Target Service Agent.”

TSD - Tape Stacker DLT

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.
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TSH - Tape Stacker Half-inch

A Media Manager designation for a category of robot. For the specific vendor types and
models in this category, see the VERITAS support web site.

This robot type is supported only by NetBackup DataCenter servers.

unassigned media

Media that contain no valid images. A piece of unassigned media has an entry in the
volumes database but no entries in the images database. Unassigned Media do not have a
“time assigned” in the Media section of the GUI.

user interface

The program used to perform user backups, archives, and restores.

user operation

A backup, archive, or restore that is started by a person on a client system.

Vault

Vault is a separately-priced NetBackup option that provides offsite backup management.
Vault automatically duplicates specified backup images, and automates the process of
offsite media rotation (a critical component of any backup or disaster recovery strategy).
Vault manages offsite storage and retrieval of media for original backups, duplicate
backups, and catalog backups. Additionally, NetBackup Vault generates reports to track
the location and content of each piece of media.

vault

In the context of the NetBackup Vault, a vault is logical entity associated with a particular
robot that acts as a designated holding place for backups that will eventually be sent to a
physical offsite vault. The term ‘vault’ is used to refer both to the process, and to the
physical storage location of a set of tapes offsite.

vault process

Vaulting is the process of choosing backup images to duplicate or eject, optionally
duplicating backups, ejecting duplicate or original media, storing it at an offsite location,
and later returning expired media to your robot. Vaulting is an integral part of the disaster
recovery process.

verbose flag

Configuration file entry that causes a higher level of detail to be written in the logs.
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verify

An operation that compares the list of files that are actually on a volume with what
NetBackup has recorded as being on it. The data that is on the media is not verified.

vmadm
A Media Manager administrator utility for managing volumes. It runs on UNIX and has a
character-based, menu interface that can be run from terminals.
vm.conf
A Media Manager configuration file with entries that include the servers that can manage
local devices and default media ID prefixes for media that do not contain barcodes.
volume

Media Manager volumes are logical units of data storage or cleaning capability on media
that have been assigned media IDs and other attributes, which are recorded in the Media
Manager volume database.

volume configuration

Refers to configuration information that is stored in the Media Manager volume database.

volume database

An internal database where Media Manager keeps information about volumes. All hosts
(where Media Manager is installed) have a volume database. However, the database is
empty unless the host is designated as a volume database host.

volume database host

The host (where Media Manager is installed) that contains information about the volumes
that Media Manager uses in a device. Because NetBackup BusinesServer supports only a
single server, the volume database host is always on the same server.

volume group
A set of volumes that are configured within Media Manager to reside at the same physical
location (for example, in a specific robot).

volume pool
A set of volumes that are configured within Media Manager to be used by a single
application and are protected from access by other applications and users.

wakeup interval

The time interval at which NetBackup checks for backups that are due.
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wildcard characters

A character that can be used to represent other characters in searches.

Microsoft Windows
(noun) Describes a line of operating systems developed by Microsoft, Inc.
For more information on the Windows operating systems that NetBackup supports, refer
to the VERITAS support web site at http: //www. support .veritas.com.
Windows
(adjective) Used to describe a specific product or clarify a term. Some examples are:
Windows 95, Windows 98, Windows NT, Windows 2000, Windows servers, Windows
clients, Windows platforms, Windows hosts, and Windows GUI.
Windows servers
A term that defines the Windows server platforms that NetBackup supports; those
platforms are: Windows NT and 2000.
Windows clients
A term that defines the Windows client platforms that NetBackup supports; those
platforms are: Windows 95, 98, ME, NT, 2000, XP (for 32- and 64-bit versions), and LE.
Windows Display Console

A NetBackup-Java interface program that runs on Windows 2000, NT, 98, and 95
computers. Users can start this interface on their local system, connect to a UNIX system
that has the NetBackup-Java software installed, and then perform any user operations
that their permissions allow.

WORM media

Write-once, read-many media for optical disks. NetBackup BusinesServer does not
support WORM media.

xbp
The X Windows-based backup, archive, and restore program for users on NetBackup
UNIX clients.
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Administrator
configure
automatic backups 4
backup and archive windows 4
browse default 117
browse permissions 127
class name 121
destination client 142, 143
source client 143
directed restores 5
exclude and include lists 5
permission to browse other clients 3
questions to ask the administrator 6
scheduled backup 147
server-directed restores 143
AFS backups
restoring in jopSA 158
Agent
definition 1
Alternate client restores
See Redirected restores
Alternate path restore
See Redirected restores
Alternate target restore
See Redirected restores
altnames file 127
Archives
bp
Archive of files and directories 137
initating 137
of selected files/directories 137
procedure 48
progress log 74
restoring 144
search screen 146
jbpSA
procedure 21

restoring 25
symbolic links 6
UNIX write permissions required 7
xbp
bplist 101
browse all backups 111
browse for restore 109
browse recent 112
listing 89
procedure 78
progress log 98
report progress of option 113
schedule type 121
search directory 113
selected files/directories option 113
split across media id 100
Auspex FastBackup
browse to restore 110
xbp restore 110
Automatic backup 4
Automatic refresh
xbp 99

Backup windows 4
Backups
bp
backup menu 133
database backup menus 138
option 132
procedure 48
progress log 74
search options 146
search screen 146
browse redirected restore 3
browse to restore 109
Auspex Fastbackup 110
raw partition 110
true-image backups 109
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bp

jbpSA
procedure 19

scheduled 4

symbolic links 6

xbp
backup menu 112
bplist command 101
database script 113
display 104
filter by date 102
images pane 120
keyword phrase 119
listing 89
media IDs 100
most recent 112
procedure 78
progress log 98
report progress of 113
schedule type 121
search directory 113
selected files/directories 113
selecting a directory 103
show all backups 111
split across media id 100

backup SQL-BackTrack DB Backup
option 134

backup/archive procedure 48

basic restore procedure 56

progress logs 74

resolving links 73

restore SQL-BackTrack DB option 140
starting 48

bp.conf command

CLIENT_NAME option 127
initial browse default 117
mail notifications 100

bplist command 101
Brief display

backup of files/directories menu 135
change on backup files/directories
menu 136

change on Restore Backups menu 142
Restore Backups menu 141

Browse

backup images 120

bp menu options 52
class type of image 127
directory depth 122

C

directory structure 124
directroy to search 115
filename filter 123
files 124

keyword phrase 119
mode 118

range of dates 117
search screen 146
source client 127, 141, 143
user interfaces 3

xbp file menu 109

CDE (Common Desktop Environment)
set up for NetBackup-Java 11
CDF directories 6
Client
bp
change destination client 143
change source client 143
destination client 142
source client 141
definition 1
jbpSA
redirected restore 151
redirected restore 5
xbp
client to browse for restore 127
client to restore to 127
redirected restore 91
Commands
bp 2,48, 132
bp.conf 100, 117, 127
setenv 76
Cross mount points
restore 27, 88, 130

Database
backup database 113
backup menu 138
restore database 114
restore menu 145
script 114
scripts 109
Date
bp
change date range
backup 135
restore 142
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end date
backup 135
restore 141
start date
backup 135
restore 141
jbpSA
selecting dates to restore 32
xbp
date backup expires 121
date backup occured 121
filter by date 102
range of dates 117
selecting dates to restore 93
Delete
bp
archive files/directories 137
progress log files 74
jbpSA
archive files/directories 21
restore deleted files 25
progress log files 4
xbp
archive files/directories 80
restore deleted files 90
Directory
bp
change directory depth option 142
change path option 135, 142
directory depth 141
path field 50, 59
resolve links 67
restoring true-image backups 69
search 60
selecting to backup 52, 53
selecting to restore 62
CDF 6
jbpSA
resolving links 42
restoring true image backups 40
symbolic link 6
UNIX permissions 7
xbp
archive directroy structure pane
selections 113
backup directory structure pane
selections 113
deleting 80
directory depth 102, 104

directory depth box 122
directory structure pane 124
directory to search box 115
discard selections 110
display contents 102
indented tree struction 111
navigating the directory tree 101
progress log file written to 80, 88
redirect the restore 114
redirected restore 91
resolving links 98, 112
restore directory structure pane
selections 114
restore earlier version 94
restore most recent version 90
restoring true-image backups 95
search 84
selecting to backup 79
selecting to restore 83
show structure 103
unselecting 87
update display 111
xbp_altpath dialog 128
Disk partition 6
bp 65
xbp 88
Disk-image backup
jbpSA restore 160, 161
Display mode
bp
backup of files/directories
menu 135
change 136
restore menu 141
bp change on restore menu 142
font size 107
Display update
edit menu 111
restore procedure 84
DISPLAY, setenv variable 76

Exclude list 5

File list

bp 147

exclude and include lists 5
File permissions 7
Filename filter
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description 123

jbpSA 17,21
xbp 102, 123
procedure 85
Fonts
changing in xbp 107
G
Graphical user interface
description 106
using 75
H
Help, online
bp help option 132
specify X resources 107
xbp 75
xbp help menu 115
HP (Hewlett Packard)
restoring CDF directories 6
|
Include list 5
Interface
command line 3
graphical 3
description 106
using 75
java 9
menu 2
description 132
using 47
J
Java interface (jbpSA) 9
K

Keyboard shortcut 106
Keyword phrase
bp
backup files/directories menu 136
backup procedure 52
Restore Backups menu 142
restore files and directories
menu 143
restore procedure 58
jbpSA
associating with backups 21
using when restoring 25
xbp
associating with backups 119

backup procedure 80
restore procedure 85

Legal character 116
Linked files
resolving links
bp 73
jbpSA 42
xbp 98
Listing backups and archives
bp procedure 58
bplist 101
UNIX permissions 7
xbp procedure 89
Listing media id 100

Mail notifications 4, 7, 100
Master server
altnames 127
bp
backup menu 133
backup of files/directories
menu 135
change for backup 50, 134, 136
change for restore 57, 140, 143
main menu 132
name displayed 48
Restore Backups menu 141
restore menu 139
directed restores 5
exclude, include lists 5
jbpSA
change for backup 19
change for restore 24
Novell NetWare client 63
xbp
cbp_config dialog 127
change for backup 78
change for restore 82, 83
configuration 110
current 78
Maximum path length 6
Media IDs 100
listing in jbpSA 162
Menu interface 2
description 132
using 47
Menus
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archive of files/directories 137

backup 133

backup database 138

main 132

restore 139

restore archives 144

restore database 145

restore raw partition backups 144

restore true image backups 145
xbp

backup 112

edit 110

file 109

help 115

restore 114

view 111

Mount points 27, 88, 130
Mwm*keyboardFocusPolicy X resource 11

NFS mounted files 7

Overwriting

bp
prompt 142
raw partition restores 65
restore procedure 61
true-image restore 71
CDF 6
disk partition 88
raw partition restores 6
xbp
overwrite existing files
checkbox 129
procedure 88
XKeysymDB 107

Path

bp
alternate restore 63
cancel redirected restore 67
change after a backup is intiated 55,
66
change for a backup 50
change for a restore 59
change path option 142
current path on search screen 147

redirect the restore 143
resolving links 67, 73
jbpSA
resolving links 23
maximum length 6
xbp
directory to search box 115
links 85
navigating the directory tree 101
redirect the restore 114
redirected restore 93
Redirected restore checkbox 130
search path links 112
xbp_altpath dialog 128
Pathname
legal characters 116
restore linked 92
xbp
full pathnames 111
Permission
bp file permissions for restore 56
to browse backup on redirected
restore 3
UNIX file permissions 7
user-directed restore 151
xbp
client to browse for restores 127
client to restore to 127
overwrite existing file 88
Progress log
checking 74
jbpSA 30
xbp
creating 129
deleting 100
interpreting 100
xbp_progress dialog 99, 130

Range of dates boxes 117
Raw partition
bp restore
device file 56
mounted directory 56
overwrite option 65
jbpSA restore
device file 159
mounted directory 159
procedure 160, 161
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restore
overwrite option 6
xbp restore
browse backups
Auspex FastBackup raw
partition 110
restore raw partitions 110
device file 82
mounted directory 82
Redirected restores
bp
links in path 67
procedure 63
specify 143
jbpSA
procedure 36, 151
server-directed 5
xbp 130
procedure 91
specify 114
Refresh display
xbp 104
if large number of backups
shown 84
update display on edit menu 111
Resolving links
bp 73
jbpSA 42
wildcard characters 42
xbp 98
do not resolve links in search
directory 112
resolve links in search directory 112
wildcard characters 98
Restore
bp
option 132
procedure 56
restore archives menu 144
restore database menu 145
restore menu 139
restore raw partition backups
menu 144
restore search options 147
restore true image backups
menu 145
true image 69
CDF directories 6
jbpSA

AFS backups 158
archives 25
procedure 24
raw partitions 160, 161
redirected 151
redirected restore 36
resolving links 23
search option 31
specific date range 32
true image 40
server-directed 151
server-directed to another client 5
xbp
Auspex FastBackup
restore xbp 110
browse archives 109
browse backups 109
browse true-image backups 109
client to browse for restore 127
client to restore to 127
deleted files 90
directores without cross mount
points 130
mode 118
procedure 82
progress log 98
raw partitions 82, 110
redirected restore 128, 130
report progress 115
resolving links 85
restore menu 114
selected files/diresctories 114
specific date range 93
true image 95
Retention period 6

Schedule
types 121
Scheduled backups
administrator scheduled backup 147
exclude list 5
for automatic backup 6
include list 5
Search directory
xbp 114
Search screen
bp
backup or archive 146
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options 148
restore 147
Selections screen
edit/view 149
view/delete 150
Server directed restore 5, 151
setenv command 76
Special symbols in xbp 106
Status codes in xbp 100

Time Zone, adjusting in joppSA 13
True image restore
bp
menu 145
procedure 69

view/delete selections screen 150

jbpSA 40

xbp
browse backups 109
procedure 96

User-directed operations 2

Verbose display

backup of files/directories menu 135

change on backup files/directories
menu 136

change on Restore Backups menu 142

Restore Backups menu 141

Wildcard characters
bp change path option 142
jbpSA
filtering files 17
in links 42
xbp
links 98
search 116
Windows
user-directed operations 4
Write permissions
viewing in xbp 104

X resources
changing 107
xbp
backup/archive procedure 78
basic restore procedure 82
progress logs 98
redirected restore procedure 91
starting 76
true-image restore procedure 96
XKeysymDB 107
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